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CGL COMPUTER- 02/03/2023 (9:00 AM - 12:00 PM)
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CGL COMPUTER- 03/03/2023 (9:00 AM - 12:00 PM)
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CGL COMPUTER- 06/03/2023 (9:00 AM - 12:00 PM)
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CGL COMPUTER- 07/03/2023 (9:00 AM - 12:00 PM)
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CHSL 2022 COMPUTER- 26/06/2023 (9:00 AM - 12:00 PM)
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DELHI POLICE HC- 10/10/2022 (9:00 AM - 10:30 AM)

Answers

Q1: 3 Q2: 3 Q3: 2 Q4: 1 Q5: 3 Q6: 4 Q7: 1 Q8: 2 Q9: 2 Q10: 3

Q.1 िन�िल�खत म� से कौन सा एक डॉ�ूम�ट �ोसेिसंग सॉ�वेयर नही ंहै?

Ans 1. नोटपैड
    2. वड�पैड
    3. ओपन ऑिफस इं�ेस
    4. माइ�ोसॉ� वड�

Q.2 एमएस-ए� सेल 2010 �रबन बार म� ______ टैब म� हाइड ऑ�शन (Hide option) मौजूद होता है।

Ans 1. डेटा (Data)     2. इ�ट� (Insert)     3. �ू (View)     4. फाइल (File)

Q.3 ______ वक� शीट िवंडो के िनचले िकनारे का नाम है, जो एमएस-ए�ेल 2010 (MS-Excel 2010) म� ए�ेल वक� शीट के बारे म� िविभ� जानकारी
�दिश�त करता है।

Ans 1. टाइटल बार (Title bar)     2. �ेटस बार (Status bar)     3. �रबन (Ribbon)     4. टा� बार (Task bar)

Q.4 मोिज़ला, मोिज़ला फाउंडेशन �ारा वष� ______ म� िवकिसत एक वेब �ाउिजंग सॉ�वेयर है।
Ans 1. 2002     2. 2000     3. 2003     4. 2001

Q.5 एमएस-ए� सेल 2010 म� ______ फ़ं�न केवल  वत�मान िस�म ितिथ (current system date) �दान करता है।
Ans 1. YEAR     2. CURRENT     3. TODAY     4. NOW

Q.6 एमएस-ए� सेल 2010 म� ______ का उपयोग, शीट के भीतर कॉलम को छुपाने (hiding) के िलए िकया जाता है।
Ans 1. Ctrl + 9     2. Alt + 9

    3. Alt + 0
    4. Ctrl + 0

Q.7 िन�िल�खत म� से कौन सा िसंबल(�तीक) ईमेल पते म� उपयोग िकया जाना चािहए?
Ans 1. @     2. %     3. $     4. #

Q.8 एमएस-ए� सेल 2010 म� ______ फ़ं�न िकसी ���ंग (string) म� कैरे� टर की कुल सं�ा का िववरण देता है।
Ans 1. SUM     2. LEN     3. COUNTA     4. COUNTIF

Q.9 एमएस-ए�ेल 2010 (MS-Excel 2010) म�______ को A से आगे बढ़ते �ए और ______ को 1 से आगे बढ़ते �ए नािमत िकया जाता है।

Ans 1. रोज़, कॉल� (rows, columns)     2. कॉल�, रोज़ (columns, rows)     3. चाट�, �ाफ (chart, graph)     4. टेबल, िपवट टेबल (table, pivot
table)

Q.10 एक माक� अप ल��ेज और अिनय��त डाटा को �ोर करने, संचा�रत करने और पुनिन�मा�ण (arbitrary) करने के िलए उपयोग िकए जाने वाले
फाइल फॉम�ट को ________ के �प म� जाना जाता है।

Ans 1. SGML     2. HTML     3. XML     4. EML
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DELHI POLICE HC- 10/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 2 Q2: 3 Q3: 2 Q4: 3 Q5: 1 Q6: 3 Q7: 4 Q8: 3 Q9: 2 Q10: 1

Q.1 MS-Word 2010 म� दाई ंओर एक श� को िमटाने के िलए िकस शॉट�कट की (key) का उपयोग िकया जाता है?
Ans 1. Ctrl+Backspace     2. Ctrl+Delete     3. Delete     4. Alt+Backspace

Q.2 एमएस-ए�ेल 2010 (MS-Excel 2010) म� ______ फॉमू�ला, िविश� सेल म� सं�ाओ ंके योग का �ाथिमक काय� है।
Ans 1. COUNT     2. IF     3. SUM     4. AVERAGE

Q.3 एमएस-ए� सेल 2010 म� ______ फं�न, िस�म की वत�मान ितिथ एवं समय (current system date and time) �दान करता है।
Ans 1. TODAY     2. NOW     3. YEAR     4. CURRENT

Q.4 िन�िल�खत म� से कौन सा एक ईमेल एड� ेस म� एक वैध डोमेन नेम है?
I. gmail.com
II. outlook.com
III. yahoo.com

Ans 1. I और III     2. I और II     3. सभी I, II और III     4. II और III

Q.5 एमएस-ए� सेल 2010 म�, हम �ीन पर अित�र� �ान �ा� करने के िलए �रबन को कोलै� (collapse) कर सकते ह�। �रबन पर कही ंभी
राइट ��क कीिजए, और िफर कोलै� द �रबन (Collapse the Ribbon) को ��क कीिजए या ______ को दबाइए।

Ans 1. CTLR+F1     2. ALT+F2     3. ALT+F1     4. CTLR+F2

Q.6 िकसी पेज को सव�र पर कॉपी करना, ______ कहलाता है।

Ans 1. पेज सेव करना (Save)     2. पेज ि�एट करना (Create)     3. पेज अपलोड करना (Uploading)     4. पेज डाउनलोड करना (Downloading)

Q.7 एमएस-ए�ेल 2010 वक� शीट के सेल म� दज� िकए गए सं�ा�क मानो ंका िडफ़ॉ� एलाइनम�ट �ा है?

Ans 1. ज��फाई(Justify)     2. स�टर(Center)     3. ले�(Left)     4. राईट(Right)

Q.8 एमएस-ए� सेल 2010 के संबंध म� गलत िवक� का चयन कीिजए।

Ans 1. Alt+Enter शॉट�कट कंुजी (key) का उपयोग MS-Excel 2010 म� टे� की एक नई लाइन शु� करने या वक� शीट सेल म� टे� की लाइनो ंया
पैरा�ाफ के बीच � पेस को बढ़ाने के िलए िकया जाता है।     2. एमएस-ए� सेल 2010 म�, Ctrl+F का उपयोग शीट के भीतर टे� खोजने म� िकया जाता है।     3. एमएस-
ए� सेल 2010 म� हम F3 का उपयोग करके फाइल को सेव कर सकते ह�।     4. एमएस-ए� सेल 2010 म� �रबन बार म� होम टैब म� सबसे अिधक उपयोग िकए जाने वाले
कमांड होते ह� जैसे कॉपी और पे� करना, सॉट� करना और िफ़�र करना, फॉम�ट करना आिद।

Q.9 एमएस-ए�ेल 2010 (MS-Excel 2010) म� टेबल का नाम बदलने (�रनेम) के िलए िन� म� से िकस कीबोड� शॉट�कट का उपयोग िकया जाता है?
Ans 1. Ctrl + T + R     2. Ctrl + R

    3. Alt + T + R
    4. Alt + R

Q.10 ऐसी वेबसाइट िजसम� लेखक या लेखको ंके अपने अनुभव, अवलोकन, िवचार आिद होते ह�, ______ के �प म� जाने जाते ह�।

Ans 1. � लॉग (BLOG)     2. ईमेल (EMAIL)     3. इं� ट�ट मेस�जर (Instant messenger)     4. वाइरस (VIRUS)

KD Job Updates KD Job Updates

KD Jo
b 

Upd
at

es



DELHI POLICE HC- 10/10/2022 (5:00 PM - 6:30 PM)

Answers

Q1: 4 Q2: 4 Q3: 1 Q4: 1 Q5: 3 Q6: 4 Q7: 2 Q8: 4 Q9: 4 Q10: 2

Q.1 डॉटेड-डेसीमल नोटेशन (dotted-decimal notation) म�, आईपी (IP) सं�रण 4 एड� ेसेज को िब�ुल ______ डॉट (.) िच�ो ंका उपयोग करके
दशा�या जाता है।

Ans 1. दो     2. तीन     3. पाँच     4. चार

Q.2 एमएस-ए� सेल 2010 के संबंध म� गलत िवक� का चयन कीिजए।

Ans 1. Alt+Enter शॉट�कट कंुजी (key) का उपयोग एमएस-ए� सेल 2010 म� िकसी िवशेष सेल वाले टे� म� एक नई लाइन �िव� ट करने के िलए िकया
जाता है।     2. एमएस-ए� सेल 2010 म�, �रबन बार म� होम टैब (home tab) म� सबसे अिधक उपयोग िकए जाने वाले कमांड होते ह� जैसे िक कॉपी और पे� करना, सॉट�
करना और िफ़�र करना, फॉम�ट करना आिद।     3. एमएस-ए� सेल 2010 म�, Ctrl+H का उपयोग शीट के भीतर टे� को �ित� थािपत (Replace) करने के िलए
िकया जाता है।     4. एमएस-ए� सेल 2010 म�, Ctrl+R का उपयोग शीट म� टे� को �ित� थािपत (Replace) करने के िलए िकया जाता है।

Q.3 MS-Excel -2010 और उससे ऊपर की वक� शीट म� एिडट मोड को इनेबल करने के संदभ� म� िन�िल�खत म� से कौन सा िवक� सही है?

Ans 1. File पर ��क कर�  > Options पर ��क कर�  > Advanced पर ��क कर�  और Editing options के अंतग�त Allow editing directly in cells
चेक बॉ� (check box) को सेले� कर�।     2. File पर ��क कर�> Options पर ��क कर�  > Customized Ribbon पर ��क कर�  और Allow editing directly
in cells चेक बॉ� (check box) को सेले� कर�।     3. File पर ��क कर�  > Options पर ��क कर�  > Customized Ribbon पर ��क कर�  और Editing
options के अंतग�त Allow editing directly in cells चेक बॉ� (check box) को सेले� कर�।     4. File पर ��क कर�  > Options पर ��क कर�  > Trust
Center पर ��क कर�  और Allow editing directly in cells चेक बॉ� (check box) को सेले� कर�।

Q.4 जब आप एमएस-ए�ेल 2010(MS-Excel 2010) वक� शीट म� B3 से लेकर, B3 : G9 सेल की र�ज को सेले� ट करते ह�, तो नेम बॉ� म� �ा
�दिश�त होगा?

Ans 1. B3     2. G9     3. B9     4. G3

Q.5 एमएस ए�ेल-2010 वक� शीट के सेल म� अिधकतम िकतने कैरे� टर टाइप िकए जा सकते ह�?
Ans 1. 16384     2. 1024     3. 32767     4. 256

Q.6 एमएस-वड� 2010 म�, बाई ंओर के एक कैरे� टर को हटाने के िलए िकस शॉट�कट की (key) का उपयोग िकया जाता है?
Ans 1. Shift + Delete     2. Ctrl + Backspace     3. Ctrl + Delete     4. Backspace

Q.7 �ू टैब (view tab) पर जाने के िलए, एमएस-ए�ेल (MS-Excel 2010) म� ______ शॉट�कट की (key) का उपयोग िकया जाता है।
Ans 1. ALT + A     2. ALT + W     3. ALT + N     4. ALT + I

Q.8 एमएस-ए�ेल 2010 (MS-Excel 2010) म� ______ ऑपरेशन का उपयोग डेटा को एक िवशेष �म म� �व��त करने के िलए िकया जाता है।

Ans 1. टेबल (TABLE)     2. िफ�र (FILTER)     3. चाट� (CHART)     4. सॉट� (SORT)

Q.9 एक _________, वेब पेजो ंऔर संबंिधत साम�ी का ऐसा सं�ह होता है िजसे िकसी सामा� डोमेन (domain) नाम से पहचाना जाता है और कम
से कम िकसी एक वेब सव�र (web server) पर प��श िकया जाता है।

Ans 1. वाइरस (VIRUS)     2. ईमेल (EMAIL)     3. इं� ट�ट मैस�जर (Instant messenger)     4. वेबसाइट (Website)

Q.10 अधूरे ईमेल को िबना भेजे ही िकस फो�र म� �ोर िकया जाता है?

Ans 1. �ैम (Spam)
    2. ड� ा� (Drafts)
    3. स�ट (Sent)
    4. ट� ैश (Trash)
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DELHI POLICE HC- 12/10/2022 (9:00 AM - 10:30 AM)

Answers

Q1: 3 Q2: 3 Q3: 4 Q4: 1 Q5: 4 Q6: 4 Q7: 4 Q8: 4 Q9: 2 Q10: 2

Q.1 एमएस-ए� सेल 2010 म� ______ का उपयोग शीट के भीतर टे� को �ित� थािपत (Replace) करने के िलए िकया जाता है।
Ans 1. Alt+R     2. Ctrl+F     3. Ctrl+H     4. Alt+F

Q.2 िन�िल�खत म� से कौन से कीबोड� शॉट�कट का उपयोग �ोम �ाउज़र म� करंट (वत�मान) टैब के बाई ंओर एक �ाउज़र टैब को सि�य करने के
िलए िकया जाता है?

Ans 1. Ctrl + Right arrow
    2. Alt + Page down
    3. Ctrl + Page up
    4. Alt + Left arrow

Q.3 सफारी एक वेब �ाउिजंग सॉ�वेयर है िजसे ______ के �ारा िवकिसत िकया गया है।

Ans 1. मोिज़ला (Mozilla)     2. माइ�ोसॉ� (Microsoft)     3. गूगल (Google)     4. ए�ल (Apple)

Q.4 एमएस-ए�ेल 2010 की इस वक� शीट को �ान से पढ़� और उसके अनुसार िन�िल�खत �� के िलए सबसे उपयु� िवक� चुन�।

10 अंकीय मान वाले सेल का ऐ�ो�ुट एड� ेस (absolute address) �ा है?
Ans 1. $B$2     2. $B2$     3. &B2&     4. B2$

Q.5 एमएस-ए�ेल 2010 (MS-Excel 2010) म� िविश� मानदंडो ंके साथ एक र�ज म� से� की सं�ा की गणना ______ का उपयोग करके की जा
सकती है।

Ans 1. IF     2. SUM     3. COUNT     4. COUNTIF

Q.6 एमएस-ए�ेल 2010 (MS-Excel 2010) के टेबल फीचर के मा�म से बनाए गए टेबल �ारा यूजर (उपयोगकता�) िविभ� मानो ंसे ______ को
िफ़�र कर सकते ह�।

Ans 1. रोज़ (Rows)     2. िफ�र (Filter)     3. सेल (Cell)     4. कॉलम (Column)

Q.7 एक मौजूदा एमएस-ए�ेल 2010 वक� बुक म� एक नई वक� शीट इ�ट� करने के िलए िन�िल�खत म� से कौन सी शॉट�कट की (shortcut key)
उपयोग की जाती है?

Ans 1. Shift+Ctrl+F10     2. Shift+F10     3. Shift+Ctrl+F11     4. Shift+F11

Q.8 एमएस-ए�ेल 2010 ए��केशन म� अिधकतम ज़ूम �ितशतता िकतनी होती है?
Ans 1. 200%     2. 300%     3. 500%     4. 400%

Q.9 िदए गए फो�रो ंम�, अ�ेिषत मेल को ______ फो�र म� �ोर िकया जाता है।

Ans 1. स�ट (Sent)     2. ड� ा� (Draft)     3. इनबॉ� (Inbox)     4. ट� ैश (Trash)

Q.10 एमएस-ए�ेल 2010 (MS-Excel 2010) म� ______ फ़ं�न की (key) का उपयोग सेल को संपािदत (एिडट) करने के िलए िकया जाता है।
Ans 1. F1     2. F2     3. F4     4. F3
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DELHI POLICE HC- 12/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 3 Q2: 2 Q3: 3 Q4: 4 Q5: 4 Q6: 1 Q7: 2 Q8: 2 Q9: 2 Q10: 3

Consider the following statement about EXACT() function of MS-Excel 2010:Q.1
P: It compares two text strings and returns TRUE if they are exactly the same.
Q: It compares two text strings and returns 1 if they are not exactly the same.
R: It compares two text strings and returns FALSE if they are not exactly the same.
Which of the following statement(s) is/are true

Ans 1. Only P     2. Only P and Q     3. Only P and R     4. All P, Q, R

Q.2 िन�िल�खत म� से िकस �कार की इंटरनेट सिव�स के िलए केबल या फोन लाइन की आव�कता नही ंहोती है?

Ans 1. डायल अप (Dial up)     2. सेटेलाइट (Satellite)     3. डीएसएल (DSL)     4. केबल (Cable)

Q.3 एमएस-वड� 2010 म�, यिद आप िकसी टेबल के भीतर टैब की (Tab key) दबाते ह�, तो कस�र टेबल के/की अगले/अगली ______ पर चला जाता है।

Ans 1. लाइन (Line)     2. रो (Row)     3. सेल (Cell)     4. डाटा (Data)

Q.4 Which of the following features in MS-Word 2010 can be used to draw a straight line across the selected texts in a
document?

Ans 1. Format Painter     2. Eraser     3. Replace     4. Strikethrough

Q.5 ______ shortcut key is used to move to the previous sheet in MS-Excel 2010.
Ans 1. Alt+ PageDown     2. Ctrl + PageDown     3. Alt+PageUp     4. Ctrl + PageUp

Q.6 िन�िल�खत म� से कौन सा कीबोड� शॉट�कट, �ोम �ाउजर म� वत�मान पेज के िलए गैर-संपादन यो�(non-editable) एचटीएमएल(HTML) सोस�
कोड �दिश�त करने के िलए उपयोग िकया जाता है?

Ans 1. CTRL + U     2. ALT + S     3. CTRL + S     4. ALT + U

Q.7 िन�िल�खत म� से कौन-सा इफ़े� (effect), MS-Word 2010 के फॉ� डायलॉग बॉ� (font dialog box) म� उपल� नही ंहै?

Ans 1. स���� (Subscript)     2. फै�ी (Fancy)     3. इटैिलक (Italic)     4. बो� (Bold)

Q.8 Which of the following is a valid email address?
Ans 1. @domainname.com     2. mySchool@gmail.com     3. John123@.net     4. abc@def@gmail.com

Q.9 Which of the following shortcut key is used in MS-Word 2010 to apply double spacing to the paragraph?
Ans 1. Ctrl + 5     2. Ctrl + 2     3. Ctrl + 4     4. Ctrl + 1

Q.10 Unhide option is present in ______ tab in MS-Excel 2010 ribbon bar.
Ans 1. Insert     2. Data     3. View     4. File
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DELHI POLICE HC- 12/10/2022 (5:00 PM - 6:30 PM)

Answers

Q1: 2 Q2: 1 Q3: 2 Q4: 1 Q5: 3 Q6: 3 Q7: 4 Q8: 4 Q9: 3 Q10: 4

Q.1 एमएस-ए� सेल 2010 म� �रबन बार म� ______ टैब आपको बैक�ेज �ू (backstage view) म� जंप करने की सुिवधा देता है िजसम� आव�क
फ़ाइल-संबंधी कमांड और ए�ेल के िवक� होते ह�।

Ans 1. FORMULA     2. FILE     3. HOME     4. REVIEW

Q.2 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, ______ फीचर हम� आस� सेल के समूह के कंट�ट (सं�ा�क मान) का योग करने म� सहायता
करता है।

Ans 1. ऑटोसम (AutoSum)     2. ऑटोिफल (AutoFill)     3. िपवटटेबल (PivotTable)     4. चाट� (Charts)

Q.3 ईथरनेट काड� (Ethernet card) एक ऐसा नेटवक�  एडे�र (network adaptor) है िजसका उपयोग वायड� नेटवक�  (wired network) को �ािपत
करने के िलए िकया जाता है। इसे ______ के �प म� भी जाना जाता है।

Ans 1. �ूटूथ काड� (Bluetooth Card)     2. नेटवक�  इंटरफेस काड� (Network Interface Card)     3. फाइबर ऑि�� (Fiber optics)     4. वाई-फाई
काड� (Wi-Fi card)

Q.4 �ोम �ाउज़र म� डाउनलोड िवंडो खोलने के िलए िन� म� से िकस कीबोड� शॉट�कट का उपयोग िकया जाता है?
Ans 1. Ctrl + J     2. Alt + D     3. Ctrl + D     4. Alt + J

Q.5 MS-Excel 2010 की वक� शीट म� इ�ट� हाइपरिलंक डायलॉग बॉ� (Insert hyperlink dialog box) को खोलने के िलए िन�िल�खत म� से
िकस शॉट�कट की (key) का उपयोग िकया जाता है?

Ans 1. Ctrl+D     2. Ctrl+H     3. Ctrl+K     4. Ctrl+G

Q.6 एमएस-ए�ेल 2010 (MS-Excel 2010) वक� बुक म� अगली शीट पर जाने के िलए ______ शॉट�कट की (key) का उपयोग िकया जाता है।
Ans 1. Alt+ PageDown     2. Alt+ PageUp     3. Ctrl + PageDown     4. Ctrl + PageUp

Q.7 ______ फ़ी�, �ेषक के पते को इंिगत करता है अथा�त, िजसने ई-मेल (e-mail) भेजा है।

Ans 1. इनबॉ� (Inbox)     2. बीसीसी (Bcc)     3. टू (To)     4. �ॉम (From)

Q.8 एमएस-वड� 2010 म� पैरा�ाफ को दािहनी ओर अलाइन करने के िलए िन�िल�खत म� से िकस शॉट�कट की (shortcut key) का उपयोग िकया
जाता है?

Ans 1. Ctrl+Shift+M     2. Ctrl+Shift+R     3. Ctrl+J     4. Ctrl+R

Q.9 एमएस-वड� 2010 म� ओपन फाइल को सेव करने के िलए िन�िल�खत म� से कौन-सा कीबोड� शॉट�कट की (key) CTRL+S के समक� है?
Ans 1. Ctrl + F5     2. Ctrl + F12     3. Shift + F12     4. Shift + F5

Q.10 एमएस-ए�ेल 2010 वक� शीट के सेल म� समय के साथ वत�मान ितिथ �दिश�त करने के िलए िन�िल�खत म� से कौन सा फं�न उपयोग िकया
जाता है?

Ans 1. Date()     2. Timevalue()     3. Time()     4. Now()
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DELHI POLICE HC- 13/10/2022 (9:00 AM - 10:30 AM)

Answers

Q1: 2 Q2: 2 Q3: 3 Q4: 4 Q5: 2 Q6: 4 Q7: 1 Q8: 4 Q9: 4 Q10: 1

Q.1 जब एमएस-वड� 2010 (MS-Word 2010) का कोई डा�ूम�ट पहले से खुला हो, तो नया डा�ूम�ट खोलने के िलए िकस कीबोड� शॉट�कट का
उपयोग िकया जाता है?

Ans 1. Ctrl + V     2. Ctrl + N     3. Ctrl + Y     4. Ctrl + X

Q.2 एमएस-ए�ेल 2010 (MS-Excel 2010) म� ______, मानो ंको रे�� स (reference) या एरै (array) म� अवलोिकत करता है।
Ans 1. VLOOKUP     2. MATCH     3. COUNT     4. SUM

Q.3 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, पहले से िव�मान फ़ाइल को खोलने के िलए ______ संि�या (ऑपरेशन) का उपयोग िकया जाता
है।

Ans 1. NEW     2. SAVE     3. OPEN     4. SAVE AS

Q.4 MS-Word 2010 म� दाई ंओर के कैरे�र को िडलीट करने के िलए िकस शॉट�कट की (key) का उपयोग िकया जाता है?
Ans 1. Ctrl+Delete     2. Ctrl+Backspace     3. Alt+Backspace     4. Delete

Q.5 एमएस-ए�ेल 2010 (MS-Excel 2010) वक� शीट म� एक ही सेल म� एक नई लाइन आरंभ करने के िलए िन�िल�खत म� से िकस कीबोड� शॉट�कट
का उपयोग िकया जाता है?

Ans 1. Ctrl + Enter     2. Alt + Enter     3. Tab + Enter     4. Shift + Enter

Q.6 ______ को आसानी से इंटरनेट से जुड़े कं�ूटरो ंम� फैलाया जा सकता है। इस तरह के हमलो ंसे आपका िस�म �ैश हो सकता है, या आपका
मह�पूण� डेटा िडलीट हो सकता है।

Ans 1. CHAT (चैट)     2. EMAIL (ईमेल)     3. SEARCH (सच�)     4. VIRUS (वाइरस)

Q.7 ई-मेल (e-mail) म� ______ फ़ी� उस ई-मेल के उ�े� को इंिगत करता है।

Ans 1. स�े� (Subject)     2. बीसीसी (Bcc)     3. �ॉम (From)     4. टू (To)

Q.8 एमएस-ए� सेल 2010 के संबंध म� गलत िवक� का चयन कीिजए।

Ans 1. एमएस-ए� सेल 2010 म�, नई फाइल को खोलने के िलए Ctrl+N का उपयोग िकया जाता है।     2. एमएस-ए� सेल 2010 म�, हम इ�ट� टैब से एक
टेबल इ�ट� कर सकते ह�।     3. एमएस-ए� सेल 2010 म�, हम F12 का उपयोग करके फाइल को सेव कर सकते ह�।     4. एमएस-ए� सेल 2010 म�, हम िकसी सेल म�
कम�ट नही ंडाल सकते ह�।

Q.9 एमएस-वड� 2010 (MS-Word 2010) म�, �ेल चेक रन करने के िलए िन�िल�खत म� से िकस की (key) का उपयोग िकया जाता है?
Ans 1. F5     2. F3     3. F1     4. F7

Q.10 एक IPv4 पता ______ िबट का होता है।
Ans 1. 32     2. 16     3. 128     4. 64
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DELHI POLICE HC- 13/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 1 Q2: 3 Q3: 2 Q4: 3 Q5: 3 Q6: 1 Q7: 1 Q8: 1 Q9: 3 Q10: 4

Q.1 एमएस-ए�ेल 2010 फॉ� डायलॉग बॉ� म� िन�िल�खत म� से कौन सी फॉ� �ाइल उपल� नही ंहोती है?

Ans 1. सुपरबो� (Superbold)     2. इटैिलक (Italic)     3. बो� (Bold)     4. रेगुलर (Regular)

Q.2 एमएस-वड� 2010 म� िन�िल�खत म� से कौन सा एलाइनम�ट िवक� आपके टे� को मािज�न (margins) के बीच समान �प से िवत�रत करेगा?

Ans 1. अलाइन राईट (Align Right)
    2. स�टर (Center)
    3. ज��फाई (Justify)
    4. अलाइन ले� (Align Left)

Q.3 एमएस-ए� सेल 2010 म� ______, समूहीकृत वै�ू वाला ऐसा टेबल है जो एक या अिधक असतत �ेिणयो ंके भीतर िकसी अित िव�ृत टेबल के
अलग-अलग आइटमो ंका संचय करता है।

Ans 1. �ेडशीट (Spreadsheet)     2. िपवट टेबल (Pivot table)     3. बार (Bar)     4. लाइन (Line)

Q.4 एमएस-वड� 2010 म�, से�(cells) को ______ करने का अथ� है िक आस� सेल(cells) को उसके बाद एक एकल सेल(cell) के �प म� माना
जाता है, भले ही वे एक एकल सेल(cell) के �प म� नही ंरहे हो।ं

Ans 1. फॉम��िटंग (Formatting)     2. ���िटंग (Splitting)     3. मिज�ग (Merging)     4. एिडिटंग (Editing)

Q.5 ______ is the intercompany communication of business documents in a standard format.
Ans 1. Emergency data Interchange     2. Electronic Data Information     3. Electronic Data Interchange     4. Electronic Data

Instruction

Q.6 ई-मेल (e-mail) का ______ फी� उस ई-मेल के �ा�कता� को इंिगत करता है।

Ans 1. टू (To)     2. स�े� (Subject)     3. िस�ेचर (Signature)     4. �ॉम (From)

Q.7 एमएस-वड� 2010 (MS-Word 2010) म�, _______ एक छोटा, अनुकूलन यो� टूलबार (customisable toolbar) है जो �ाय: उपयोग िकए जाने
वाले कमांड जैसे सेव, अनडू, �रडू आिद को �दिश�त करता है।

Ans 1. �ीक ए�ेस टूलबार (Quick Access toolbar)
    2. फाइल टैब (File tab)
    3. �रबन (Ribbon)
    4. टाइटल बार (Title bar)

Q.8 िन�िल�खत म� से कौन सा िवक� इंटरनेट �ारा �दान की जाने वाली सिव�स नही ंहै?

Ans 1. ईथरनेट (Ethernet)
    2. एफटीपी (FTP)
    3. व�� वाइड वेब
    4. ईमेल

Q.9 Choose the wrong option in relation to cell:
Ans 1. Any information you enter in a spreadsheet will be stored in a cell.     2. Cells can contain text, such as letters, numbers, and

dates.     3. Cells can contain text, such as letters, numbers but not dates.     4. Cells can contain formatting attributes that change the way
letters, numbers, and dates are displayed

Q.10 एमएस-ए�ेल 2010 (MS-Excel 2010) म� िन�िल�खत �ंजक का आउटपुट �ा है?
= 9 / 6 * 4 + 3 - 1

Ans 1. 12     2. 10     3. 6     4. 8
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DELHI POLICE HC- 13/10/2022 (5:00 PM - 6:30 PM)

Answers

Q1: 4 Q2: 2 Q3: 4 Q4: 2 Q5: 2 Q6: 3 Q7: 4 Q8: 3 Q9: 1 Q10: 2

Q.1 एमएस-ए� सेल 2010 म� िकसी रो (row) को सेले� करने के िलए ______ शॉट�कट कंुजी (key) का उपयोग िकया जाता है।
Ans 1. Ctrl+Enter     2. Ctrl+Spacebar     3. ALT+Enter     4. Shift+Spacebar

Q.2 ______ function is used in MS-Excel 2010 for Rounding the number down.
Ans 1. CEILING     2. FLOOR     3. COUNTIF     4. IF

Q.3 एमएस-वड� 2010 (MS-Word 2010) म�, सेले� ट िकए �ए टे� को स�टर अलाइन करने के िलए िन� म� से िकस कीबोड� शॉट�कट का उपयोग
िकया जाता है?

Ans 1. Ctrl + A     2. Ctrl + W     3. Ctrl + C     4. Ctrl + E

Q.4 Text editors and text formatters belong to which category of computing?
Ans 1. Interpreter     2. Word Processors     3. Language Translator     4. Compiler

Q.5 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, चयिनत टे� को बो� करने के िलए िकस शॉट�कट की (key) का उपयोग िकया जाता है?
Ans 1. Shift + B     2. Ctrl + B     3. Ctrl + O     4. Shift + O

Q.6 िन�िल�खत म� से कौन सी इंटरनेट �ारा �दान की जाने वाली सेवा / सेवाएँ है / ह�?
(i) वेबसाइट (Websites)
(ii) इले�� ॉिनक मेल (Electronic mail)
(iii) समाचार समूह (Newsgroup)
(iv) चचा� समूह (Newsgroup)

Ans 1. केवल (i), (ii) और (iii)     2. केवल (iii) और (iv)     3. (i), (ii), (iii) और (iv)     4. केवल (ii), (iii) और (iv)

Online conversations in which you are immediately able to send messages back and forth to one another is calledQ.7
______.

Ans 1. BLOG     2. VLOG     3. EMAIL     4. CHAT

Q.8 िन�िल�खत म� से कौन सा �भाव (effect) एमएस-वड� 2010 फॉ� डायलॉग बॉ� म� उपल� नही ंहोता है?

Ans 1. �� ाइक�ू (Strikethrough)
    2. बो� (Bold)
    3. इ�लाइज करै�र हाइट (Equalize Character Height)
    4. इटैिलक (Italic)

Q.9 एमएस-वड� 2010 (MS-Word 2010) म�, &#39; �र�ू (Review) &#39; टैब के &#39; �ूिफंग (Proofing) &#39; �ुप म� िन�िल�खत म� से कौन
सा िवक� उपल� नही ंहै?

Ans 1. कम�ट (Comment)     2. वड� काउंट (Word Count)     3. एिडटर (Editor)     4. िथसॉरस (Thesaurus)

Q.10 Gmail म�, जब आप कोई संदेश �ा� करते ह� और मूल �ेषक और अ� सभी �ा�कता�ओ ंको To और Cc लाइनो ंपर नया संदेश भेजना चाहते
ह�, तो आप �ा उपयोग करते ह�?

Ans 1. फॉरवड� ऑल (Forward All)     2. �र�ाई ऑल (Reply All)     3. फॉरवड� (Forward)     4. �र�ाई (Reply)
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DELHI POLICE HC- 14/10/2022 (9:00 AM - 10:30 AM)

Answers

Q1: 2 Q2: 2 Q3: 2 Q4: 4 Q5: 2 Q6: 4 Q7: 3 Q8: 3 Q9: 4 Q10: 3

Q.1 िन�िल�खत म� से कौन सा एमएस-ए�ेल 2010 म� एक फं�न नही ंहै?
Ans 1. Max()     2. Avg()     3. Sum()     4. Average()

Q.2 एमएस-ए� सेल 2010 म�, डेटा टेबल पर ______ ऑपरेशन का उपयोग केवल उन रो (rows) को �दिश�त करने के िलए िकया जाता है जो कुछ
शत� को पूरा करती ह� और अ� रो (rows) िछपी होती ह�।

Ans 1. SORT     2. FILTER     3. CHART     4. TABLE

Q.3 एमएस-ए� सेल 2010 म� ______ का उपयोग शीट के भीतर टे� खोजने म� िकया जाता है।
Ans 1. Ctrl+T     2. Ctrl+F     3. Alt+R     4. Alt+F

Q.4 Gmail म�, जब आप कोई संदेश �ा� करते ह� और िकसी ऐसे ��� को संदेश भेजना चाहते ह� जो To या Cc लाइनो ंपर न हो, तो आप �ा
उपयोग करते ह�?

Ans 1. �रपोट� �ैम (Report Spam)     2. ि�ंट (Print)     3. शो ऑ�रिजनल (Show original)     4. फॉरवड� (Forward)

Q.5 एमएस-वड� 2010 म� (MS-Word 2010), रो (rows) और कॉल� (columns) म� डेटा की �व�ा को ______ कहा जाता है।

Ans 1. रो (row)
    2. टेबल (table)     3. सेल (Cell)
    4. कॉलम (Column)

Q.6 इंटरनेट ए��ोरर एक वेब �ाउिजंग सॉ�वेयर है, िजसे वष� 1995 म� ______ �ारा िवकिसत िकया गया था।

Ans 1. मोिज़ला (Mozilla)     2. गूगल (Google)     3. या� (Yahoo)     4. माइ�ोसॉ� (Microsoft)

Q.7 एमएस-वड� 2010 (MS-Word 2010) म�, कीबोड� शॉट�कट Ctrl + X का उपयोग ______ के िलए िकया जाता है।

Ans 1. आ�शन को ओपन करने     2. हाइलाइटेड सेले�न को बो� करने     3. सेले�ेड आइटमो ंको ��पबोड� म� कट करने     4. पूरे टे� को सेले�
करने

Q.8 गूगल �ोम म� बुकमाक�  बार को िदखाने या िछपाने के िलए िन�िल�खत म� से कौन सा कीबोड� शॉट�कट उपयोग िकया जा सकता है?
Ans 1. Ctrl + Shift + C     2. Alt + Ctrl + K     3. Ctrl + Shift + B     4. Ctrl + Shift + K

Q.9 एमएस-वड� 2010 (MS-Word 2010) म� िन�िल�खत म� से िकस कीबोड� शॉट�कट की (shortcut key) का उपयोग पैरा�ाफ �ेिसंग को 1.5-
लाइन �ेिसंग म� बदलने के िलए िकया जाता है?

Ans 1. Ctrl + 2     2. Ctrl + 1     3. Ctrl + 3     4. Ctrl + 5

Q.10 एमएस-ए�ेल 2010 (MS-Excel 2010) म� ______ शॉट�कट की (key) का उपयोग डेटा टैब पर जाने के िलए िकया जाता है।
Ans 1. ALT+N     2. ALT+F     3. ALT+A     4. ALT+I
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DELHI POLICE HC- 14/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 2 Q2: 3 Q3: 4 Q4: 4 Q5: 4 Q6: 1 Q7: 2 Q8: 4 Q9: 3 Q10: 2

Q.1 एमएस-ए�ेल (MS-Excel 2010) के �रबन म� मौजूद, ______ का उपयोग वक� शीट म� िविभ� ऑ�े�्स जैसे िक िच�, चाट�, िपवट टेबल,
हाइपरिलंक, िवशेष िसंबल, समीकरण, हेडर और फुटर को जोड़ने के िलए िकया जाता है।

Ans 1. डाटा (DATA)     2. इ�ट� (INSERT)     3. फॉमू�ला (FORMULA)     4. फाइल (FILE)

Q.2 एमएस-ए� सेल 2010 �रबन बार म� ______ टैब म� सबसे अिधक उपयोग िकए जाने वाले कमांड होते ह� जैसे कॉपी और पे� करना, सॉट� करना
और िफ़�र करना, फॉम�ट करना आिद।

Ans 1. FORMULA     2. REVIEW     3. HOME     4. FILE

Q.3 फेसबुक एक ______ है।

Ans 1. सच� इंजन (Search engine)     2. �ाउज़र (Browser)     3. इंटरनेट सेवा �दाता (Internet service provider)     4. सोशल नेटवक�  साइट
(Social network site)

Q.4 सेल A5 म� टाइप िकए गए एक फॉमू�ला =A3+B4 पर िवचार कर�। यिद सेल A5 को कॉपी िकया जाता है और सेल E9 म� पे� िकया जाता है, तो
सेल E9 म� फॉमू�ला �ा होगा?

Ans 1. =B4+C5     2. =E8+F7     3. =A3+B4     4. =E7+F8

Q.5 एमएस-ए�ेल 2010 (MS-Excel 2010) शीट म�, टे� ओवर�ो सम�ा वाले सेल को ______ �ारा ठीक िकया जा सकता है।

Ans 1. टे� ब��ंग (Text Bumping)     2. टे� मिज�ग (Text Merging)     3. टे� अलाइिनंग (Text Aligning)     4. टे� रैिपंग (Text Wrapping)

Q.6 िन�िल�खत म� से �ा एक वेब मेल �ोवाइडर नही ंहै?

Ans 1. बाईडू (Baidu)
    2. या� (Yahoo)
    3. जीमेल (Gmail)
    4. आउटलुक (Outlook)

Q.7 एमएस-ए�ेल 2010 (MS-Excel 2010) के संबंध म� गलत िवक� चुन�।

Ans 1. एमएस-ए�ेल 2010 (MS-Excel 2010) म�, हम िकसी सेल (cell) म� कम�ट �िव� कर सकते ह�।     2. एमएस-ए�ेल 2010 (MS-Excel 2010)
म�, एक नई �र� (��क) फ़ाइल खोलने के िलए Ctrl+O का उपयोग िकया जाता है।     3. एमएस-ए�ेल 2010 (MS-Excel 2010) म�, हम इ�ट� टैब से टेबल �िव�
कर सकते ह�।     4. एमएस-ए�ेल 2010 (MS-Excel 2010) म�, हम F12 का उपयोग करके फाइल को सेव कर सकते ह�।

Q.8 �ोम �ाउज़र म� दाई ंओर के ��ेक खुले �ए टैब म� जाने के िलए िन�िल�खत म� से िकस कीबोड� शॉट�कट उपयोग िकया जाता है?
Ans 1. Alt + N     2. Ctrl + N     3. Alt + Tab     4. Ctrl + Tab

Q.9 एमएस-वड� 2010 (MS-Word 2010) डॉ�ूम�ट म�, हाइपरिलंक इ�ट� करने के िलए िन�िल�खत म� से िकस कीबोड� शॉट�कट की (key) का
उपयोग िकया जा सकता है?

Ans 1. Alt + K     2. Alt + L     3. Ctrl + K     4. Ctrl + L

Q.10 एमएस-ए� सेल 2010 म� संपूण� वक� शीट (worksheet) को सेले� करने के िलए ______ शॉट�कट कंुजी (key) का उपयोग िकया जाता है।
Ans 1. ALT+A     2. Ctrl+A     3. Shift+R     4. Ctrl+R
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DELHI POLICE HC- 14/10/2022 (5:00 PM - 6:30 PM)

Answers

Q1: 4 Q2: 3 Q3: 1 Q4: 3 Q5: 4 Q6: 1 Q7: 3 Q8: 3 Q9: 2 Q10: 4

Q.1 Which of the following refers to a huge database of Internet resources such as webpages, newsgroups, programs,
images etc. and helps to locate information on World Wide Web?

Ans 1. Web server     2. Protocols     3. Domain     4. Search engine

Q.2 एमएस-ए� सेल 2010 म� कॉलम सेले� करने के िलए ______ शॉट�कट कंुजी (key) का उपयोग िकया जाता है।
Ans 1. Alt + Enter     2. Ctrl + Enter     3. Ctrl + Spacebar     4. Shift + Spacebar

Q.3 Consider the following word written in a MS-Word 2010 document:
Prestige
Which of the following is correct regarding the given word?

Ans 1. The word has a strikethrough.     2. The word is bold as well as italic.     3. The word is italic.     4. The word is italic and has a
strikethrough.

Q.4 एमएस-ए� सेल 2010 �रबन बार म� ______ टैब म� फ़ं�न डालने, नाम प�रभािषत करने और गणना-संबंधी िवक�ो ंको िनयंि�त करने के िलए
टूल होते ह�।

Ans 1. REVIEW     2. PAGE Layout     3. FORMULA     4. FILE

Q.5 एमएस-वड� 2010 (MS-Word 2010) म�, िन� म� से िकस फ़ीचर का उपयोग सामा� �कार की लाइन से ब�त से छोटे अ�रो ंया सं�ाओ ंको
टाइप करने और टे� की लाइन से थोड़ा ऊपर सेट करने के िलए िकया जाता है?

Ans 1. फॉम�ल प�टर (Formal Painter)
    2. �� ाइक�ू (Strikethrough)
    3. सब��� (Subscript)
    4. सुपर��� (Superscript)

Q.6 MS-Word 2010 के फॉ� साइज िल� बॉ� म� उपल� अगले बड़े पॉइंट साइज तक फॉ� साइज को बड़ा करने के िलए िन�िल�खत म� से
िकस शॉट�कट की (key) का उपयोग िकया जाता है?

Ans 1. Ctrl + Shift + >     2. Ctrl + Shift + F4     3. Ctrl + Shift + <     4. Ctrl + Shift + F3

Q.7 सुरि�त संचार की आव�कता तब होती है जब दो प� इंटरनेट के मा�म से संचार कर रहे हो,ं और वे नही ंचाहते िक कोई तीसरा प� उनके
बीच अवरोध उ�� करे। िन�िल�खत म� से कौन-सी एक सुरि�त संचार की िवशेषता है?
P: गोपनीयता (Confidentiality)
Q: प�रशु�ता (Accuracy)

Ans 1. P और Q दोनो ं    2. केवल Q     3. केवल P     4. न तो P और न ही Q

Q.8 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, ______ का उपयोग डेटा के िकसी भी सेट का आलेखी िन�पण करने के िलए िकया जाता है।

Ans 1. कॉल� (Columns)     2. रोज़ (Rows)     3. चाट्�स (Charts)     4. टेबल (Table)

Q.9 िन�िल�खत म� से कौन सा िवक� यूजर को ई-मेल के साथ फाइल भेजने की सुिवधा देता है?

Ans 1. �ैम (Spam)     2. अटैचम�ट (Attachment)     3. �ू�ड (Snoozed)     4. मैस�जर (Messenger)

Q.10 िन�िल�खत म� से कौन सा फॉ� �भाव (effect) एमएस-ए�ेल 2010 फॉ� डायलॉग बॉ� म� उपल� नही ंहोता है?

Ans 1. इटैिलक (Italic)
    2. बो� (Bold)
    3. अंडरलाइन (Underline)     4. सुपर इटैिलक (Super Italic)
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DELHI POLICE HC- 17/10/2022 (9:00 AM - 10:30 AM)

Answers

Q1: 4 Q2: 1 Q3: 2 Q4: 4 Q5: 2 Q6: 4 Q7: 3 Q8: 1 Q9: 1 Q10: 1

Q.1 Which of the following is not an Internet etiquette?
Ans 1. Using abbreviations wisely     2. Size of attachments need to be small     3. Including name at the bottom of mails     4.

Forwarding unwanted messages

Q.2 Choose the wrong option with respect to MS-Excel 2010:
Ans 1. In MS-Excel 2010, we can save the file by using F2     2. In MS-Excel 2010, we can insert comments to a cell     3. In MS-

Excel 2010, we can insert a table from the insert tab     4. In MS-Excel 2010, to open an existing file Ctrl+O is used

Q.3 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, दो या दो से अिधक गैर-आस� वक� शीट को सेले� ट करने के िलए, पहली वक� शीट के टैब पर ��क
कर� , िफर जब आप अ� शीट िजसे सेले� करना चाहते है, के टैब पर ��क करके अपने की-बोड� पर ______ की (key) दबाए रख�।

Ans 1. Tab     2. Ctrl     3. Alt     4. Esc

Q.4 एमएस-वड� 2010 (MS-Word 2010) म� कस�र को एक पैरा�ाफ ऊपर ले जाने के िलए िन�िल�खत म� से िकस कीबोड� शॉट�कट का उपयोग िकया
जाता है?

Ans 1. Ctrl + Right arrow key     2. Ctrl + Down arrow key     3. Ctrl + Left arrow key     4. Ctrl + Up arrow key

Q.5 Which of the following command is used in MS-Word 2010 to open the file page to use backstage view?
Ans 1. Alt + C     2. Alt + F     3. Alt + H     4. Alt + G

Q.6 Which of the following is not a part of an email address?
Ans 1. Username     2. @ Symbol     3. Email provider's domain     4. User domain

Q.7 Which of the following MS-Excel 2010 function is used to converts a date that is stored as text to a serial number that
Excel recognizes as a date?

Ans 1. TODAY()
    2. NETWORKDAYS()     3. DATEVALUE()     4. EDATE()

Q.8 _______ function In MS-Excel changes all the characters of the text To UpperCase.
Ans 1. UPPER     2. PROPER     3. LOWER     4. LEN

Q.9 Which of the following search engine is dominating market with maximum number of searches on it?
Ans 1. Google     2. Bing     3. Yahoo     4. Ask.com

Q.10 Which of the following shortcut key is used to apply superscript formatting in MS-Word 2010?
Ans 1. Ctrl + Shift + +     2. Ctrl + Shift + <     3. Ctrl + Shift + >     4. Ctrl + Shift + =
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DELHI POLICE HC- 17/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 2 Q2: 4 Q3: 2 Q4: 3 Q5: 1 Q6: 2 Q7: 1 Q8: 3 Q9: 1 Q10: 2

Q.1 एमएस-वड� 2010 म�, पेज डाउन की (Page Down key) का उपयोग िन� न म� से िकसके िलए िकया जाता है?

Ans 1. जब डॉ�ूम�ट म� अनेक पेज हो ंतो कस�र को अंितम पेज पर ले जाने के िलए।     2. कस�र को एक �ीन नीचे ले जाने के िलए।     3. कस�र को एक
पैरा�ाफ नीचे ले जाने के िकए।     4. कस�र को एक लाइन नीचे ले जाने के िलए।

Q.2 एचटीएमएल (HTML) के संदभ� म� िन�िल�खत कथनो ंपर िवचार कर�।
P: एचटीएमएल (HTML) को डाटा �ोर और ट� ांसपोट� करने के िलए िडजाइन िकया गया है
Q: सभी एचटीएमएल (HTML) डॉ�ूम�ट, डॉ�ूम�ट टाइप िड�ेरेशन: <!DOCTYPE html> के साथ शु� होने चािहए
R: एचटीएमएल (HTML) वेब पेजो ंके िलए मानक माक� अप ल��ेज है।
इनम� से कौन सा/से कथन सही है/ह�?

Ans 1. P, Q, R सभी     2. केवल P और Q     3. केवल Q
    4. केवल Q और R

Q.3 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, िन� म� से � या एक फं�न है?
Ans 1. FORMULA     2. SUM     3. RANGE     4. ADD

Q.4 वेब �ाउजर म�, वत�मान पेज से िपछले पेज पर जाने के िलए िन� म� से कौन सी कमांड सहायक होती है?

Ans 1. सेव (Save)     2. फॉरवड� (Forward)     3. बैक (Back)     4. ि�एट (Create)

Q.5 जब MS-Excel 2010 की वक� शीट म� सेल के कंट�ट को एिडट िकया जा रहा हो, तो सेल नंबर ______ म� �दिश�त हो रहा होता है।

Ans 1. नेम बॉ� (name box)     2. फॉमू�ला बार (formula bar)     3. �ेटस बार (status bar)     4. �रबन (ribbon)

Q.6 एमएस-वड� 2010 (MS-Word 2010) म�, एक पैरा�ाफ या खंड के आरंभ म� सजावटी अवयव के �प म� उपयोग िकए जाने वाले एक बड़े कैिपटल
लेटर को बनाना ______ को संदिभ�त करता है।

Ans 1. �ाट� आट� (Smart Art)     2. ड� ॉप कैप (Drop Cap)     3. हेडर (Header)     4. वाटरमाक�  (Watermark)

Q.7 अ�व��त �ा�कता� सूची म� अिधक सं�ा म� भेजे गए अयािचत और अवांिछत जंक ईमेल को ______ फ़ो�र म� सं�हीत िकया जाता है।

Ans 1. � पैम (Spam)     2. ट� ैश (Trash)     3. ड� ा� (Draft)     4. इनबॉ� (Inbox)

Q.8 एमएस-वड� 2010 (MS-Word 2010) म�, समान टे� को िफर से टाइप करने के बजाय, हम समय और मेहनत को कम करने के िलए ______
का उपयोग कर सकते ह�।

Ans 1. paste + undo     2. copy + undo     3. copy + paste     4. cut + copy

Q.9 एमएस-ए�ेल 2010 म� पाँचवी ंरो (row) और पाँचव� कॉलम के �ित�ेदन (इंटरसे�न) पर सेल का एड� ेस �ा है?
Ans 1. E5     2. 5E     3. $E5$     4. $E$5

Q.10 एमएस-ए�ेल 2010 म� िन�िल�खत म� से कौन-सी एक गलत िड�ेरेशन है?
Ans 1. =TIMEVALUE("9/7/2022 6:35 AM")     2. =TIMEVALUE("Wednesday, September 7,2022 6:35 AM")     3. =TIMEVALUE("22-

Aug-2011 6:35 AM")     4. =TIMEVALUE("2:24 AM")
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DELHI POLICE HC- 17/10/2022 (5:00 PM - 6:30 PM)

Answers

Q.1 िन�िल�खत डोमेन नामो ंकी सूची को उनके अथ� से सुमेिलत कर�।

डोमेन नेम अथ�
P. .net 1. गैर - सरकारी संगठन
Q. .edu 2. वािण��क संगठन
R. .org 3. शैि�क संगठन
S. .com 4. रा� और रा�� ीय सरकारी एज��िसयो ंको इंिगत करता है
5. र�ा िवभाग
6. नेटवक�  संगठन

Ans 1. P-5, Q-1, R-2, S-4     2. P-6, Q-2, R-4, S-2     3. P-6, Q-3, R-1, S-2     4. P-1, Q-3, R-4, S-2

Q.2 एमएस-ए� सेल 2010 के �रबन बार म� हेडर (Header) और फुटर (Footer) िवक� ______ टैब म� उप��त होते है।

Ans 1. फाइल (File)     2. �ू (View)     3. इ�ट� (Insert)     4. डेटा (Data)

Q.3 एमएस वड� म� फं�न की (key) F12 का उपयोग ______ के िलए िकया जाता है।

Ans 1. फाइल मेनू ओपन करने
    2. अगली काय�शील िवंडो ओपन करने
    3. सेव एज (Save As) डायलॉग बॉ� ओपन करने
    4. काय�शील िवंडो को बंद करने

Q.4 िन�िल�खत म� से कौन-सा िवक� प एक वड� �ोसेसर नही ंहै?

Ans 1. नोटपैड (Notepad)     2. िल�ेऑिफस राइटर (LibreOffice Writer)     3. �ोम (Chrome)     4. माइ�ोसॉ� वड� (Microsoft Word)

Q.5 A table in MS-Word 2010 can have unlimited rows and a maximum of ______ columns.
Ans 1. 64     2. 62     3. 61     4. 63

Q.6 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, िन� �ंजक का मान �ा होगा?

= 22 – 12 / 3 / 2 + 4
Ans 1. 8     2. 24     3. 20     4. 26

Q.7 एमएस-ए�ेल 2010 (MS-Excel 2010) म� पहले से मौजूद फाइल को खोलने के िलए ______ का उपयोग िकया जाता है।
Ans 1. NEW     2. OPEN     3. SAVE AS     4. SAVE

Q.8 MS-Word 2010 ए��केशन म� �ूनतम जूम �ितशत �ा है?
Ans 1. 10%     2. 15%     3. 25%     4. 5%

Q.9 िबंग (Bing) एक ______ है

Ans 1. इंटरनेट सेवा �दाता (Internet service provider)     2. �ाउज़र (Browser)     3. सोशल नेटवक�  साइट (Social network site)     4. सच� इंजन
(Search engine)

Q.10 आप एक ______ ि�एट कर सकते ह�, जो आपके �ारा भेजे जाने वाले ��ेक ईमेल के अंत म� िदखाई देगा।

Ans 1. िस�ेचर (Signature)
    2. स�े� (Subject)
    3. अटैचम�ट (Attachments)
    4. फॉम��िटंग ऑ�श� (Formatting options)
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DELHI POLICE HC- 18/10/2022 (9:00 AM - 10:30 AM)

Answers

Q1: 1 Q2: 1 Q3: 3 Q4: 1 Q5: 4 Q6: 1 Q7: 2 Q8: 4 Q9: 4 Q10: 1

Q.1 एमएस-वड� 2010 के पैरा�ाफ फॉम��िटंग म�, Ctrl + Q का उपयोग िन�िल�खत म� से िकस उ�े� के िलए िकया जाता है?

Ans 1. हाइलाइट िकए गए पैरा�ाफ की पैरा�ाफ फॉम��िटंग हटाने के िलए     2. �ाइल टा� पेन ओपन और अ�ाई करने के िलए     3. पैरा�ाफ इंड��टेशन
हटाने के िलए     4. पैरा�ाफ �ेिसंग को डबल लाइन म� बदलने के िलए

Q.2 एमएस-ए� सेल 2010 के �रबन बार म� ______ टैब, वक� शीट �ू, �ीिजंग पैन, देखने और कई िवंडो को �व��त करने के बीच ��च करने के
िलए कमांड �दान करता है।

Ans 1. VIEW     2. HOME     3. REVIEW     4. FORMULA

Q.3 जीमेल (Gmail) म� �ाइंड काब�न कॉपी (BCC) के उपयोग के संबंध म� िन�िल�खत म� से कौन सा कथन सही है?

Ans 1. इसका उपयोग ईमेल की कॉपी को 100 �ाथिमक �ा�कता�ओ ंके साथ शेयर करने के िलए िकया जाता है।
    2. इसका उपयोग 10 �ाथिमक �ा�कता�ओ ंके साथ ईमेल की कॉपी शेयर करने के िलए िकया जाता है।
    3. इसका उपयोग �ाथिमक �ा�कता� को इसके बारे म� बताए िबना िकसी के साथ ईमेल की कॉपी शेयर करने के िलए िकया जाता है।
    4. इसका उपयोग सभी �ाथिमक �ा�कता�ओ ंके साथ ईमेल की कॉपी शेयर करने के िलए िकया जाता है।

Q.4 िन�िल�खत कथनो ंपर िवचार कर�।
P: उस सेल पर डबल-��क कर�  िजसम� वह डाटा है िजसे आप एिडट करना चाहते ह�।
Q: उस सेल पर ��क कर�  िजसम� वह डाटा है िजसे आप एिडट करना चाहते ह�, और िफर F2 दबाएं।
R: उस सेल पर ��क कर�  िजसम� वह डाटा है िजसे आप एिडट करना चाहते ह�, और िफर िश� की (Shift key) दबाएं।
S: उस सेल पर ��क कर�  िजसम� वह डाटा है िजसे आप एिडट करना चाहते ह�, और िफर कंट� ोल की (Ctrl key) दबाएं।
एमएस-ए�ेल 2010 वक� शीट के एिडट मोड म� काय� आरंभ करने के संबंध म� िन�िल�खत म� से कौन सा कथन सही है?

Ans 1. केवल P, Q     2. P, Q, R, S सभी     3. केवल P     4. केवल P, Q, R

Q.5 एमएस-ए�ेल 2010 (MS-Excel 2010) म� �र�ू (review) टैब खोलने के िलए ______ शॉट�कट की (key) का उपयोग िकया जाता है।
Ans 1. ALT + A     2. ALT + N     3. ALT + I     4. ALT + R

Q.6 एमएस-ए�ेल 2010 (MS-Excel 2010) के �रबन बार म� मौजूद ______ टैब, आपको वत�नी की जांच करने, प�रवत�नो ंको ट� ैक करने, कम�ट और
नोट्स िलखने, वक� शीटो ंऔर वक� बुको ंको सु�र�त करने की अनुमित देता है।

Ans 1. �र�ु (REVIEW)     2. फॉमू�ला (FORMULA)     3. फाइल (FILE)     4. डाटा (DATA)

Q.7 एमएस-ए� सेल 2010 म� ______ फं�न, िकसी टे� वै�ू के ��ेक श� के पहले अ�र को कैिपटल कर देता है।
Ans 1. LEN     2. PROPER     3. LOWER     4. UPPER

Q.8 Flipkart is one of the leading e-commerce marketplaces in India. It belongs to segment:
Ans 1. Business to Government     2. Government to Business     3. Government to Consumer     4. Business to Consumer

Q.9 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, ______ ऑपरेशन का उपयोग पहले से सेव की गई फ़ाइल को िकसी िभ� नाम से सेव करने के िलए
िकया जाता है।

Ans 1. NEW     2. OPEN     3. SAVE     4. SAVE AS

Q.10 हैथवे (Hathway) एक ______ है।

Ans 1. इंटरनेट सेवा �दाता (Internet service provider)     2. सच� इंजन (Search engine)     3. सोशल नेटवक�  साइट (Social network site)     4.
�ाउज़र (Browser)
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DELHI POLICE HC- 18/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 2 Q2: 3 Q3: 1 Q4: 4 Q5: 2 Q6: 1 Q7: 1 Q8: 3 Q9: 4 Q10: 2

Q.1 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, ______ का उपयोग तब िकया जाता है, जब आप सेल रेफर�स को िविश� सेल पर िफ� करना
चाहते ह�।

Ans 1. आटोमेिटक सेल रेफर�स (Automatic cell reference)     2. ऐ�ो�ूट सेल रेफर�स (Absolute cell reference)     3. �ेिसिफक सेल रेफर�स
(Specific cell reference)     4. िम� सेल रेफर�स (Mixed cell reference)

Q.2 एमएस-ए� सेल 2010 म� ______ का उपयोग डेटा को बार और लाइनो ंके �प म� दशा�ने के िलए िकया जाता है।
Ans 1. SORT     2. FILTER     3. CHART     4. TABLE

Q.3 ईमेल ए��केशन (email application) म� ______ एक ऐसा फो�र होता है जो आगमन संदेशो ंको �ीकार करता है।

Ans 1. इनबॉ� (Inbox)     2. ट� ैश (Trash)     3. आउटबॉ� (Outbox)     4. ड� ा� (Draft)

Q.4 एमएस-ए� सेल 2010 म� ______ फं�न यह गणना करता है िक िल� ट ऑफ आ� यू�म�ट्स (list of arguments) म� िकतनी वै� यू ह�।
Ans 1. IF     2. CEILING     3. COUNTIF     4. COUNTA

Q.5 एक ______ एक �कार का �ेषी सॉ�टवेयर या मैलवेयर होता है, जो कं�ूटर के बीच फैलता है और डेटा एवं सॉ�टवेयर को नुकसान प�ँचाता है।

Ans 1. � लॉग (BLOG)     2. वाइरस (VIRUS)     3. ईमेल (EMAIL)     4. इं� ट�ट मैस�जर (Instant messenger)

Q.6 एमएस-वड� 2010 म� टे� को बाई ंओर अलाइन करने के िलए िन�िल�खत म� से िकस शॉट�कट की (key) का उपयोग िकया जाता है?
Ans 1. Ctrl+L     2. Ctrl+M     3. Ctrl+Shift+M     4. Ctrl+Shift+L

Q.7 वेब �ाउज़र म� ______ कमांड वत�मान पेज से अगले पेज पर जाने म� सहायता करता है।

Ans 1. फॉरवड� (Forward)     2. बैक (Back)     3. सेव (Save)     4. ि�एट (Create)

Q.8 एमएस-ए�ेल 2010 की वक� शीट म� रो (rows) और कॉलम (columns) की सं�ा िकतनी होती है?

Ans 1. 65536 रो (rows) और 812 कॉलम (columns)     2. 1,048,576 रो (rows) और 65536 कॉलम (columns)     3. 1,048,576 रो (rows) और
16,384 कॉलम (columns)     4. 65536 रो (rows) और 16,384 कॉलम (columns)

Q.9 िन�िल�खत म� से कौन-सा, एमएस-वड� 2010 म� पहले से कॉ��गर वॉटरमाक�  नही ंहै?

Ans 1. �े डायगोनल टे� के साथ "CONFIDENTIAL" वॉटरमाक�      2. �े हॉ�रजॉ�ल टे� के साथ "CONFIDENTIAL" वॉटरमाक�      3. �े डायगोनल
टे� के साथ "DO NOT COPY" वॉटरमाक�      4. �े विट�कल टे� के साथ "DO NOT COPY" वॉटरमाक�

Q.10 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, पं��यो ं(rows) की पहचान िन� न म� से िकसके �ारा की जाती है?
Ans 1. @, $, %     2. 1, 2, 3     3. *, &, ^     4. A, B, C
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DELHI POLICE HC- 18/10/2022 (5:00 PM - 6:30 PM)

Answers

Q1: 2 Q2: 1 Q3: 4 Q4: 2 Q5: 4 Q6: 3 Q7: 3 Q8: 4 Q9: 4 Q10: 4

Q.1 _______refers to the topmost area of the application that contains menu items and toolbars available in MS-Excel 2010.
Ans 1. Title bar     2. Ribbon     3. Ruler bar     4. Task bar

Q.2 A ______ is a tool used in MS-Excel 2010 to calculate, summarize and analyze data and lets you see comparisons,
patterns and trends in your

data.
Ans 1. pivot table     2. reference table     3. lookup table     4. conditional table

Q.3 एमएस-वड� 2010 (MS-Word 2010) के ______ म�, पहली लाइन के अित�र� त अ� सभी लाइन� इंड�ट होती ह�।

Ans 1. ले� इंड�ट(left indent)     2. राइट इंड�ट(right indent)     3. सेकंड लाइन इंड�ट(second line indent)     4. ह��िगंग इंड�ट(hanging indent)

Q.4 एमएस-वड� 2010 (MS-Word 2010) डॉ�ूम�ट म� िडफ़ॉ� फॉ� फेस �ा होता है?

Ans 1. इटैिलक (Italic)     2. कैिलबरी (Calibri)     3. टाइ� �ू रोमन (Times New Roman)     4. ए�रयल (Arial)

Q.5 ______, एमएस-वड� 2010 (MS-Word 2010) म� डॉ�ूम�ट के ए��केशन नाम को �दिश�त करता है।

Ans 1. �रबन (Ribbon)
    2. फाइल टैब (File tab)
    3. �ीक ए�ेस टूलबार (Quick Access toolbar)
    4. टाइटल बार (Title bar)

Q.6 िन�िल�खत म� से कौन सी सबसे धीमी �कार की इंटरनेट सिव�स है?

Ans 1. 3G और 4G (3G and 4G)     2. िडिजटल स��ाइबर लाइन (Digital subscriber line)     3. डायल अप (Dial up)     4. सेटेलाइट
(Satellite)

Q.7 MS-Excel 2010 म� नीचे िदए गए फं�न िकसे �रटन� कर� गे?
=EXACT("Word", "word")

Ans 1. TRUE     2. 0     3. FALSE     4. 1

Q.8 िडलीट िकए गए मेल, ______ फ़ो�र म� पाए जा सकते ह�।

Ans 1. ड� ा� (Draft)     2. स�ट (Sent)     3. इनबॉ� (Inbox)     4. ट� ैस (Trash)

Q.9 In paragraph formatting of MS-Word 2010, the keyboard shortcut Ctrl + Q is used for which of the following purpose?
Ans 1. Open Apply Style task pane     2. Remove paragraph indentation     3. Change the paragraph spacing to double line     4.

Remove paragraph formatting from highlighted paragraph.

Q.10 ______ एक दूरसंचार तकनीक है, िजससे अलग-अलग �ानो ंपर मौजूद दो या दो से अिधक लोग पर�र वीिडयो या ऑिडयो �सारण के
मा�म से एक साथ बातचीत कर सकते ह�।

Ans 1. ईमेल (EMAIL)     2. पेम�ट गेटवे (Payment gateway)     3. �ॉग (BLOG)     4. िविडयोकॉ��� �िसंग (Videoconferencing)

KD Job Updates KD Job Updates

KD Jo
b 

Upd
at

es



DELHI POLICE HC- 19/10/2022 (9:00 AM - 10:30 AM)

Answers

Q.1 जब आप एमएस-ए�ेल 2010 वक� शीट के सेल का चयन (सेले�) करते ह� और F2 की (key) दबाते ह� तो �ा होगा?

Ans 1. सेल के कंट�ट के फ़ॉ� का रंग बदल जाएगा
    2. सेल एिडिटंग मोड म� बदल जाएगी, तािक इसके कंट�ट को संशोिधत िकया जा सके
    3. सेल के बैक�ाउंड का रंग बदल जाएगा
    4. सेल का कंट�ट िडलीट हो जाएगा

Q.2 ______ ईमेल एड� ेस का पहला भाग है।

Ans 1. यूजरनेम (username)     2. डोमेन नेम (domain name)     3. मेल सव�र (mail server)     4. िस�म नेम (system name)

Q.3 एमएस-ए�ेल 2010 (MS-Excel 2010) म� िन�िल�खत �ंजक का प�रणाम �ा होगा?
= 8 / 8 ^ 2 * 16

Ans 1. 0     2. 2     3. 16     4. 32

Q.4 एचटीएमएल (HTML) के संदभ� म� िन�िल�खत कथनो ंपर िवचार कर�।
P: एचटीएमएल (HTML) को डाटा को �ोर और ट� ांसपोट� करने के िलए िडजाइन िकया गया है।
Q: सभी एचटीएमएल (HTML) डॉ�ूम�ट, डॉ�ूम�ट �कार िड�ेरेशन: <!DOCTYPE html> से शु� होने चािहए।
R: एचटीएमएल (HTML), वेब पेजो ंके िलए मानक माक� अप ल��ेज है।
इनम� से कौन सा/से कथन अस� है/ह�?

Ans 1. केवल R     2. केवल P और R     3. केवल P और Q     4. केवल P

Q.5 एमएस-वड� 2010 (MS-Word 2010) म�, िन�िल�खत म� से कौन सा/से मा� पेज ओ�रएंटेशन है/ह�?
(i) ल�ड�ेप (Landscape)
(ii)पोट� �ट (Portrait)

Ans 1. न तो (i) और न ही (ii)     2. केवल (ii)     3. (i) और (ii) दोनो ं    4. केवल (i)

Q.6 जब आप एमएस-ए�ेल 2010 (MS-Excel 2010) म� एक नई वक� बुक ओपन करते ह�, तो �ीन पर सबसे ऊपर िन�िल�खत म� से �ा िदखाई
देता है?

Ans 1. वट�कल �ॉल बार (Vertical scroll bar)
    2. �ेटस बार (Status bar)
    3. टाइटल बार (Title bar)
    4. हॉ�रजॉ�ल �ॉल बार (Horizontal scroll bar)

Q.7 एमएस-वड� 2010 (MS-Word 2010) म� '�ाइ�' (Styles) के संदभ� म� िन�िल�खत म� से कौन-सा कथन स� है?
(i) �ाइ� (Styles) केवल एक प�रभाषा है, जो यह बताती है िक टे� को कैसा िदखना चािहए।
(ii) �ाइ� (Styles) पूरे डॉ�ूम�ट म� ि�क फॉम��िटंग संशोधनो ंकी सुिवधा देती ह�।

Ans 1. (i) और (ii) दोनो ं    2. केवल (i)     3. केवल (ii)     4. न तो (i) और न ही (ii)

Q.8 इंटरनेट से जुड़े �� येक कं�ूटर को एक आईपी (IP) पते की आव� यकता होती है। IP का पूण� �प �ा है?

Ans 1. International Partner (इंटरनेशनल पाट�नर)     2. Internal Protocol (इंटरनल �ोटोकॉल)     3. Internet Partner (इंटरनेट पाट�नर)     4.
Internet Protocol (इंटरनेट �ोटोकॉल)

Q.9 एमएस-ए�ेल 2010 म� ƒx बटन ______ ऑपरेशन का िन�पण करता है।

Ans 1. इंसट� फं�न (Insert function)     2. ए�े�/इंटर (Accept/Enter)     3. क� सल (Cancel)     4. फॉम�ट (Format)

Q.10 एमएस-ए�ेल 2010 (MS-Excel 2010) वक� बुक म� पहली वक� शीट का िडफॉ� नेम (default name) �ा होता है?
Ans 1. WSheet1     2. Spreadsheet1     3. Sheet1     4. Worksheet1
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DELHI POLICE HC- 19/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 1 Q2: 4 Q3: 3 Q4: 1 Q5: 2 Q6: 4 Q7: 3 Q8: 1 Q9: 2 Q10: 3

Q.1 एमएस-वड� 2010 (MS-Word 2010) म�, ______ टैब एक िडफ़ॉ� टैब होता है जो आपके �ारा डॉ�ूम�ट खोलने पर िदखाई देता है।

Ans 1. होम (Home)
    2. लेआउट (Layout)
    3. इ�ट� (Insert)
    4. �र�ू (Review)

Q.2 िन�िल�खत म� से कौन-सा, MS-Word 2010 म� िडफ़ॉ� �प से ि�क ए�ेस टूलबार (Quick Access Toolbar) म� मौजूद नही ंहै?

Ans 1. री डू (Redo)     2. अन डू (Undo)     3. सेव (Save)     4. कट (Cut)

Q.3 एमएस-ए� सेल 2010 म� ______ का उपयोग, शीट के भीतर रो (rows) को िछपाने (hiding) के िलए िकया जाता है।
Ans 1. Alt+9     2. Ctrl+0     3. Ctrl+9     4. Alt+0

Q.4 एमएस-ए�ेल 2010 (MS-Excel 2010) के �रबन ______ म� फ़ं�न �िव� करने, नामो ंको प�रभािषत करने और गणना िवक�ो ंको िनयंि�त
करने के िलए टूल होते ह�।

Ans 1. फॉमू�ला (FORMULA)     2. डाटा (DATA)     3. �र�ू (REVIEW)     4. फाइल (FILE)

Q.5 MS-Word 2010 म�, �लर के संदभ� म� िन�िल�खत म� से कौन सा कथन गलत है?

Ans 1. यह डॉ�ूम�ट पेजो ंके मािज�� को िनयंि�त करने म� मदद करता है     2. यह फॉ� �ाइ� को बदलने म� मदद करता है     3. यह एक लाइन के
इंड��टेशन को बदलने म� मदद करता है     4. यह टै� को सेट करने म� मदद करता है

Q.6 एमएस-वड� 2010 (MS-Word 2010), अ�ायी नाम के साथ ______ के �प म� एक नया डॉ�ूम�ट ओपन करता है।
Ans 1. Book     2. Document     3. Book 1     4. Document1

Q.7 एमएस-ए�ेल 2010 (MS-Excel 2010) म�, िन� �ंजक का मान �ा होगा?
= 6 5 6 / 4 ^ 2

Ans 1. 21     2. 61     3. 41     4. 81

Q.8 संब� वेब पेजो ंके सं�ह को ______ कहा जाता है।

Ans 1. वेबसाइट (Website)     2. Xml     3. वेबसव�र (Webserver)     4. Html

Q.9 ईमेल म� अटैचम�ट (संल�क) को दशा�ने के िलए ______ आइकन का उपयोग िकया जाता है।

Ans 1. फोन (Phone)     2. पेपर ��प (Paper clip)     3. इमोजी (Emoji)     4. �ाइली (Smiley)

Q.10 व�� वाइड वेब का िवकास िन�िल�खत म� से िकस वष� म� शु� �आ था?
Ans 1. 1959     2. 1979     3. 1989     4. 1969
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DELHI POLICE HC- 19/10/2022 (5:00 PM - 6:30 PM)

Answers

Q1: 2 Q2: 1 Q3: 1 Q4: 4 Q5: 3 Q6: 3 Q7: 1 Q8: 4 Q9: 3 Q10: 3

Q.1 िन�िल�खत म� से कौन सा एक वैध एमएस-ए�ेल 2010 (MS-Excel 2010) मैथ फं�न (Math function) नही ंहै?
Ans 1. BASE()     2. OFF()     3. ODD()     4. MOD()

Q.2 गूगल �ोम (Google Chrome) एक ______ है।

Ans 1. �ाउज़र (Browser)     2. सोशल नेटवक�  साइट (Social network site)
    3. इंटरनेट सेवा �दाता (Internet service provider)     4. मोबाइल फोन (Mobile phone)

Q.3 एमएस-ए�ेल 2010 (MS-Excel 2010) म� कॉलम की पहचान िन� न म� से िकसके �ारा की जाती है?
Ans 1. A, B, C     2. *, &, ^     3. 1, 2, 3     4. @, $, %

Q.4 एमएस-ए�ेल 2010 (MS-Excel 2010) के सेल (cell) से संबंिधत गलत िवक� का चयन कर�।

Ans 1. सेल (cell) के पते को A1, A2, A3 के �प म� दशा�या जाता है     2. सेल (cell) म� टे� हो सकता है, जैसे अ�र, सं�ाएं और ितिथयां     3. रो
(Row) और कॉलम के इंटरसे�न को सेल (cell) के �प म� जाना जाता है     4. सेल (cell) के पते को 1, 2, 3 के �प म� दशा�या जाता है

Q.5 गूगल �ोम �ाउजर के ज़ूम को िडफ़ॉ� पर रीसेट करने के िलए िन�िल�खत म� से िकस कीबोड� शॉट�कट का उपयोग िकया जाता है?
Ans 1. CTRL + R     2. CTRL + D     3. CTRL + 0     4. CTRL + 9

Q.6 MS-Excel 2010 की वक� शीट म� सेले�ेड से� म� आउटलाइन जोड़ने के िलए िन�िल�खत म� से िकस शॉट�कट की (key) का उपयोग िकया
जाता है?

Ans 1. Ctrl+Shift+Underscore (_)     2. Ctrl+Shift+Right arrow     3. Ctrl+Shift+Ampersand sign (&)     4. Ctrl+Shift+Left Arrow

Q.7 ______ एक वैि�क संचार �णाली है, जो हजारो ं���गत नेटवक� (individual networks) को एक साथ जोड़ती है।

Ans 1. इंटरनेट (Internet)     2. टोपोलॉजी (Topology)     3. इट� ानेट (Intranet)     4. एटीएम (ATM)

Q.8 एमएस-वड� 2010 (MS-Word 2010) म�, आप िकसी डॉ�ूम�ट के िकसी िविश� िह�े से टे� को कट कर सकते ह� और उस टे� को उस
डॉ�ूम�ट म� कही ंभी पे� कर सकते ह�। जब आप टे� को कट करते ह�, तो यह ______ पर �ोर हो जाता है।

Ans 1. सेल (CELL)     2. टेबल (TABLE)     3. रो (ROW)     4. ��पबोड� (CLIPBOARD)

Q.9 ______, एमएस-ए� सेल 2010 म� सबसे �चिलत फं� शन म� से एक है, और यह आपको िकसी वै� यू और आपकी अपे�ा के बीच तािक� क तुलना
करने की सुिवधा देता है।

Ans 1. CEILING     2. FLOOR     3. IF     4. COUNTIF

Q.10 एमएस-ए�ेल 2010 (MS-Excel 2010) म� डॉ�ूम�ट को ज�ी से जूम करने के िलए, ______ से माइनस (minus) और �स (plus) िच�ो ंका
उपयोग िकया जाता है।

Ans 1. टाइटल बार (Title bar)     2. फामू�ला बार (Formula bar)     3. �ेटस बार (Status bar)     4. हॉ�रजॉ�ल �ॉल बार (Horizontal scroll bar)
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DELHI POLICE HC- 20/10/2022 (9:00 AM - 10:30 AM)

Answers

Q1: 4 Q2: 4 Q3: 1 Q4: 3 Q5: 2 Q6: 2 Q7: 1 Q8: 2 Q9: 3 Q10: 2

Q.1 Data validation option is present in _______ tab in MS-Excel 2010 ribbon bar.
Ans 1. Insert     2. File     3. View     4. Data

Q.2 एमएस-वड� 2010 (MS-Word 2010) डॉ�ूम�ट को बंद करने के िलए कीबोड� शॉट�कट की (key) ______ है।
Ans 1. Ctrl + Z     2. Ctrl + X     3. Ctrl + Y     4. Ctrl + W

Q.3 एमएस-वड� 2010 (MS-Word 2010) म�, िल�खत टे� और पेपर के िकनारे के बीच की दूरी को ______ कहा जाता है।

Ans 1. मािज�न (Margin)
    2. अलाइनम�ट (Alignment)
    3. �लर लाइन (Ruler Line)
    4. इंड�ट �ॉप (Indent Stop)

Q.4 एमएस-ए�ेल 2010 ए��केशन म� �ूनतम ज़ूम �ितशतता िकतनी होती है?
Ans 1. 20%     2. 0%     3. 10%     4. 50%

Q.5 एमएस-ए�ेल 2010 (MS-Excel 2010) म� ______ फं�न िकसी सं�ा को िनकटतम पूणा�क या िदए गए मान के िनकटतम गुणज (nearest
multiple of significance) तक पूणा�िकत करता है।

Ans 1. IF     2. CEILING     3. COUNTIF     4. FLOOR

Q.6 Which of the following the component where email is received and managed?
Ans 1. Trash     2. Inbox     3. Drafts     4. Sent mail

Q.7 इंटरनेट पर सूचना भेजने, संचारण (traveling) और �ा� करने को िनयंि�त करने वाले िनयमो ंको �ा कहा जाता है?

Ans 1. �ोटोकॉल (Protocols)
    2. �ोसीजर (Procedure)
    3. ए�ो�र� म (Algorithms)
    4. �ो�ाम (Programs)

Q.8 एक सेवा, जो हम� एक अि�तीय पते के साथ इंटरनेट पर इले�� ॉिनक मोड म� संदेश भेजने की सुिवधा देती है। यह लोगो ंके बीच जानकारी
िवत�रत करने का एक कुशल, िमत�यी और समयोिचत साधन �दान करती है।

Ans 1. िविडयोकॉ��� �िसंग (Videoconferencing)     2. ईमेल (EMAIL)     3. � लॉग (VLOG)     4. � लॉग (BLOG)

Q.9 माइ�ोसॉ� ए�ेल 2016 (Microsoft Excel 2016) म�, िन�िल�खत म� से कौन-सा फ़ॉमू�ला िन�ािदत होने पर एरर (error) देगा?
Ans 1. = SUM (A9 : A15) * SUM (K9 : K15)     2. = SUM (A9 : A15) * 10     3. = SUM (A9 : A15) – B4 / 10     4. =SUM (L9 : L12) *

SUM (K9 : K12) / (10 - 9)

Q.10 यिद एमएस वड� 2007 (MS Word 2007) म� 'Examination' श� पर यिद tOGGLE cASE लागू िकया जाता है तो प�रणाम �ा होगा?
Ans 1. examination     2. eXAMINATION     3. EXAMINATION     4. Examination
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DELHI POLICE HC- 20/10/2022 (1:00 PM - 2:30 PM)

Answers

Q1: 4 Q2: 2 Q3: 2 Q4: 1 Q5: 3 Q6: 4 Q7: 1 Q8: 2 Q9: 4 Q10: 2

Q.1 एमएस-ए� सेल 2010 के संबंध म� गलत िवक� का चयन कीिजए।

Ans 1. एमएस-ए� सेल 2010 म�, �रबन बार म� होम टैब (Home Tab) म� सबसे अिधक बार उपयोग िकए जाने वाले कमांड होते ह� जैसे िक कॉपी और पे�
करना, सॉट� और िफ़�र करना, फॉम�ट करना आिद।
    2. एमएस-ए� सेल 2010 म�, Ctrl + 0 का उपयोग, शीट के भीतर कॉलम को छुपाने (hiding) के िलए िकया जाता है।     3. एमएस-ए� सेल 2010 म�, Ctrl + 9 का
उपयोग, शीट के भीतर रो (rows) को छुपाने (hiding) के िलए िकया जाता है।     4. एमएस-ए� सेल 2010 म�, Alt + 0 का उपयोग, शीट के भीतर कॉलमो ंको छुपाने
(hiding) के िलए िकया जाता है।

Q.2 एमएस-ए�ेल 2010 (MS-Excel 2010) म� वक� बुक को बंद करने के िलए ______ फं�न की (key) का उपयोग िकया जाता है।
Ans 1. Ctrl+F3     2. Ctrl+F4     3. Ctrl+F1     4. Ctrl+F2

Q.3 एमएस-वड� 2010 म� िन�िल�खत म� से कौन सा ऑपरेशन आपके डॉ�ूम�ट म� कंट�ट ��पबोड� से डालता है?

Ans 1. हायफनेशन (Hyphenation)     2. पे� (Paste)     3. फॉम�ट प�टर (Format painter)     4. कॉपी (Copy)

Q.4 इंटरनेट िव� भर के आपस म� जुड़े कं�ूटरो ंका एक समूह है। इंटरनेट अपने आप म� ______ का एक �कार है।

Ans 1. वैन (WAN)     2. मैन (MAN)     3. वीपीएन (VPN)     4. लैन (LAN)

Q.5 एमएस-ए�ेल 2010 (MS-Excel 2010) के सेल A1 म� एक सू� "=B2+4" पर िवचार कर�। यिद सेल A1 को कॉपी करके D4 म� पे� िकया जाता
है, तो D4 म� फॉमू�ला �ा होगा?

Ans 1. =D4+4     2. =B2+4     3. =E5+4     4. =B4+7

Q.6 गूगल �ोम एक वेब �ाउिजंग सॉ�वेयर है, िजसे गूगल इंक (Google Inc) �ारा वष� ______ म� िवकिसत िकया गया है।
Ans 1. 2009     2. 2010     3. 2007     4. 2008

Q.7 िन�िल�खत म� से कौन सा ईमेल एड� ेस का सही �म है?

Ans 1. यूजर नेम, @, डोमेन नेम     2. @, यूजर नेम, डोमेन नेम     3. @, डोमेन नेम, यूजर नेम     4. डोमेन नेम, @, यूजर नेम

Q.8 एमएस-वड� 2010 (MS-Word 2010) डॉ�ूम�ट को सेव करने के िलए िन� म� से िकस कीबोड� शॉट�कट का उपयोग िकया जाता है?
Ans 1. Ctrl + C

    2. Ctrl + S
    3. Ctrl + B
    4. Ctrl + A

Q.9 एमएस-ए� सेल 2010 म� ______ शॉट�कट कंुजी (key) का उपयोग टे� की एक नई लाइन शु� करने या वक� शीट सेल म� टे� की लाइनो ंया
पैरा�ाफ के बीच � पेस को बढ़ाने के िलए िकया जाता है।

Ans 1. ALT+Space     2. Ctrl+Space     3. Ctrl+Enter     4. ALT+Enter

Q.10 एमएस-ए� सेल 2010 म� _______ फं�न िकसी ितिथ के अनु�प वष� िलख देता है।
Ans 1. CURRENT     2. YEAR     3. TODAY     4. NOW
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DELHI POLICE HC- 20/10/2022 (5:00 PM - 6:30 PM)

Answers

Q1: 1 Q2: 4 Q3: 1 Q4: 3 Q5: 4 Q6: 3 Q7: 3 Q8: 4 Q9: 4 Q10: 4

Q.1 एमएस-ए� सेल 2010 म� टेबल का नाम बदलने के िलए ______ शॉट�कट कंुजी (key) का उपयोग िकया जाता है।
Ans 1. Ctrl + R

    2. Alt + R
    3. Alt + I
    4. Ctrl + I

Q.2 एमएस-ए�ेल 2010 (MS-Excel 2010) वक� शीट म� सातवी ंरो और दसव� कॉलम के इ�रसे�न पर ��त सेल का एड� ेस �ा होगा?
Ans 1. 7J

    2. G10     3. $J7$     4. J7

Q.3 िन�िल�खत म� से �ा ईमेल एड� ेस का एक कंपोन�ट (घटक) नही ंहै?

Ans 1. िस�म नेम (System name)     2. यूजरनेम (Username)     3. @ (at िच�)     4. डोमेन नेम (Domain name)

Q.4 िन�िल�खत म� से कौन-सा िवक� प माक� अप ल��ेज का उदाहरण नही ंहै?
Ans 1. HTML     2. XML     3. QBE     4. SGML

Q.5 एमएस-वड� 2010 (MS-Word 2010) म�, टेबल बनाने के बाद, यिद आप िकसी टेबल म� िकसी िवशेष रो (row) के नीचे एक नई रो (row) इ�ट�
करना चाहते ह�, तो आपको िन�िल�खत म� से िकस िवक� का उपयोग करना होगा?

Ans 1. Insert Rows Above     2. Insert Columns to the Right     3. Insert Columns to the Left     4. Insert Rows Below

Q.6 एमएस-वड� 2010 (MS-Word 2010) म�, िन�िल�खत म� से िकस कीबोड� शॉट�कट की (key) का उपयोग टेबल की एक रो (row) म� िपछले सेल म�
जाने के िलए िकया जाता है?

Ans 1. Ctrl + Tab     2. Windows + Tab     3. Shift + Tab     4. Alt + Tab

Q.7 एमएस-ए�ेल 2010 (MS-Excel 2010) �रबन बार म� ______ टैब ऑन�ीन और ि�ंटेड दोनो ंम� वक� शीट के �प को �व��त करने के िलए
टू� �दान करता है। ये टू� थीम सेिटं�, ि�डलाइ�, पेज मािज��, ऑ�े� अलाइिनंग और ि�ंट ए�रया को िनयंि�त करते ह�।

Ans 1. फाइल (FILE)     2. �र�ू (REVIEW)     3. पेज लेआउट (Page Layout)     4. फॉमू�ला (FORMULA)

Q.8 एमएस-ए�ेल 2010 (MS-Excel 2010) म� इ�ट� टैब पर जाने के िलए शॉट�कट की (key) ______ का उपयोग िकया जाता है।
Ans 1. ALT+F     2. ALT+I     3. ALT+T     4. ALT+N

Q.9 बताएं, िक एमएस-वड� 2010 (MS-Word 2010) से संबंिधत िन�िल�खत कथन स� ह� या अस�?

(i) ल�ड�ेप ओ�रएंटेशन म�, िकसी पेज की ऊँचाई उसकी चौड़ाई से अिधक होती है।
(ii) पोट� �ट ओ�रएंटेशन म�, पेज की चौड़ाई उसकी ऊँचाई से अिधक होती है।

Ans 1. (i) - अस� (ii) - स�     2. (i) - स� (ii) - स�     3. (i) - स� (ii) - अस�     4. (i) - अस� (ii) - अस�

Q.10 ______, ���यो ंऔर लोगो ंके समूह के बीच रीयल टाइम चैट (real time chat) की सुिवधा �दान करता है।

Ans 1. ईमेल (EMAIL)     2. वाइरस (VIRUS)     3. � लॉग (BLOG)     4. इ��ट मेस�जर (Instant messenger)
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 िन�िल�खत म� से कौन-सी, कं�ूटर की एक िवशेषता नही ंहै?

Ans A. ब�आयामी �ितभा (Versatility)     B. बु�� ल�� (Intelligent quotient)     C. गित (Speed)     D. शु�ता (Accuracy)

Q.2 एमएस-पॉवरपॉइंट 365 म� �ाइड की ट� ांिजशन �ीड (transition speed) को सेट करने के िलए िन�िल�खत म� से िकस िवक� का उपयोग
िकया जाता है?

Ans A. िडजाइन (Design) -> �ूरेशन (Duration)     B. एिनमेश� (Animations) -> �ूरेशन (Duration)     C. ट� ांिजशन (Transition) ->�ूरेशन
(Duration)     D. �ाइड शो (Slide Show) -> �ूरेशन (Duration)

Q.3 एमएस-पॉवरपॉइंट 365 म� सेले�ेड टे� के फॉ� साइज बदलने के िलए िन�िल�खत म� से िकस शॉट�कट कंुिजयो ं(keys) का उपयोग िकया
जाता है?

Ans A. Alt+N, S, H     B. Alt+G, H     C. Alt+H, F, S     D. Alt+W, Q

Q.4 Which of the following is a world-wide network of computers, also known as network of networks?
Ans A. World Wide Web     B. Internet     C. MAN     D. VLAN

Q.5 MS-Word 365 के िन�िल�खत म� से िकस िवक� का उपयोग सेले�ेड टे� (selected text), पैरा�ाफ (paragraph) या टेबल सेल (table
cell) के पीछे का रंग बदलने के िलए िकया जाता है?

Ans A. टे� हाईलाइट कलर (Text Highlight Color)     B. फॉ� कलर (Font Color)     C. शेिडंग (Shading)     D. टे� इफे�्स एंड टाइपो�ाफी
(Text Effects and Typography)

Q.6 िन�िल�खत म� से कौन सा िवक� गूगल �ोम �ाउज़र (Google Chromebrowser) म� एक संपूण� वेब पेज को ि�ंट करने का सही �म है?

Ans A. वेब पेज खोल� -> ि�ंट �ी�ू पर ��क कर�  -> ‘ि�ंट’ आइकन पर��क कर�
(Open the web page -> Click on Print Preview -> Click on the ‘Print’ icon)     B. वेब पेज खोल� -> पेज सेटअप पर ��क कर�  -> ‘ि�ंट’ आइकन पर��क
कर�
(Open the web page -> Click on Page Setup -> Click on the ‘Print’ icon)     C. वेब पेज खोल� -> Ctrl + S दबाएं -> पेज पर राइट ��क कर�  और ‘ि�ंट’ पर
ले� ��क कर�
(Open the web page -> Press Ctrl + S -> Right click on the page and left click on ‘Print’)     D. वेब पेज खोल� -> Ctrl + A दबाएं -> पेज पर राइट ��क
कर�  और ‘ि�ंट’ पर ले� ��क कर�
(Open the web page -> Press Ctrl + A -> Right click on the page and left click on ‘Print’)

Q.7 िलन� (Linux) एक पोट�बल ऑपरेिटंग िस�म (portable operating system) होता है। िन�िल�खत म� से कौन-सा िवक� प िलन� के
पोट� �िबिलटी फीचर (portability feature) का सबसे अ�ा वण�न करता है?

Ans A. िलन� (Linux) िविभ� �कार के हाड�वेयर पर काय� कर सकता है।     B. िलन� (Linux) एक ही समय म� म�ीपल यूजस� को सपोट� कर सकता
है।     C. िलन� (Linux) GUI को सपोट� कर सकता है।     D. िलन� (Linux) एक ही समय म� कई काय��मो ंको सपोट� कर सकता है।

Q.8 MS-Word 365 म� िन�िल�खत म� से कौन-सा िवक�, िकसी पेज के लेआउट और ि�ंट िवक�ो ंको सेट करने म� उपयोग िकया जाता है?

Ans A. ड� ॉ (Draw)     B. पेज सेटअप (Page Setup)     C. िडजाइन (Design)     D. �र�ू (Review)

Q.9 MS-Excel 365 म� सेल के िविश� अ�र को �ित� थािपत करने के िलए िन�िल�खत म� से कौन-सा त� सही है?

Ans A. सेल म� ��क करना और िफर नए अ�र टाइप करना     B. सेल म� ��क करना और िफर िडलीट (Delete) को दबाना     C. सेल म� ��क करना
और िफर बैक�ेस दबाना     D. िविश� अ�रो ंको सेले� करना और िफर नए अ�रो ंको टाइप करना

Q.10 इंटरनेट पर साम�ी को सच� करने के संदभ� म� िन�िल�खत म� से कौन-सा त� स� नही ंहै?

Ans A. उ�रण िच�ो ंका उपयोग करना (Use quotation marks)     B. जिटल सच� टम� का उपयोग करना (Use complex search terms)     C.
िविश� कीवड� का उपयोग करना (Use specific keywords)     D. अपने सच� इंजन को बदलना (Vary your search engine)

Q.11 एक कं�ूटर िन�िल�खत म� से िकस भाषा (language) को सीधे समझ सकता है?

Ans A. िन� न-� तर (Low-level)     B. व� तु � तर (Object level)     C. म� यम � तर (Medium level)     D. उ� च-� तर (High-level)

Q.12 MS-Excel 365 म� अनु�िमक �म म� िदनांको ंकी सूची को ��रत �प से बनाने के िलए िन�िल�खत म� से िकस िवक� का उपयोग िकया जा
सकता है?

Ans A. िफल ह�डल (Fill Handle)     B. ऑटो क��ीट (Auto Complete)     C. आटो रन (Auto Run)     D. ऑटो हाइड (Auto hide)
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Q.13 एमएस-पॉवरपॉइंट 365 में किसी फाइल को सेव करने का सही विकल्प निम्नलिखित में से कौन-सा है?

Ans A. फाइल (File) -> सेव (Save)     B. ड्रा  (Draw) -> सेव (Save)     C. इन्सर्ट (Insert) -> सेव (Save)     D. डिजाइन (Design) -> सेव (Save)

Q.14 TCP एक ______ प्रोटोकॉल है, जबकि UDP एक ______ प्रोटोकॉल है।

Ans A. एप्लिके शन-लेयर (application-layer); कनेक्शन-ओरिएं टेड (connection-oriented)     B. कनेक्शन-लेस (connection-less), कनेक्शन-
ओरिएं टेड (connection-oriented)     C. कनेक्शन-ओरिएं टेड (connection-oriented); कनेक्शन-लेस (connection-less)     D. कनेक्शन-लेस (connection-
less); एप्लिके शन-लेयर (application-layer)

Q.15 GUI आधारित ऑपरे टिंग सिस्टम (Operating Systems) के  संदर्भ में निम्नलिखित में से कौन-सा/से कथन सत्य है/हैं?

(i) डॉस (DOS) और लिनक्स (Linux) दोनों  GUI आधारित होते हैं।
(ii) डॉस (DOS) और यूनिक्स (Unix) दोनों  GUI आधारित होते हैं।

Ans A. न तो (i) न ही (ii)     B. (i) और (ii) दोनों     C. के वल (i)     D. के वल (ii)

Q.16 MS-Word 365 में जब हम मिनी टू लबार (Mini toolbar), जो उन टेबल सेल, रो या कॉलम में राइट-क्लिक करने से प्रदर्शित होता है जिन्हें आप
डिलीट करना चाहते हों , में 'डिलीट' (Delete) विकल्प पर क्लिक करते हैं, तो निम्नलिखित में से कौन-सा विकल्प उपलब्ध नहीं  होता है?

Ans A. डिलीट सेल्स (Delete Cells)     B. डिलीट रोज़ (Delete Rows)     C. डिलीट पेजेज़ (Delete Pages)     D. डिलीट कॉलम्स (Delete
Columns)

Q.17 किसी विंडोज़ 10 ऑपरे टिंग सिस्टम (Windows 10 operating system) में डेस्कटॉप बैकग्राउंड (Desktop background) को बदलने के  लिए
निम्नलिखित में से किसका उपयोग किया जा सकता है?

Ans A. डेस्कटॉप पर कहीं  भी डबल क्लिक करें      B. डेस्कटॉप पर राइट क्लिक करें  और 'पर्सनलाइज़'(Personalize) ऑप्शन को सेलेक्ट करें      C.
डेस्कटॉप पर कहीं  भी ट्रि पल क्लिक करें      D. डेस्कटॉप पर राइट क्लिक करें  और 'न्‍यू' (New) ऑप्शन को सेलेक्ट करें

Q.18 निम्नलिखित में से कौन-सा प्रिंटर, एक इंक-रिबन पर पिन मारकर अक्षरों  को छापता है?

Ans A. लेज़र (Laser)     B. इंकजेट (Inkjet)     C. डॉट मैट्रि क्स (Dot matrix)     D. एलईडी (LED)

Q.19 MS-Excel 365 में एडिट मोड (Edit mode) में कार्य प्रारंभ करने के  लिए, निम्नलिखित में से कौन-सा तथ्य सही नहीं  है?

Ans A. उस सेल पर क्लिक करना जिसमें वह डेटा है जिसे आप संपादित करना चाहते हैं, और फिर फॉर्मूला बार में कहीं  भी क्लिक करना     B. उस सेल पर
डबल-क्लिक करना जिसमें वह डेटा है जिसे आप संपादित करना चाहते हैं     C. उस सेल पर क्लिक करना जिसमें वह डेटा है जिसे आप संपादित करना चाहते हैं, और
फिर F5 को दबाना     D. उस सेल पर क्लिक करना जिसमें वह डेटा है जिसे आप संपादित करना चाहते हैं, और फिर F2 को दबाना

Q.20 कं प्यूटर की मुख्य मेमोरी निम्नलिखित में से किस तकनीक का उपयोग करके  बनाई जाती है?

Ans A. ऑप्टिकल (Optical)     B. मैग्नेटिक (Magnetic)     C. वैक्यूम ट्यूब (Vacuum tube)     D. सेमी-कं डक्टर (Semi-conductor)

Q.21 IBM-360 सीरीज, कं प्यूटर की निम्नलिखित में से किस पीढ़ी से संबंधित है?

Ans A. चतुर्थ     B. तृतीय     C. प्रथम     D. द्वितीय

Q.22 निम्नलिखित में से कौन-सा तथ्य, ई-मेल (e-mail) के  संदर्भ में स्पैम (spam) को नियंत्रित करने का तरीका नहीं  है?

Ans A. स्पैम फ़िल्टरिंग टू ल (spam filtering tools) और एं टी-वायरस सॉफ़्टवेयर (anti-virus software) को डाउनलोड करना     B. अपने ई-मेल (e-
mail) पते को सार्वजनिक रूप से घोषित करना या पोस्ट करना     C. स्पैम (spam) संदेशों का जवाब न देना     D. किसी भी हाइपरलिंक (hyperlink) पर क्लिक करने
से पहले सोचना

Q.23 Which of the following is FALSE with respect to the control unit of a computer?
Ans A. It obtains instructions from the memory, interprets them, and directs the operation of the computer.     B. It is responsible for

controlling the transfer of data and instructions among other units of the computer.     C. It processes and stores data.     D. It manages and
coordinates all the units of the computer.

Q.24 Which of the following formatting options connects text to the top, middle, or bottom of a bounding box in MS-
PowerPoint 365?

Ans A. Add or Remove Columns     B. Align Text     C. Text Direction     D. Numbering or Bullets

Q.25 MS-Word 365 में निम्नलिखित में से किस टैब में पेज बॉर्डर्स (Page Borders) विकल्प उपलब्ध होते है?

Ans A. होम (Home)     B. डिज़ाइन (Design)     C. डेवलपर (Developer)     D. प्रीव्यू (Review)
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Q.26 उपयोगकर्ताओं के  बीच संदेशों  के  आदान-प्रदान के  लिए निम्नलिखित में से कौन-सा कं प्यूटर आधारित एक एप्‍लीके शन है?

Ans A. ई-श्रम (e-sharm)     B. ई-के वाईसी (e-kyc)     C. ई-आधार (e-aadhar)     D. ई-मेल (e-mail)

Q.27 MS-Excel 365 में पंक्तियों  (rows) का आकार बदलने के  लिए निम्न में से किस विकल्प का उपयोग किया जाता है?

Ans A. होम -> सेल स्टाइल्स -> रो विड्थ या रो हाइट
(Home -> Cell Styles -> Row Width or Row Height)     B. होम -> इन्सर्ट -> रो विड्थ या रो हाइट
(Home -> Insert -> Row Width or Row Height)     C. फॉर्मेट ऐज टेबल -> फॉर्मेट -> रो विड्थ या रो हाइट
(Format as Table -> Format -> Row Width or Row Height)     D. होम -> फॉर्मेट -> रो विड्थ या रो हाइट
(Home -> Format -> Row Width or Row Height)

Q.28 निम्नलिखित में से कौन-सा विकल्प निम्नलिखित कथनों  की सत्यता का सर्वोत्तम वर्णन करता है?

(i) विंडोज़ टास्कबार (Windows taskbar) सामान्‍य रूप से स्क्रीन के  निचले भाग पर एक क्षैतिज रेखा के  रूप में दिखाई देता है।
(ii) विंडोज 10 टास्कबार (Windows 10 taskbar) में एक सर्च बॉक्स होता है जिसका उपयोग कं प्यूटर और वेब दोनों  को ब्राउज़ करने के  लिए
किया जा सकता है

Ans A. (i) – असत्य, (ii) – असत्य     B. (i) – असत्य, (ii) – सत्य     C. (i) – सत्य, (ii) – सत्य     D. (i) – सत्य, (ii) – असत्य

Q.29 जिन वेबसाइटों  पर हम सबसे अधिक जाते हैं, उन पर शीघ्रता से नेविगेट (navigate) करने के  लिए निम्नलिखित में से कौन-सा विकल्‍प एक अच्‍छा
तरीका है?

Ans A. हिस्ट्री  (History)     B. हेल्प (Help)     C. फे वरिट्स (Favorites)     D. डाउनलोड्स (Downloads)

Q.30 Which of the following menus is used for adding clip art pictures to a presentation in MS-PowerPoint 365?
Ans A. Insert     B. Animation     C. Transitions     D. Design

Q.31 Which of the following options best describes the truthfulness of the given statements?

(i) Type "WinWord.exe" without quotation marks in the Run dialogue box and click ‘OK’
(ii) Type "Word.exe" without quotation marks in the Run dialogue box and click ‘OK’

Ans A. (i)-False (ii)True     B. (i)-True (ii)-True     C. (i)-True (ii)-False     D. (i)-False (ii)-False

Q.32 MS-Word 365 में प्रिंट प्रीव्यू (Print Preview) के  संदर्भ में निम्नलिखित में से कौन-सा कथन सत्य है?

Ans A. फ़ाइल (File) > प्रिंट (Print) को क्लिक करने पर, दाईं ओर, आपको प्रिंट (Print) बटन और कॉन्फ़िगर करने योग्य सेटिंग्स (Settings) दिखाई देंगी।
    B. वर्ड (Word) एक ही विंडो में प्रिंट (Print) और प्रीव्यू (Preview) को जोड़ता है।     C. होम (Home) टैब के  पैराग्राफ ग्रुप में, हम के वल कु छ निश्चित पृष्ठों को प्रिंट
करने (printing only certain pages), पृष्ठ अभिविन्यास (page orientation) बदलने आदि जैसे विकल्पों का चयन कर सकते हैं।     D. फाइल (File) > प्रिंट (Print)
को क्लिक करने पर, बाईं ओर, आपको अपने प्रेजेंटेशन का प्रीव्यू दिखाई देगा।

Q.33 आउटलुक 2016 में ई-मेल (e-mail) में स्माइली इमोजी (smiley emoji) डालने के  लिए निम्नलिखित में से किस प्रतीक का उपयोग किया जाता
है?

Ans A. :-)     B. ;-)     C. :-O     D. :-(

Q.34 MS-Excel 365 में किसी अन्य विंडोज़ ऑपरे टिंग सिस्टम पर उपयोग किए जाने के  लिए, किसी वर्क बुक को कॉमा-डिलिमिटेड (comma-
delimited) टेक्स्ट फाइल के  रूप में सेव (save) करने में निम्नलिखित में से किस फाइल फॉर्मेट का उपयोग किया जाता है?

Ans A. सीएसवी (कॉमा डिलिमिटेड) CSV (comma delimited)     B. फॉर्मेटेड टेक्स्ट (Formatted Text)     C. यूनिकोड टेक्स्ट (Unicode Text)     D.
टेक्‍स्‍ट (एमएस-डॉस) Text (MS-DOS)

Q.35 Which of the following is true with reference to a Local Area Network?
Ans A. It is a collection of devices connected in different countries.     B. WAN cannot connect many LANs together.     C. LANs can

be operated only on Client/Server technology.     D. It connects devices that are in a single, limited area.

Q.36 निम्नलिखित में से कौन-सी इमेज, MS-Word 365 में सेलेक्टेड टेक्स्ट से सभी फॉर्मेटिंग को हटाने के  लिए उपयोग किए जाने वाले आइकन को
दर्शाती है?

Ans A.      B.      C.      D. 
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Q.37 एमएस-पॉवरपॉइंट 365 में, सेट अप स्लाइड शो (Set Up Slide Show) के  निम्नलिखित में से किस विकल्प का उपयोग, स्लाइड शो को तब तक
लूप करने के  लिए किया जाता है, जब तक कि इसे देखने वाले लोग Esc कुं जी(key) न दबाएँ ?

Ans A. ब्राउज्ड बाई एन इंडिविजुअल (विंडो) (Browsed by an individual (window)
    B. प्रेजेंटेड बाई ए स्पीकर (फु ल स्क्रीन) (Presented by a speaker (full screen)
    C. ब्राउज्ड एट ए कियोस्‍क (फु ल स्क्रीन) (Browsed at a kiosk (full screen)
    D. प्रेजेंटेड बाई एन इंडिविजुअल (फु ल स्क्रीन) (Presented by an individual (full screen)

Q.38 निम्नलिखित में से कौन-सा, एक ब्राउज़र सॉफ्टवेयर नहीं  है?

Ans A. क्रोमियम (Chromium)     B. माइक्रोसॉफ्ट एज (Microsoft Edge)     C. डकडकगो (DuckDuckGo)     D. ब्रेव (Brave)

Q.39 एमएस-पॉवरपॉइंट 365 में टेम्प्लेट (Template) का उपयोग करके  प्रेजेंटेशन बनाने का सही तरीका निम्नलिखित में से कौन-सा है?

Ans A. फाइल (File) -> न्यू (New) -> सर्च फॉर ऑनलाइन टेंपलेट्स एं ड थीम्स (Search for online templates and themes)     B. फाइल (File) ->
ओपन (Open) -> सर्च फॉर ऑनलाइन टेंपलेट्स एं ड थीम्स (Search for online templates and themes)     C. फाइल (File) -> रिसेंट (Recent) -> सर्च फॉर
ऑनलाइन टेंपलेट्स एं ड थीम्स(Search for online templates and themes)     D. फाइल (File) -> होम (Home) -> सर्च फॉर ऑनलाइन टेंपलेट्स एं ड थीम्स
(Search for online templates and themes)

Q.40 एक्सेस स्पीड (access speed) के  बढ़ते क्रम के  संदर्भ में निम्नलिखित में से कौन-सा विकल्प सही है?
Ans A.

    B.

    C.

    D.

Q.41 MS-Excel 365 में वर्क शीट को प्रिंट करने का सही विकल्प निम्नलिखित में से कौन-सा है?
Ans A. File -> Print     B. Home -> Print     C. Page Layout -> Print     D. View -> Print

Q.42 यदि हम MS-Excel 365 में एक ही सेल में, लेकिन एक नई लाइन पर डेटा प्रविष्‍ट करना चाहते हैं, तो निम्नलिखित में से किस कीबोर्ड शॉर्टकट
(keyboard shortcuts) का उपयोग किया जाएगा?

Ans A. Alt + Enter     B. Ctrl + Esc     C. Alt + Esc     D. Shift + Enter

Q.43 निम्नलिखित में से कौन-सा, लिनक्स का वह मुख्य घटक है जो हार्डवेयर के  साथ इंटरैक्ट (interact) करता है?

Ans A. शेल (Shell)     B. एडिटर (Editor)     C. कर्नेल (Kernel)     D. जीयूआई (GUI)

Q.44 MS-Excel 365 फॉर्मूला में पंक्ति (row) 5 में सभी सेलों  को संदर्भित करने के  लिए निम्नलिखित में से किसका उपयोग किया जाता है?
Ans A. 5$5$     B. 5:5     C. 5     D. $5$5

Q.45 निम्नलिखित में से कौन-सा विकलप, सरकार और लोगों  के  बीच सबसे कु शल और सफल माध्यमों  में से एक है और IECT के  द्वारा प्राप्त किया
जाता है?

Ans A. ई-ऑफिस (e-office)     B. ई-मनी (e-money)     C. ई-बिजनेस (e-business)     D. ई-गवर्नेंस (e-governance)

Q.46 निम्नलिखित में से कौन-सी इंटरनेट सेवा, इंटरनेट पर फोन कॉल करने और प्राप्त करने का तरीका बताती है?

Ans A. इंटरनेट रिले चैट (Internet Relay Chat)     B. यूज़नेट (USENET)     C. ई-मेल (e-mail)     D. वीओआईपी (VoIP)

Q.47 स्लाइड शो (Slide Show) मेनू का निम्नलिखित में से कौन-सा विकल्प ऐसे करेंट स्लाइड, नेक्स्ट स्लाइड और स्पीकर नोट्स को दिखाता है,
जिससे हमें एमएस-पॉवरपॉइंट 365 में प्रेजेंटेशन के  समय फोकस करने और दर्शकों  के  साथ जुड़ने में सहायता मिलती है?

Ans A. यूज टाइमिंग्स (Use Timings)     B. यूज प्रेजेंटर व्यू (Use Presenter View)     C. प्ले नरेशन्स (Play Narrations)     D. शो मीडिया कन्ट्रो ल्स
(Show Media Controls)
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Answers

Q1: B Q2: C Q3: C Q4: B Q5: C Q6: D Q7: A Q8: B Q9: D Q10: B

Q11: A Q12: A Q13: A Q14: C Q15: A Q16: C Q17: B Q18: C Q19: C Q20: D

Q21: B Q22: B Q23: C Q24: B Q25: B Q26: D Q27: D Q28: C Q29: C Q30: A

Q31: C Q32: B Q33: A Q34: A Q35: D Q36: A Q37: C Q38: C Q39: A Q40: C

Q41: A Q42: A Q43: C Q44: B Q45: D Q46: D Q47: B Q48: C Q49: C Q50: C

Q.48 किसी भी समय ई-मेल (e-mail) संदेश लिखते समय वर्तनी जाँच सुविधा को चालू करने के  लिए जीमेल (Gmail) में निम्नलिखित में से कौन-सा
सही विकल्प है?

Ans A. सेटिंग्‍स > सी ऑल सेटिंग्‍स > लेबल्‍स > लैंग्‍वेज
(Settings > See all settings > Labels > Language)     B. सेटिंग्‍स > सी ऑल सेटिंग्‍स > जेनरल > लैंग्‍वेज
(Settings > See all settings > General > Language)     C. सेटिंग्‍स > सी ऑल सेटिंग्‍स > जेनरल > स्‍पेलिंग
(Settings > See all settings > General > Spelling)     D. सेटिंग्‍स > सी ऑल सेटिंग्‍स > लेबल्‍स > स्‍पेलिंग
(Settings > See all settings > Labels > Spelling)

Q.49 MS-Word 365 में किसी भी समय हेल्प व्यूअर विंडो (Help Viewer window) खोलने के  लिए निम्नलिखित में से किन फं क्शन-कुं जियों
(function keys) का उपयोग किया जाता है?

Ans A. F4     B. F5     C. F1     D. F10

Q.50 निम्नलिखित में से कौन-सी लेयर, फाइव-लेयर्ड इंटरनेट आर्कि टेक्चर (five layered internet architecture) में उपलब्ध नहीं  होता है?

Ans A. एप्लिके शन (Application)     B. ट्रा न्सपोर्ट (Transport)     C. सेशन (Session)     D. डेटा लिंक (Data Link)
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 आईईसीटी (IECT) का पूण� �प �ा है?

Ans A. Information Electronics and Conversation Technology (इ�ॉम�शन इले�� ॉिन� एंड क�ज़�शन टे�ोलॉजी)     B. Information
Electronics and Communication Technology (इ�ॉम�शन इले�� ॉिन� एंड क� युिनकेशन टे�ोलॉजी)     C. Information Electric and Correspondence
Transmission (इ�ॉम�शन एले��� क एंड कॉरे�ॉ��स ट� ांसिमशन)     D. Information Electronics and Communication Transmission (इ�ॉम�शन
इले�� ॉिन� एंड क� युिनकेशन ट� ांसिमशन)

Q.2 िन� म� से कौन सा वोलेटाइल मेमोरी का उदाहरण है?

Ans A. रैम (RAM)     B. हाड� ड� ाइव (Hard drive)     C. �ैश मेमोरी (Flash memory)     D. रोम (ROM)

Q.3 िन�िल�खत म� से कौन सा कीबोड� शॉट�कट, सभी �मुख वेब �ाउज़र म� बुकमाक�  ि�एशन मेनू को तुरंत ए�ेस करने के िलए उपयोग िकया जाता
है?

Ans A. Shift + D     B. Ctrl + D     C. Esc + D     D. Alt + D

Q.4 एमएस-ए�ेल 365 (MS-Excel 365) म� िन� म� से कौन सा िवक� केवल कुछ शत� को पूरा करने वाली पं��यो ंको िड��े करने के िलए
संदिभ�त है?

Ans A. सॉिट�ग (Sorting)     B. िफ��रंग (Filtering)     C. मिज�ग (Merging)     D. िपवोिटंग (Pivoting)

Q.5 वाइड ए�रया नेटवक�  (WAN) के संदभ� म� िन�िल�खत म� से कौन सा कथन स� है?

Ans A. WAN की फ़ॉ� टॉलर�स ब�त अिधक होती है।     B. WAN का केवल एक �कार होता है िजसे ���ड वैन (switched WAN) के नाम से जाना
जाता है।     C. लंबी दूरी के ट� ांसिमशन के कारण, WAN म� नॉइज़ (रव) और एरर (�ुिट) अिधक होता है।     D. WAN की डेटा रेट LAN की गित से अिधक होती है।

Q.6 एमएस-ए�ेल 365 (MS-Excel 365) म� कॉलम इ�ट� करने का सही �म िन� म� से कौन सा है?

Ans A. िडज़ाइन > इ�ट� > इ�ट� शीट कॉल� (Design > Insert > Insert Sheet Columns)     B. होम > इ�ट� > इ�ट� शीट कॉल�
(Home > Insert > Insert Sheet Columns)     C. इ�ट� > इ�ट� शीट कॉल� (Insert > Insert Sheet Columns)     D. ड� ॉ > इ�ट� > इ�ट� शीट कॉल�
(Draw > Insert > Insert Sheet Columns)

Q.7 िन�िल�खत म� से कौन सा �ू, एमएस-पॉवर पॉइंट (MS-PowerPoint) पर एक िसंपल �ेप के साथ, सभी को एक ही �ान पर, ��ेक �ाइड
को एक साथ लगातार फॉम�ट करने की सुिवधा देता है?

Ans A. आउटलाइन (Outline)     B. �ाइड सॉट�र (Slide Sorter)     C. नोट्स पेज (Notes Page)     D. �ाइड मा�र (Slide Master)

Q.8 एमएस-पॉवर पॉइंट (MS-PowerPoint) �ेज���टेशन को फ�� �ाइड के बजाय करंट �ाइड से �ाट� करने के िलए शॉट�कट कंुजी �ा है?
Ans A. Ctrl + F4     B. Shift + F5     C. Ctrl + F5     D. Shift + F4

Q.9 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) म� फॉ� डायलॉग बॉ� को खोलने के िलए िकस कीबोड� शॉट�कट का उपयोग िकया जाता है?
Ans A. Ctrl + F     B. Ctrl + N     C. Ctrl + T     D. Ctrl + M

Q.10 िन�िल�खत म� से कौन सा िवक� प एमएस-वड� 365 (MS-Word 365) म� 'ऑनलाइन टे�' श� पर टॉगल केस ऑ�शन लागू करने का प�रणाम
है?

Ans A. oNLINE tEST     B. ONLINE TEST     C. Online test     D. Online tesT

Q.11 िन�िल�खत म� से कौन सा िवक� प एमएस-वड� 365 ( MS-Word 365) म� रेगुलर, बो� और इटैिलक श�ो ंका सबसे अ�ा वण�न करता है?

Ans A. इफे� ट्स (Effects)     B. साइज़ (Size)     C. कलर (Color)     D. फॉ� साइज़ (Font Size)

Q.12 ई-मेल एड� ेस के संदभ� म� िन� म� से कौन सा कथन स� है?

Ans A. # िच�, डोमेन और उस ��� के बीच संबंधक होता है िजसका ई-मेल एड� ेस होता है।     B. डोमेन नाम वॉिण��क या ���गत नही ंहो सकते ह�।
    C. �वसाय या ���गत उपयोग के िलए लोकि�य ई-मेल �दाताओ ंम� जीमेल, या� शािमल ह�।     D. डोमेन नाम िकसी संगठन के िलए िविश� नही ंहोता है।

Q.13 अिधकांश ई-मेल सेवा �दाताओ ं�ारा िन�िल�खत म� से िकस �कार की फाइलो ंको अटैचम�ट के �प म� भेजने की अनुमित नही ंहोती है?

Ans A. .पीडीएफ (.pdf)     B. .ईए�ई (.exe)     C. .जेपीजी (jpg)     D. .डॉक (.doc)
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Q.14 एमएस-पॉवर पॉइंट 365 (MS-PowerPoint 365) में फु टर को टाइटल स्लाइड पर प्रदर्शित होने से रोकने के  लिए निम्नलिखित में से किस विकल्प
का उपयोग किया जाता है?

Ans A. शो स्लाइड्स (Show slides)     B. डोन्ट शो ऑन टाइटल स्लाइड (Don't show on title slide)     C. शो ऑप्शन्स (Show options)     D. डोन्ट
शो ऑन फर्स्ट स्लाइड (Don’t show on first slide)

Q.15 ओपनएसयूएसई (openSUSE), फे डोरा, डेबियन आदि, निम्नलिखित में से किस जीयूआई (GUI) आधारित ऑपरे टिंग सिस्टम का वर्ज़न हैं?

Ans A. एप्पल आईओएस (Apple iOS)     B. मैक ओएस एक्स (MacOS X)     C. लिनक्स (Linux)     D. विंडोज़ (Windows)

Q.16 निम्न में से कौन सा एप्लीके शन सॉफ्टवेयर का उदाहरण है ?

Ans A. बूट प्रोग्राम (Boot program)     B. बायोस (BIOS)     C. डिवाइस ड्रा इवर (Device driver)     D. ईमेल क्लाइंट्स (Email clients)

Q.17 एमएस-एक्सेल 365 (MS-Excel 365) में डेटा टैब की निम्न में से कौन-सा फीचर आपको कु छ नियम सेट करने की सुविधा देता है जो यह
निर्धारित करते हैं कि सेल में क्या दर्ज किया जा सकता है?

Ans A. डेटा फिल्टरिंग (Data filtering)     B. डेटा सॉर्टिंग (Data sorting)     C. डेटा मर्जिंग (Data merging)     D. डेटा वैलिडेशन (Data validation)

Q.18 कं प्यूटर सिस्टम में एएससीआईआई (ASCII) फॉर्मेट में रिप्रेजेंटेशन डेटा के  लिए प्रत्येक कै रेक्टर के  लिए कितने बिट की आवश्यकता होती है?
Ans A. 5     B. 10     C. 7     D. 9

Q.19 निम्न में से कौन सा एक वेब ब्राउज़र नहीं  है?

Ans A. ओपेरा (Opera)     B. नेटस्के प (Netscape)     C. सफारी (Safari)     D. यान्डेक्स (Yandex)

Q.20 विंडोज ऑपरे टिंग सिस्टम में पीसी (PC) बैच फाइल के  लिए फाइल एक्सटेंशन निम्न में से कौन सा है?
Ans A. .BMP     B. .BAT     C. .CSV     D. .DBF

Q.21 निम्नलिखित में से किस ऑपरेटर का उपयोग गूगल सर्च इंजन में सटीक वाक्यांश खोजने के  लिए किया जा सकता है?

Ans A. पीरियड (period)     B. कोटेशन्स (Quotations)     C. माइनस (Minus)     D. टाइल्ड (Tilde)

Q.22 एमएस-पॉवर पॉइंट 365 (MS-PowerPoint 365) में प्रेजेंटेशन के  लिए आवश्यक स्लाइड्स का चयन करने के  लिए, सेट अप स्लाइड शो के  निम्न
में से कौन से विकल्प का उपयोग किया जाता है?

Ans A. शो स्लाइड्स (Show slides)     B. एड्वांस स्लाइड्स (Advance slides)     C. शो टाइप (Show type)     D. शो ऑप्शन्स (Show options)

Q.23 निम्नलिखित में से कौन सा मूवेबल, छु पाने योग्य आइकन बार है जो ग्राफिकल यूज़र इंटरफे स (GUI) डेस्कटॉप के  बिल्कु ल किनारे  पर सेट है और
एप्के लीके शन्स के  लिए लॉन्चिंग पैड के  रूप में काम करता है?

Ans A. आइकन (Icon)     B. एप्लीके शन (Application)     C. स्टार्ट मेनू (Start menu)     D. टास्क बार (Task bar)

Q.24 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) प्रेजेंटेशन का निम्नलिखित में से कौन सा व्यू लेआउट, हेडर और फु टर और बैकग्राउंड सहित
प्रेजेंटेशन हैंडआउट्स की दिखावट को एडिट करने के  लिए उपयोग किया जाता है?

Ans A. हैंडआउट मास्टर (Handout Master)     B. स्लाइड सॉर्टर (Slide Sorter)     C. नोट्स मास्टर (Notes Master)     D. स्लाइड मास्टर (Slide
Master)

Q.25 निम्न में से कौन सा ई-मेल में मेलबॉक्स का एक वह क्षेत्र है जहां वे संदेश, जो भेजने की प्रक्रिया में होते हैं या जो भेजने में विफल हो जाते हैं,
सामान्य रूप से स्टोर किए जाते हैं?

Ans A. आउटबॉक्स (Outbox)     B. सेंट मेल (Sent Mail)     C. इनबॉक्स (Inbox)     D. स्पैम (Spam)

Q.26 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) में एक पेज में चार स्लाइड्स को प्रिंट करने के  लिए प्रिंट लेआउट सेटिंग्स से निम्नलिखित में से
कौन सा विकल्प इस्तेमाल किया जा सकता है?

Ans A. आउटलाइन (Outline)     B. हैंडआउट्स (Handouts)     C. फु ल पेज स्लाइड्स (Full Page Slides)     D. नोट्स पेजेस (Notes Pages)

Q.27 प्रारं भिक कं प्यूटिंग डिवाइस में से एक, एनालिटिकल इंजन का निर्माण किसने किया था?

Ans A. हरमन होलेरिथ (Herman Hollerith)     B. जॉन नेपियर (John Napier)     C. चार्ल्स बैबेज (Charles Babbage)     D. ब्लेज़ पास्कल (Blaise
Pascal)
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Q.28 एमएस-वर्ड (MS-Word 365) में किसी डॉक्यूमेंट या कं टेनर के  किनारे  तक पहुँचने पर शब्द को तोड़ने के  लिए निम्नलिखित में से कौन सी एक
छोटी, डैश लाइन के  उपयोग को संदर्भित करता है?

Ans A. मर्ज एं ड सेंटर (Merge and Centre)     B. स्ट्रा इक थ्रू (Strikethrough)     C. रैप टेक्स्ट (Wrap text)     D. हाईफनेशन (Hyphenation)

Q.29 निम्नलिखित में से कौन सा कम्‍युनिके शन प्रोटोकॉल, इंटरनेट पर नेटवर्क  डिवाइसेज़ को आपस में जोड़ने के  लिए उपयोग किया जाता है?

Ans A. टीसीपी/आईपी (TCP/IP)     B. एचटीटीपी (HTTP)     C. डब्ल्यू डब्ल्यू डब्ल्यू (WWW)     D. एफटीपी (FTP)

Q.30 एमएस-एक्सेल 2019 (MS-Excel 2019) में एक्टिव सेल (active cell) की सामग्री को प्रदर्शित करने के  लिए निम्नलिखित में से किस विकल्प का
उपयोग किया जाता है?

Ans A. टाइटल बार (Title bar)     B. रूलर (Ruler)     C. स्क्रॉल बार (Scroll bar)     D. फॉर्मूला बार (Formula bar)

Q.31 कं प्यूटर सिस्टम की विजुअल डिस्प्ले यूनिट (VDU) के  संदर्भ में निम्नलिखित में से कौन सा कथन गलत है?

Ans A. वीडीयू (VDU) छोटे बिंदुओं को व्यवस्थित करके , एक आयताकार पैटर्न में इमेज बनाता है, जिन्हें पिक्सेल के  रूप में जाना जाता है     B. पिक्सेल का
आकार वीडीयू (VDU) पर डिस्प्ले हो रही इमेज की स्पष्टता को निर्धारित करता है।     C. वीडीयू (VDU) में कै थोड-रे  ट्यूब और फ्लैट-पैनल डिस्प्ले में भिन्नताएं  हैं     D.
वीडीयू (VDU) एक कं प्यूटर का प्राइमरी आउटपुट डिवाइस है।

Q.32 निम्नलिखित में से कौन सा सर्च इंजन माइक्रोसॉफ्ट द्वारा लॉन्च किया गया है?

Ans A. बायडु  (Baidu)     B. गूगल (Google)     C. बिंग (Bing)     D. यान्डेक्स (Yandex)

Q.33 निम्न में से कौन सा विंडोज़ ऑपरे टिंग सिस्टम का नवीनतम संस्करण है?

Ans A. विंडोज़ विस्टा (Windows Vista)     B. विंडोज़ 8 (Windows 8)     C. विंडोज़ 10 (Windows 10)     D. विंडोज़ 11 (Windows 11)

Q.34 निम्नलिखित में से कौन-सी एमएस-वर्ड 365 (MS-Word 365) के  फीचर का उपयोग बेसलाइन से एक या अधिक कै रेक्टर्स (characters) को
ऊपर उठाने के  लिए किया जाता है?

Ans A. ड्रॉ प कै प     B. वर्ड रैप     C. सुपरस्क्रिप्ट     D. सबस्क्रिप्ट

Q.35 एमएस-वर्ड 365 (MS-Word 365) में होम टैब के  निम्न में से किस समूह में बुलेट्स एं ड नंबरिंग (Bullets and Numbering) फीचर शामिल होता
है?

Ans A. स्टाइल्स (Styles)     B. पैराग्राफ (Paragraph)     C. क्लिपबोर्ड (Clipboard)     D. एडिटर (Editor)

Q.36 इंटरनेट के  संदर्भ में, ARPANET का पूर्ण रूप क्या है?

Ans A. Advanced Research Planning Agency Network (एडवांस्ड रिसर्च प्लानिंग एजेंसी नेटवर्क )     B. Automatic Research Projects Agency
Network (ऑटोमेटिक रिसर्च प्रोजेक्ट्स एजेंसी नेटवर्क )     C. Advanced Remedial Projects Agency Network (एडवांस रेमेडियल प्रोजेक्ट्स एजेंसी नेटवर्क )    
D. Advanced Research Projects Agency Network (एडवांस्ड रसर्च प्रोजेक्ट्स एजेंसी नेटवर्क )

Q.37 निम्नलिखित में से कौन सा फील्ड संक्षेप में यह पहचान लेगा कि हम ई-मेल में किस बारे  में लिख रहे हैं?

Ans A. सब्जेक्ट (Subject)     B. टु (To)     C. फ्रॉम (From)     D. सीसी (CC)

Q.38 एमएस-वर्ड 365 (MS-Word 365) में, निम्न में से कौन-सी फं क्शन कुं जी, यदि संभव हो तो, अंतिम कमांड या कार्य को दोहराती हैं?
Ans A. F1     B. F2     C. F3     D. F4

Q.39 कं प्यूटर एक डंब मशीन है और यह यूज़र के  निर्देश के  बिना कोई काम नहीं  कर सकता'- यह कथन निम्नलिखित में से किस कं प्यूटर विशेषता को
दर्शाता है?

Ans A. परिश्रमी (Diligence)     B. कोई आईक्‍यू नहीं  (No IQ)     C. परिवर्तनशीलता (Versatility)     D. कोई अहसास नहीं  (No feeling)

Q.40 एमएस-एक्सेल 365 (MS-Excel 365) में बराबर अंतरालों , जैसे महीनों , तिमाहियों  या वित्तीय वर्षों में डेटा में ट्रें ड्स दिखाने के  लिए निम्न में से कौन
सा चार्ट उपयुक्त होता है?

Ans A. कॉलम (Column)     B. मैप (Map)     C. पाई (Pie)     D. लाइन (Line)

Q.41 यदि एमएस-एक्‍सल (MS-Excel) 365 में A1 से A8 तक के  कन्टेंट 'DATA,1,2,3,4,5,6,COUNT' हैं, तो फॉर्मूला "=COUNTA(A:A)" का
आउटपुट क्या होगा?

Ans A. 8     B. 2     C. 6     D. एरर (Error)
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Answers

Q1: B Q2: A Q3: B Q4: B Q5: C Q6: B Q7: D Q8: B Q9: C Q10: A

Q11: D Q12: C Q13: B Q14: B Q15: C Q16: D Q17: D Q18: C Q19: D Q20: B

Q21: B Q22: A Q23: D Q24: A Q25: A Q26: B Q27: C Q28: D Q29: A Q30: D

Q31: B Q32: C Q33: D Q34: C Q35: B Q36: D Q37: A Q38: D Q39: B Q40: D

Q41: A Q42: B Q43: D Q44: B Q45: C Q46: C Q47: C Q48: C Q49: C Q50: D

Q.42 एमएस-एक्सेल 365 (MS-Excel 365) में निम्नलिखित में से कौन सा लॉजिकल फं क्शन TRUE रिटर्न करता है, यदि इसके  सभी आर्ग्‍युमेंट TRUE
हैं?

Ans A. नॉट (NOT)     B. एं ड (AND)     C. फॉल्स (FALSE)     D. ऑर (OR)

Q.43 कं ट्रो ल पैनल में माउस कं पोनेंट का निम्न में से कौन सा टैब विंडोज़ 10 में माउस की पॉइंटर स्पीड को सेलेक्ट करने के  लिए इस्तेमाल किया जाना
चाहिए?

Ans A. पॉइंटर्स (Pointers)     B. हार्डवेयर (Hardware)     C. बटन्स (Buttons)     D. पॉइंटर ऑप्शन्स (Pointer options)

Q.44 एमएस-एक्सेल 365 (MS-Excel 365) में टेक्स्ट को इटैलिक करने या इटैलिक फॉर्मेटिंग को हटाने के  लिए निम्न में से किस कीबोर्ड शॉर्टकट का
उपयोग किया जाता है?

Ans A. Ctrl + 2     B. Ctrl + 3     C. Ctrl + 4     D. Ctrl + 1

Q.45 निम्नलिखित में से किसका उपयोग आईपी एड्रे स ( IP address) को एक नाम देने के  लिए किया जाता है ताकि एक यूज़र इंटरनेट के  सहयोग से
एक नाम के  द्वारा कं प्यूटर का पता लगा सके ?

Ans A. यूडीपी (UDP)     B. एचटीटीपीएस (HTTPS)     C. डीएनएस (DNS)     D. टीसीपी/आईपी (TCP/IP)

Q.46 ट्रां ज़िशन टैब का निम्न में से कौन सा विकल्प, ट्रां ज़िशन कै से होता है यह बदलने के  लिए उपयोग किया जाता है, उदाहरण के  लिए, वह दिशा
जिससे स्लाइड एमएस-पॉवर पॉइंट 365 (MS-PowerPoint 365) में एं टर करती है?

Ans A. एड्वांस स्लाइड (Advance Slide)     B. एनिमेशन (Animation)     C. इफे क्ट ऑप्शन्स (Effect Options)     D. ड्यूरेशन (Duration)

Q.47 निम्न में से कौन सी इंटरनेट द्वारा प्रदान की जाने वाली सूचना पुनर्प्राप्ति सेवा (information retrieval service) है?

Ans A. टेलनेट (telnet)     B. ई-मेल (E-mail)     C. गोफर (Gopher)     D. न्यूज़ ग्रुप (News group)

Q.48 एमएस-वर्ड 365 (MS-Word 365) में एक टेबल में टेक्स्ट अलाइन करने के  लिए अलाइनमेंट ग्रुप में कितने विकल्प उपलब्ध होते हैं?
Ans A. 7     B. 3     C. 9     D. 6

Q.49 होम शॉपिंग और विज्ञापन, कं प्यूटर एप्लीके शन की निम्नलिखित में से किस श्रेणी से संबंधित हैं?

Ans A. स्वास्थ्य देखभाल (Healthcare)     B. सैन्य (Military)     C. मार्के टिंग (Marketing)     D. शिक्षा (Education)

Q.50 डॉक्यूमेंट के  लेआउट के  संदर्भ में 'वाइड', 'मिरर्ड ', 'नैरो' शब्द एमएस-वर्ड 365 (MS-Word 365) में निम्न में से किस विकल्प का वर्णन करता है?

Ans A. ऑरिएं टेशन (Orientation)     B. साइज़ (Size)     C. ब्रेक्स (Breaks)     D. मार्जिन्स (Margins)
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 ई-मेल िलखने के संदभ� म� िन�िल�खत म� से कौन सा कथन अस� य है?

Ans A. ‘To’ और ‘Cc’ फ़ी� अ�र एक दूसरे के �ान पर उपयोग िकए जाते ह�।     B. हम 'Cc' फी� को खाली छोड़ सकते ह�।     C. हम 'To' फ़ी� म�
एक से अिधक पते (एड� ैस) नही ंजोड़ सकते ह�।     D. हम ' Bcc' फ़ी� को खाली छोड़ सकते ह�।

Q.2 एमएस-पावरपॉइंट (MS-PowerPoint) 365 के इ�ट� टैब के िन�िल�खत म� से िकस िवक� म� 'इ�ैश़न (equation)' ऑ�े� होता है?

Ans A. टे� � ट (Text)     B. इल�� ेश� स (Illustrations)     C. ऐड-इ� (Add-ins)     D. िस ंब� स (Symbols)

Q.3 एमएस-ए� सेल (MS-Excel) 365 म� िन�िल �ख त म� से कौन सा लॉिज कल फ़ं�न TRUE देता है यिद कोई आ� यु�म�ट TRUE है?
Ans A. LET     B. IF     C. OR     D. AND

Q.4 एमएस-वड� (MS-Word) 365 म� िन�िल�खत म� से कौन सा िवक� सेल (cell), रो (row) और कॉलम बॉड�र (column borders) बनाकर अपनी
टेबल (table) बनाने के िलए उपयोग िकया जाता है?

Ans A. �� व क टेबल (Quick table)     B. ि�एट टेबल (Create table)     C. इंसट� टेबल (Insert table)     D. ड� ा टेबल (Draw table)

Q.5 िन�िल�खत म� से कौन सा िवंडोज टा�बार का िवशेष से� शन है जो बैक�ाउंड म� चल रहे �ो�ाम और समय और ितिथ, नोिटिफकेशन, इंटरनेट
कने�न की ��ित और करंट वॉ�ूम लेवल जैसी जानकारी �दिश�त करता है?

Ans A. नोिटिफकेशन ए�र या (Notification area)     B. � टाट� मेनू (Start menu)     C. �� व क लॉ� च बार (Quick launch bar)     D. मेनू आइकन
(Menu icon)

Q.6 लगभग हर सच� इंजन व�� वाइड वेब को �व��त तरीके से �ाउज़ करने और उ�� लोकल �र पोिज टरी म� अनु�िमत करने के िलए ______
नामक �ो�ाम या �चािलत ��� का उपयोग करता है।

Ans A. �ूलर (Spooler)     B. �ॉलर (Crawler)     C. एडवेयर (Adware)     D. �ाइवेयर (Spyware)

Q.7 माउस �ॉपट�ज (Mouse properties) का िन�िल�खत म� से कौन सा िवक� दािह ने और बाएं माउस बटन के फं� शनो ंको �ैप करने के िलए
उपयोग िकया जाता है?

Ans A. पाइंट ऑ� श� स (Pointer Options)     B. डबल-��क � पीड (Double-click speed)     C. बटन कॉ�� फ �ेशन (Button configuration)     D.
�� लकलॉक (ClickLock)

Q.8 िन�िल�खत म� से कौन सा एक िवशेष-उ�े� वाला ए��केशन सॉ�वेयर है?

Ans A. िलन� (Linux)     B. िव ंडोज (Windows)     C. पेरोल िस � टम (Payroll system)     D. डाटाबेस मैनेजम�ट िस � टम (Database management
system)

Q.9 कं�ूटर मॉनीटर को VDU भी कहा जाता है।VDU पद का पूण� �प � या है?

Ans A. Video Display Unit (वीिडयो िड � � ले यूिन ट)     B. Video Dialysis Unit (वीिडयो डायिलिसस यूिनट)     C. Vertical Dialysis Unit (विट�कल
डायिलिसस यूिनट)     D. Vertical Display Unit (विट�कल िड � � ले यूिन ट)

Q.10 एमएस-पावरपॉइंट (MS-PowerPoint) 365 म� एमएस-ए� सेल (MS-Excel) वक� शीट इ�ट� करने के िलए िन�िल�खत म� से िकस िवक� का
उपयोग िकया जा सकता है?

Ans A. इ�ट�-> फॉ� स� (Insert -> Forms)     B. इ�ट�-> टेबल (Insert -> Table)     C. इ�ट�-> चाट� (Insert -> Chart)     D. इ�ट�-> ऑ� जे� ट
(Insert -> Object)

Q.11 गूगल �ोम (Google Chrome) म� कई टैब खोले जाने पर पहला टैब सि�य करने के िलए िन�िल�खत म� से कौन सा कीबोड� शॉट�कट उपयोग
िक या जाता है?

Ans A. Ctrl + 9     B. Alt + 1     C. Alt + 9     D. Ctrl + 1

Q.12 िन�िल�खत म� से कौन सी इंटरनेट �ारा �दान की जाने वाली संचार सेवा है?

Ans A. आच� (Archie)     B. ईमेल (E-mail)     C. गोफर (Gopher)     D. फाइल ट� ांसफर �ोटोकॉल (File Transfer Protocol)

Q.13 एमएस-पावरपॉइंट (MS-PowerPoint) 365 म� पहली �ाइड से �ाइड शो (slide show) शु� करने के िलए िन�िल�खत म� से िकस कीबोड�
शॉट�कट का उपयोग िकया जाता है?

Ans A. F2     B. F5     C. F9     D. F4
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Q.14 एमएस-पावरपॉइंट (MS-PowerPoint) में चयनित स्लाइड का डुप्लिके ट बनाने के  लिए कीबोर्ड शॉर्टकट का चयन कीज‍िए।
Ans A. Ctrl + D     B. Ctrl + F1     C. Ctrl + X     D. Ctrl + M

Q.15 एमएस-एक्‍सेल (MS-Excel) 365 में महत्वपूर्ण मानों  (वैल्यू) को विज़ुअल रूप से हाइलाइट करने के  लिए, बार, कलर और आइकन का उपयोग
करके  डाटा में ट्रें डों  को आसानी से पहचानने के  लिए निम्नलिखित में से किस विकल्प का उपयोग किया जाता है?

Ans A. सेल स्‍टाइल्‍स (Cell Styles)     B. पिवट टेबल (Pivot Table)     C. फॉर्मेट ऐज टेबल (Format as Table)     D. कं डीशनल फॉर्मेट‍िंग
(Conditional Formatting)

Q.16 2 मेगाबाइट्स में कितने निबल्स होते हैं?

Ans A. 222     B. 210     C. 220     D. 221

Q.17 निम्नलिखित में से कौन सा वेब मेल (web mail) प्रदाता नहीं  है?

Ans A. याहू (Yahoo)     B. गूगल (Google)     C. अपग्रेड (upGrad)     D. आउटलुक (Outlook)

Q.18 एमएस-एक्‍सेल (MS-Excel) 365 में निम्नलिखित में से किस टैब में वर्क शीट में डुप्लिके ट पंक्तियों  (rows) को हटाने (remove) का विकल्प होता
है?

Ans A. फॉर्मूलास (Formulas)     B. व्‍यू (View)     C. र‍िव्‍यू (Review)     D. डाटा (Data)

Q.19 एमएस-वर्ड (MS-Word) 365 टेबल में रो (rows) और कॉलम (columns) इंसर्ट करने के  लिए निम्नलिखित में से कौन सा एक मान्य विकल्प नहीं
है?

Ans A. इंसर्ट लेफ्ट (Insert Left)     B. इंसर्ट बिलो (Insert Below)     C. इंसर्ट राइट (Insert Right)     D. इंसर्ट बिटवीन (Insert Between)

Q.20 निम्नलिखित में से कौन सा एप्पल (Apple) द्वारा विकसित ग्राफिकल वेब ब्राउज़र है?

Ans A. सफारी (Safari)     B. एज (Edge)     C. क्रोम (Chrome)     D. फायरफॉक्‍स (Firefox)

Q.21 निम्नलिखित में से कौन सा एक यूटिलिटी सॉफ्टवेयर नहीं  है?

Ans A. एं टीवायरस     B. डिस्क डीफ्रे गमेंटर     C. नोटपैड     D. फाइल मैनेजर

Q.22 पीसी (PC) पर आउटलुक ई-मेल क्लाइंट को कॉन्फ़िगर करने का सही तरीका निम्नलिखित में से कौन सा है?

Ans A. व्‍यू -> अकाउंट सेटिंग्स (View -> Account Settings)     B. एडि‍ट -> अकाउंट सेटिंग्स (Edit -> Account Settings)     C. टू ल्‍स -> अकाउंट
सेटिंग्स (Tools -> Account Settings)     D. एक्‍शन्‍स -> अकाउंट सेटिंग्स (Actions -> Account Settings)

Q.23 एमएस-पावरपॉइंट (MS-PowerPoint) 365 में निम्नलिखित में से कौन सा विकल्प यह निर्दिष्ट करके  ट्रां ज़िशन टाइमिंग सेट करता है कि अगली
स्लाइड के  लिए ट्रां ज़िशन शुरू होने से पहले स्लाइड कितनी देर तक व्‍यू (view) में बनी रहेगी?

Ans A. ड्यूरेशन (Duration)     B. एडवांस स्‍लाइड (Advance Slide)     C. एडवांस्‍ड एन‍िमेशन (Advanced Animation)     D. इफे क्‍ट ऑप्शन्‍स
(Effect Options)

Q.24 एमएस-वर्ड (MS-Word) 365 के  निम्नलिखित में से किस टैब में सेव( Save), सेव ऐज (Save As), ओपन ए न्यू डॉक्यूमेंट (Open a New
Document) आदि जैसे विकल्प होते हैं?

Ans A. डाटा (Data)     B. फाइल (File)     C. होम (Home)     D. र‍िव्‍यू (Review)

Q.25 निम्नल‍िख‍ित में से कौन सा कीबोर्ड शॉर्टकट एमएस-पावरपॉइंट (MS-PowerPoint) 365 में ट्रां ज़िशन टैब (Transitions tab) खोलने और
स्लाइड्स के  बीच ट्रां ज़िशन जोड़ने के  लिए उपयोग किया जा सकता है?

Ans A. Alt + S     B. Alt + A     C. Alt + K     D. Alt + R

Q.26 विंडोज सिस्टम की बूटिंग प्रक्रिया के  बाद प्रदर्शित होने वाली पहली स्क्रीन निम्नलिखित में से कौन सी है?

Ans A. डेस्कटॉप (Desktop)     B. मेनू बार (Menu bar)     C. आइकन (Icon)     D. स्टेटस बार (Status bar)

Q.27 एमएस-एक्‍सेल (MS-Excel) 365 के  निम्नलिखित में से किस टैब में सेल अलाइनमेंट (cell alignment) विकल्प जैसे- टॉप अलाइन, मिडिल
एलाइन आदि शामिल हैं?

Ans A. इंसर्ट (Insert)     B. डाटा (Data)     C. होम (Home)     D. ड्रा  (Draw)

Q.28 माइक्रोसॉफ्ट एज (Microsoft Edge), ओपेरा (Opera)और एप्पल सफारी (Apple Safari) ______ के  उदाहरण हैं।

Ans A. सर्च इंजन (search engine)     B. वेब पेज (web page)     C. वेब सर्वर (web server)     D. वेब ब्राउज़र (web browser)
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Q.29 ASCII-7 एक 7-बिट कोड है, और यह विशिष्ट रूप से अधिकतम ______ कै रेक्‍टरों  को निरूप‍ित सकता है।
Ans A. 64     B. 127     C. 256     D. 128

Q.30 निम्नलिखित में से कौन सा टैब एमएस-वर्ड (MS-Word) 365 में डिफ़ॉल्ट टैब है?

Ans A. डिज़ाइन (Design)     B. होम (Home)     C. फाइल (File)     D. लेआउट (Layout)

Q.31 एमएस-एक्‍सेल (MS-Excel) 365 में पंक्तियों  (rows) को म‍िटाने (delete) का सही क्रमनिम्नल‍िख‍ित में से कौन सा है?

Ans A. ड्रा  > ड‍िलीट >ड‍िलीट शीट रोज(Draw > Delete > Delete Sheet Rows)     B. होम > ड‍िलीट > ड‍िलीट शीट रोज (Home > Delete > Delete
Sheet Rows)     C. इंसर्ट > ड‍िलीट शीट रोज (Insert > Delete Sheet Rows)     D. ड‍िजाइन > ड‍िलीट > ड‍िलीट शीट रोज (Design > Delete > Delete Sheet
Rows)

Q.32 निम्नलिखित में से कौन-सा एक तरीका नहीं  है, जिसके  द्वारा हम मेल बॉक्स तक पहुंच सकते हैं और उनका उपयोग कर सकते हैं?

Ans A. मोबाइल फोन (Mobile phone)     B. वेबमेल (Webmail)     C. ईमेल क्लाइंट्स (Email clients)     D. पेजर (Pager)

Q.33 निम्नलिखित एमएस-एक्‍सेल (MS-Excel) 365 फॉर्मूला का आउटपुट क्या होगा? =12/8*6+4-2
Ans A. 10     B. 11     C. 8     D. 12

Q.34 वर्ड प्रोसेसर विंडो में निम्नलिखित में से किसका उपयोग एप्लिके शन या विंडो-स्‍पेस‍िफ‍िक मेनू जैसे होम (Home), इंसर्ट (Insert) और डिज़ाइन
(Design) प्रस्तुत करने के  लिए किया जाता है?

Ans A. टाइटल बार (Title Bar)     B. स्टेटस बार (Status Bar)     C. मेनू बार (Menu Bar)     D. रूलर बार (Ruler Bar)

Q.35 निम्नलिखित में से कौन सा विकल्‍प डाटा के  पैके ट की राउटिंग और एड्रे  सिंग के  लिए बनाए नियमों  के  सेट को संदर्भित करता है ताकि वे पूरे
नेटवर्क  में संचारण (travel) कर सकें  और सही गंतव्य (destination) पर पहुंच सकें ?

Ans A. मॉडल (Model)     B. प्रोटोकॉल (Protocol)     C. टोपोलॉजी (Topology)     D. आर्कि टेक्चर (Architecture)

Q.36 एमएस-वर्ड (MS-Word) 365 में नया ब्लैंक डॉक्यूमेंट बनाने के  लिए निम्‍नलिखित में से क‍िस कीबोर्ड शॉर्टकट का उपयोग क‍िया जाता है?
Ans A. Alt + N     B. Esc + N     C. Ctrl + N     D. Shift + N

Q.37 प्रेजेंटेशन बनाने और डिजाइन करने के  लिए निम्नलिखित में से किस सॉफ्टवेयर का उपयोग किया जाता है?

Ans A. एमएस-एक्सेस (MS-Access)     B. एमएस-वर्ड (MS-Word)     C. एमएस-एक्सेल (MS-Excel)     D. एमएस-पावरपॉइंट (MS-PowerPoint)

Q.38 निम्नलिखित में से कौन सा कनेक्शन फोन लाइनों  का उपयोग करता है, जो एनालॉग सिग्नल के  बजाय डिजिटल सिग्नल वहन करते हैं?

Ans A. Wi-Fi     B. डायल-अप (Dial-up)     C. सैटेलाइट (Satellite)     D. DSL

Q.39 एमएस-पावरपॉइंट (MS-PowerPoint) 365 स्लाइड्स को प्रिंट करते समय निम्नलिखित में से कौन सा प्रिंट लेआउट का मान्य विकल्प नहीं  है?

Ans A. इन-लाइन (Inline)     B. फु ल पेज स्लाइड्स (Full Page Slides)     C. नोट्स पेजस (Notes Pages)     D. आउटलाइन (Outline)

Q.40 निम्नलिखित में से कौन सीपीयू द्वारा वर्तमान में निष्पादित किए जा रहे प्रोग्राम और डेटा को स्टोर करता है?

Ans A. प्राथमिक मेमोरी (Primary memory)     B. तृतीयक मेमोरी (Tertiary memory)     C. द्वितीयक मेमोरी (Secondary memory)     D. सहायक
मेमोरी (Auxiliary memory)

Q.41 एमएस-एक्‍सेल (MS-Excel) 365 में फॉमूला में कॉलम (columns) H से J तक सभी सेल को संदर्भित करने के  लिए निम्नलिखित में से किस
प्रकार के  रेफरेंस का उपयोग किया जाता है?

Ans A. HJ     B. $H$J     C. H:J     D. H-J

Q.42 निम्नलिखित में से किस ऑपरेटर का उपयोग किया जा सकता है, जब हम गूगल (Google) सर्च इंजन में किसी विशिष्ट शब्द और उस शब्द के
लिए कोई समानार्थी शब्द खोजना चाहते हैं?

Ans A. पीर‍ियड (Period)     B. उद्धरण चिन्ह (Quotations)     C. अंतर-च‍िन्‍ह (Tilde)     D. ऋण चिह्न (Minus)

Q.43 ENIAC, EDVAC, आदि ______ पीढ़ी के  कं प्यूटर के  उदाहरण हैं।

Ans A. द्वि‍तीय     B. प्रथम     C. तृतीय     D. चौथी
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Answers

Q1: C Q2: D Q3: C Q4: D Q5: A Q6: B Q7: C Q8: C Q9: A Q10: D

Q11: D Q12: B Q13: B Q14: A Q15: D Q16: A Q17: C Q18: D Q19: D Q20: A

Q21: C Q22: C Q23: B Q24: B Q25: C Q26: A Q27: C Q28: D Q29: D Q30: B

Q31: B Q32: D Q33: B Q34: C Q35: B Q36: C Q37: D Q38: D Q39: A Q40: A

Q41: C Q42: C Q43: B Q44: B Q45: B Q46: A Q47: C Q48: B Q49: B Q50: B

Q.44 एमएस-एक्‍सेल (MS-Excel) 365 में निम्नलिखित में से कौन सा चार्ट एक डाटा सीरीज में आइटम के  आकार को दर्शाने के  लिए उपयोग किया
जाता है, जो एक कॉलम (column) या पंक्ति (row) में व्यवस्थित डाटा के  आइटम के  योग के  समानुपाती होता है?

Ans A. स्‍कै टर (Scatter)     B. पाई (Pie)     C. बार (Bar)     D. लाइन (Line)

Q.45 एमएस-वर्ड (MS-Word) 365 में स्वचालित बुलेट (bullets) और नंबरिंग (numbering) को बंद करने का सही क्रम निम्नलिखित में से कौन सा
है?

1. ऑटोकरेक्‍ट ऑप्‍शन्‍स (AutoCorrect Options) का चयन कीज‍िए, और इसके  बाद ‘ऑटोफॉर्मेट ऐज यूज टाइप (AutoFormat As You
Type)’ टैब का चयन कीज‍िए।
2. फाइल पर जाएं  > ऑप्‍शन्‍स > प्रूफ‍िं ग (File > Options > Proofing)
3. Select OK का चयन कीज‍िए।
4. ऑटोमैट‍िक बुलेटेड ल‍िस्‍ट्स या ऑटोमैट‍िक नंबर्ड ल‍िस्‍ट्स (Automatic bulleted lists or Automatic numbered lists) का चयन कीज‍िए
या क्‍लीयर कीजिए।

Ans A. 1, 2, 3, 4     B. 2, 1, 4, 3     C. 2, 1, 3, 4     D. 2, 4, 1, 3

Q.46 विंडोज 11 (Windows 11) पर प्रोग्राम को अनइंस्टॉल या चेंज करने के  लिए कं ट्रो ल पैनल के  निम्नलिखित में से कौन से फीचर का चयन किया जा
सकता है?

Ans A. प्रोग्राम्‍स एं ड फीचर्स (Programs and Features)     B. डिवाइस और प्रिंटर्स (Devices and Printers)     C. डिवाइस मैनेजर (Device
Manager)     D. डिफ़ॉल्ट प्रोग्राम्‍स (Default Programs)

Q.47 'स्क्रीनशॉट' (Screenshot) विकल्प एमएस-वर्ड 2010 (MS-Word 2010) के  ___________ टैब में उपलब्ध है।

Ans A. डिजाइन (Design)     B. रिव्यू (Review)     C. इन्सर्ट (Insert)     D. होम (Home)

Q.48 निम्नलिखित में से कौन सा ISPs द्वारा प्रदान की जाने वाली सेवा नहीं  है?

Ans A. लीज्ड लाइन एक्सेस     B. डाटाबेस मैनेजमेंट     C. डायल-अप एक्‍सेस     D. इंटरनेट एक्‍सेस

Q.49 निम्नलिखित में से कौन सा विंडोज ऑपरे टिंग सिस्टम में ASCII टेक्स्ट फाइल के  लिए फाइल एक्सटेंशन है?
Ans A. .WAV     B. .TXT     C. .ZIP     D. .BAT

Q.50 विविध समस्याओं को हल करने की उपयोग क्षमता (flexibility) कं प्यूटर की ______ अभिलाक्षणिकता का न‍िरूपण करता है।

Ans A. गत‍ि (speed)     B. उपयोगि‍ता (versatility)     C. शुद्धता (accuracy)     D. कर्मठता (diligence)
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 एमएस-वड� 2007 (MS-Word 2007) म� पैरा�ाफ के टे� के अलाइनम�ट के बारे म� िन�िल�खत म� से कौन सा कथन सही है?

Ans A. टे� को दाईं ओर अलाइन करने के िलए कीबोड� शॉट�कट ‘Alt + R’ का उपयोग िकया जा सकता है।     B. टे� को क� � म� अलाइन करने के िलए
कीबोड� शॉट�कट ‘Ctrl + C’ का उपयोग िकया जा सकता है ।     C. टे� को बाईं ओर अलाइन (align) करने के िलए कीबोड� शॉट�कट ‘Ctrl + L’ का उपयोग िकया जा
सकता है।     D. टे� को बाईं ओर अलाइन करने के िलए कीबोड� शॉट�कट ‘Alt + L’ का उपयोग िकया जा सकता है।

Q.2 एमएस ए� सेल 2007 (MS-Excel 2007) म� पांचवी रो (row) के तीसरे सेल (cell) का एड� ेस िन� म� से कौन सा होना चािहए?
Ans A. 35     B. C5     C. 5C     D. 53

Q.3 िन�िल�खत म� से कौन सा �म िवंडोज 10 (Windows 10) म� 'डेट एंड टाइम (Date & time)' िवंडो खोलता है िजसका उपयोग िस�म की ितिथ
और समय बदलने के िलए िकया जाता है?

Ans A. � टाट� -> सेिट ं� स -> डेट एंड ल�� वेज -> डेट एंड टाइम (Start -> Settings -> Date & language -> Date & time)     B. � टाट� -> सेिट ं� स -> डेट-
> डेट एंड टाइम (Start -> Settings -> Date -> Date & time)     C. � टाट� -> सेिट ं� स -> डेट एंड टाइम (Start -> Settings -> Date & time)     D. � टाट� ->
सेिट ं� स -> टाइम एंड ल�� वेज -> डेट एंड टाइम (Start -> Settings -> Time & language -> Date & time)

Q.4 एमएस ए� सेल 2007 (MS-Excel 2007) म� सेल के 'नंबर (Number)' टाइप फॉम��िटंग म� दशमलव �ानो ंका िडफ़ॉ� मान (default value)
िन� म� से � या होती है?

Ans A. 1     B. 4     C. 2     D. 3

Q.5 एमएस ए� सेल 2007 (MS-Excel 2007) म� ि�ंिटंग के बारे म� िन�िल�खत म� से कौन सा कथन गलत है?

Ans A. िडफ़ॉ� �प से, एमएस ए� सेल (MS-Excel) उस पूण� डाटा को ि�ंट करता है, जो वत�मान वक� शीट पर उप��त है।     B. ि�ं िट ंग के िलए सेलो ंकी
र�ज को मै�ुअल �प से चुना जा सकता है।     C. सेलो ंकी असंल� र�ज को ि�ं ट  करना संभव है।     D. िडफ़ॉ� �प से, एमएस ए� सेल (MS-Excel) उस पूण� डाटा को
ि�ंट करता है, जो वत�मान वक� बुक की वक� शीटो ंपर मौजूद है।

Q.6 एमएस-पावरपॉइंट 2007 (MS-PowerPoint 2007) म� पावरपॉइंट �ेज���टेशन खोलने के िलए, 'ओपन िवंडो (open window)' �दिश�त करने के
िलए िन� म� से कौन सा कीबोड� शॉट�कट उपयोग िकया जाता है?

Ans A. Alt + O     B. Ctrl + O     C. Ctrl + Alt + O     D. Shift + O

Q.7 िवंडोज 10 (Windows 10) ऑपरेिटंग िस�म के टा�बार के बारे म� िन�िल�खत म� से कौन सा कथन गलत है?

Ans A. �ाट� मे�ू, टा�बार के बाईं ओर होता है।     B. इंटरनेट कने�न की ��ित टा�बार के अिधसूचना �े� (notification area) म� �दिश�त होती है।
    C. िपन िकए गए ए�� ल केशन के आइकन टा�बार के अिधसूचना �े� (notification area) म� �दिश�त होते ह�।     D. टा�बार, �ीन के बॉटम पर होता है।

Q.8 एमएस वड� 2007 (MS-Word 2007) म� पेज सेटअप (Page Setup) के बारे म� िन�िल�खत म� से कौन सा/से कथन स� है/ह�?

(i) '(सामा� यत:)' मािज�न का मान ��ेक िदशा म� 2.54 cm होता है।
(ii) A4 पेपर का आकार 21 cm × 29.7 cm होता है।

Ans A. केवल (ii)     B. न तो (i) और न ही (ii)     C. केवल (i)     D. (i) और (ii) दोनों

Q.9 िवंडोज 10 (Windows 10) म� माउस �ॉपट�ज को बदलने के बारे म� िन�िल�खत म� से कौन सा/से कथन स� य है/ह�?

(i) माउस के बाएं बटन के फं� शन को बदला नही ंजा सकता।
(ii) माउस पॉइंटर का आकार बदला जा सकता है।

Ans A. (i) और (ii) दोनो ं    B. केवल (i)     C. केवल (ii)     D. न तो (i) और न ही (ii)

Q.10 िवंडोज (Windows) ऑपरेिटंग िस�म के बारे म� िन�िल�खत म� से कौन सा कथन गलत है?

Ans A. िवंडोज एनटी (Windows NT) सि�य म�ीटा��ंग (preemptive multitasking) को सपोट� करता है।     B. िवंडोज 10 (Windows 10) को
2015 म� जारी िकया गया था।     C. िवंडोज एनटी (Windows NT) को ऑरेकल (Oracle) �ारा िवकिसत िकया और माइ�ोसॉ� (Microsoft) �ारा िवपिणत
(marketed) िकया गया था।     D. िवंडोज 1.0 (Windows 1.0) ऑपरेिटंग िस�म MS-DOS का एक ए�ट�शन था।

Q.11 ईमेल के बारे म� िन�िल�खत म� से कौन सा/से कथन स� है/ह�?

(i) इसका उपयोग इंटरनेट के मा� यम से इले�� ॉिनक संदेश भेजने के िलए िकया जाता है।
(ii) ईमेल एड� ेस का �ा�प (format) 'domainname@username' होता है।

Ans A. न तो (i) और न ही (ii)     B. (i) और (ii) दोनो ं    C. केवल (i)     D. केवल (ii)
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Q.12 कं प्यूटर नेटवर्क  में, WAN का पूर्ण रूप क्‍या है?

Ans A. Wide Area Network (वाइड एरिया नेटवर्क )     B. Windows Actual Network (विंडोज एक्‍चुअल नेटवर्क )     C. Wide Actual Network
(वाइड एक्‍चुअल नेटवर्क )     D. Windows Area Network (विंडोज एरिया नेटवर्क )

Q.13 निम्नलिखित में से कौन-सा एमएस एक्‍सेल (MS-Excel) फं क्शन क‍िसी संख्या का क्रमगुणित (factorial) परिणाम देगा?
Ans A. FACTR()     B. FAC()     C. FACT()     D. FACTORIAL()

Q.14 ईमेल का उत्तर देने के  संबंध में निम्नलिखित में से कौन सा कथन सही है?

Ans A. CC लाइनों पर सभी प्राप्तकर्ताओं (recipients) को उत्तर देने के  लिए 'रिप्‍लाई ऑल (Reply All)' विकल्प का उपयोग किया जाता है। इसका उपयोग
मूल प्रेषक को उत्तर देने के  लिए नहीं  किया जाता है।     B. BCC लाइनों पर सभी प्राप्तकर्ताओं (recipients) को उत्तर देने के  लिए 'र‍िप्‍लाई BCC (Reply BCC)'
विकल्प का उपयोग किया जाता है। इसका उपयोग मूल प्रेषक (sender) को उत्तर देने के  लिए नहीं  किया जाता है।     C. के वल मूल प्रेषक को उत्तर देने के  लिए 'र‍िप्‍लाई
(Reply)' विकल्प का उपयोग किया जाता है।     D. फॉरवर्ड (Forward)' विकल्प का उपयोग के वल मूल ‘प्रेषक (sender)’ को उत्तर देने के  लिए किया जाता है।

Q.15 किस मेमोरी को कं प्यूटर के  CPU द्वारा सीधे एक्सेस नहीं  किया जा सकता है?

Ans A. रोम (ROM)     B. मेमोरी कार्ड (Memory card)     C. रैम (RAM)     D. कै श मैमोरी (Cache memory)

Q.16 निम्नलिखित में से किस वैज्ञानिक ने स्टोर्ड प्रोग्राम कं प्यूटर (stored program computer) की अवधारणा पेश की?

Ans A. चार्ल्स बैबेज (Charles Babbage)     B. ब्लेज़ पास्कल (Blaise Pascal)     C. जॉन वॉन न्यूमैन (John Von Neumann)     D. एलन ट्यूरिंग
(Alan Turing)

Q.17 स्माइली (smiley) के  उपयोग द्वारा इंस्‍टेंट मैसेज (instant message) के  बारे  में निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) इंस्टेंट मैसेजिंग (instant messaging) में, स्माइली टेक्स्ट मैसेज के  साथ भेजी जा सकती है।
(ii) स्माइली, भावना का चित्रमय न‍िरूपण है।

Ans A. न तो (i) और न ही (ii)     B. के वल (ii)     C. (i) और (ii) दोनों     D. के वल (i)

Q.18 मान लें क‍ि A1 सेल में '14-09-2022' तिथि स्‍टोर की गई है, जो ‘बुधवार (Wednesday)’ है। B1 सेल का निम्नलिखित में से कौन सा फॉर्मूला
'Wed' प्रदर्शित करेगा?

Ans A. =TEXT(A1,"dddd")     B. =DAY(A1,"ddd")     C. =TEXT(A1,"ddd")     D. =Day(A1,"dddd")

Q.19 निम्नलिखित में से कौन सा एमएस एक्‍सेल (MS-Excel) फॉर्मूला वर्क शीट में A1 से A20 की रेंज में एक स्ट्रिंग के  सेलों  की संख्या की गणना करता
है?

Ans A. Count(A1:A20, “*”)     B. Count(A1:A20, *)     C. CountIF(A1:A20, “*”)     D. CountIF(A1:A20, *)

Q.20 एमएस पावरपॉइंट 2007 (MS-PowerPoint 2007 ) में हैडर और फु टर के  संबंध में निम्नलिखित में से कौन-सा/से कथन सत्य है/हैं?

(i) डिफ़ॉल्ट रूप से, स्लाइड संख्‍या, स्लाइड के  ऊपरी दाएं  कोने पर प्रदर्शित होती है।
(ii) हैडर और फु टर का उपयोग करके  इंसर्ट क‍िए 'दिनांक और समय (date and time)' को स्वचालित रूप से नहीं  बदला जा सकता है।

Ans A. (i) और (ii) दोनों     B. के वल (ii)     C. के वल (i)     D. न तो (i) और न ही (ii)

Q.21 एमएस-पावरपॉइंट 2007 (MS-PowerPoint 2007) में ब्लैंक प्रेजेंटेशन बनाने के  लिए निम्न में से किस कीबोर्ड शॉर्टकट का उपयोग किया जाता
है?

Ans A. Alt + M     B. Ctrl + Alt + N     C. Ctrl + M     D. Ctrl + N

Q.22 इनबॉक्स (inbox) सभी ______ के  लिए डिफ़ॉल्ट लोके शन होता है।

Ans A. ड‍िलीटेड मेल (deleted mail)     B. इनकमिंग मेल (incoming mail)     C. फॉरवर्डेड मेल (forwarded mail)     D. सेंट मेल (sent mail)

Q.23 एमएस पावरपाइंट 2007 (MS-PowerPoint 2007) में प्रेजेंटेशन देखने के  बारे  में निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) डिफ़ॉल्ट रूप से, स्लाइड, 'नॉर्मल (Normal)' व्‍यू में खोली जाती हैं।
(ii) स्लाइड शो कमांड को 'F7' कुं जी दबाकर निष्पादित किया जा सकता है।

Ans A. (i) और (ii) दोनों     B. के वल (i)     C. न तो (i) और न ही (ii)     D. के वल (ii)

Q.24 एक नया ब्लैंक डॉक्यूमेंट (blank document) खोलने के  लिए कीबोर्ड शॉर्टकट, निम्न में से कौन-सा है?
Ans A. Ctrl + N     B. Alt + N     C. Ctrl + Alt + N     D. Shift + N
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Q.25 एमएस-वर्ड (MS-Word) में निम्नलिखित में से कौन सा टेक्स्ट सबस्क्रिप्ट का उदाहरण है?

Ans A. H2O     B. X = 12     C. X2 + Y2     D. X = 10 + Y

Q.26 डिफ़ॉल्ट रूप से, निम्न में से कौन सी कमांड एमएस पावरपॉइंट 2007 (MS-PowerPoint 2007) के  क्विक एक्सेस टू लबार (quick access
toolbar) में उपस्थित नहीं  होती है?

Ans A. रीडू  (Redo)     B. अनडू  (Undo)     C. कॉपी स्लाइड (Copy Slide)     D. सेव (Save)

Q.27 एमएस वर्ड 2007 (MS-Word 2007) में निम्नलिखित में से कौन सी कमांड 'पेज सेटअप (Page Setup)' मेनू से संबंधित नहीं  है?

Ans A. पेज कलर (Page Color)     B. ओर‍िएं टेशन (Orientations)     C. मार्जिन (Margins)     D. पेपर साइज (Paper Size)

Q.28 मान लें कि सेल B10 में
“=IF(A10>85,"A",IF(A10<65,"B",IF(A10>75,"C","D")))” फॉर्मूला है, जहां सेल A10, "75" स्टोर करती है। सेल B10 में निम्न में से कौन सा
आउटपुट होना चाहिए?

Ans A. B     B. D     C. A     D. C

Q.29 एमएस वर्ड 2007 (MS-Word 2007) के  निम्नलिखित में से किस मुख्‍य मेनू आइटम में 'वाटरमार्क  (Watermark)' कमांड शामिल होता है?

Ans A. रेफरेंसेस (References)     B. पेज लेआउट (Page Layout)     C. होम (Home)     D. इंसर्ट (Insert)

Q.30 वर्ल्ड वाइड वेब (WWW) के  बारे  में निम्नलिखित में से कौन सा कथन गलत है?

Ans A. यह वेबसाइटों या वेब पेजों का एक संग्रह होता है जो वेब सर्वर पर स्‍टोर/संग्रहीत होता है।     B. WWW में, वेब पेज को HTTP प्रोटोकॉल का उपयोग
करके  एक्‍सेस किया जाता है।     C. यह इंट्रा नेट (intranet) होता है, जो किसी संगठन में प्राइवेट नेटवर्क  के  रूप में स्थापित किया जाता है।     D. इसका आविष्कार टिम
बर्नर्स-ली (Tim Berners-Lee) ने किया था।

Q.31 एमएस पावरपाइंट 2007 (MS-PowerPoint 2007) में स्लाइड में साउंड/मूवी को इंसर्ट करने के  लिए निम्नलिखित में से किस मुख्‍य मेन्यू का
उपयोग किया जा सकता है ?

Ans A. इंसर्ट (Insert)     B. डिज़ाइन (Design)     C. एनीमेशन (Animation)     D. व्‍यू (View)

Q.32 कं प्यूटर की इनपुट डिवाइस से संबंधित निम्नलिखित में से कौन सा कथन गलत है?

Ans A. कीबोर्ड के  माध्यम से प्रविष्ट डाटा सीधे मेमोरी डाटा रजिस्टर (MDR) में स्थानांतरित कर दिया जाता है।     B. माउस एक इनपुट डिवाइस है।     C.
इनका उपयोग कं प्यूटर को डाटा भेजने के  लिए किया जाता है।     D. ये इनपुट डाटा को डिजिटल रूप में रूपांतर‍ित करती हैं।

Q.33 कं प्यूटर की प्राथमिक मेमोरी से संबंधित निम्नलिखित में से कौन सा कथन गलत है?

Ans A. RAM, अर्थमेटिक लॉजिक यूनिट (ALU) का एक घटक होती है।     B. रैंडम एक्सेस मेमोरी (RAM) एक ह्रासी प्राथमिक मेमोरी होती है।     C.
ROM, एक अनह्रासी प्राथमिक मेमोरी होती है।     D. CPU सीधे प्राथमिक मेमोरी के  साथ इंटरैक्ट करता है।

Q.34 सिस्टम सॉफ्टवेयर से संबंधित निम्नलिखित में से कौन सा कथन गलत है?

Ans A. यह सीधे कं प्यूटर के  हार्डवेयर से इंटरैक्ट करता है।     B. यह कं प्यूटर के  संचालन के  लिए बुनियादी प्रकार्यात्मकता प्रदान करता है।     C. यह सीधे
एं ड यूजर, या किसी अन्य सॉफ़्टवेयर को सेवाएं  प्रदान करता है।     D. प्रिंटर, एक ड्रा इवर सिस्टम सॉफ्टवेयर नहीं  है।

Q.35 Which of the following statements related to sending a new email is INCORRECT?
Ans A. CC stands for ‘carbon copy’ that is used to send the same message to more than one person and all of them see the list of

recipients of this message.     B. The subject of the message is entered in the ‘Subject’ field.     C. BCC stands for ‘blind carbon copy’ that is
used to send the same message to more than one person and none of them can see the list of recipients of this message.     D. The sender’s
email address is automatically stored in the ‘To’ field.

Q.36 इंटरनेट से संबंधित निम्नलिखित में से कौन सा कथन गलत है?

Ans A. यह TCP/IP प्रोटोकॉल का उपयोग करता है।     B. यह एक वैश्विक नेटवर्क  है जो दुनिया भर के  अरबों कं प्यूटरों को जोड़ता है।     C. यह वर्ल्ड
वाइड वेब से अलग होता है।     D. यह वेब पेजों का एक संग्रह है ज‍िस पर ब्राउज़र के  माध्यम से पहुंचा जाता है।

Q.37 एमएस वर्ड 2007 (MS-Word 2007) में वर्तमान में खुले हुए वर्ड डॉक्‍यूमेंट के  कं टेंट को सेव करने के  लिए कीबोर्ड शॉर्टकट निम्न में से कौन-सा है?
Ans A. Ctrl + S     B. Ctrl + Alt + S     C. Alt + S     D. Shift + S

KD Jo
b 

Upd
at

es



Q.38 निम्नलिखित में से कौन-सा CPU का एक इंटीग्रेटेड कं पोनेंट है और सामान्‍यत: प्रोग्राम निष्पादन के  दौरान डाटा और एड्रे स को स्टोर करने के  लिए
उपयोग किया जाता है?

Ans A. रज‍िस्‍टर (Register)     B. सेकें डरी मेमोरी (Secondary memory)     C. अर्थमेटिक लॉजिक यूनिट (Arithmetic logic unit)     D. कं ट्रो ल यून‍िट
(Control Unit)

Q.39 मैकिन्टौश मशीन (Macintosh machine) के  विषय में निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) यह एप्‍पल का एक उत्पाद है।
(ii) इसे 1972 में विकसित किया गया था

Ans A. न तो (i) न ही (ii)     B. के वल (ii)     C. के वल (i)     D. (i) और (ii) दोनों

Q.40 लिनक्स (Linux) ऑपरे टिंग सिस्टम के  बारे  में निम्नलिखित में से कौन सा कथन गलत है?

Ans A. यह सिंगल यूजर ऑपरे टिंग सिस्टम होता है।     B. यह ओपन सोर्स ऑपरे टिंग सिस्टम होता है।     C. यह मल्टी टास्किं ग ऑपरे टिंग सिस्टम होता है।
    D. इसे ल‍िनस टॉर्वाल्ड्स (Linus Torvalds) द्वारा विकसित किया गया था।

Q.41 निम्नलिखित में से कौन सा सर्च इंजन के  बारे  में एक गलत कथन है?

Ans A. गूगल सर्च इंजन (Google search engine) को मूल रूप से बैकरब (BackRub) के  नाम से जाना जाता था ।     B. बिंग (Bing) को 2009 में
माइक्रोसॉफ्ट (Microsoft) द्वारा लॉन्च किया गया था।     C. आस्क (Ask) को 1996 में लॉन्च किया गया था।     D. अल्‍टाव‍िस्‍टा (AltaVista) को एप्‍पल (Apple) द्वारा
लॉन्च किया गया था।

Q.42 वर्तमान स्लाइड से स्लाइड शो शुरू करने के  लिए निम्न में से किस कीबोर्ड शॉर्टकट का उपयोग किया जाता है?
Ans A. Ctrl + F5     B. Shift + F5     C. Alt + F5     D. F5

Q.43 LAN के  बारे  में निम्नलिखित में से कौन सा कथन सही है?

Ans A. दो अलग-अलग महाद्वीपों में रखे गए दो कं प्यूटर LAN के  माध्यम से जुड़ सकते हैं।     B. इंटरनेट कनेक्शन की तुलना में LAN कनेक्शन कम
सुरक्षित होता है।     C. 10 Mbps स्पीड वाले LAN को 'ईथरनेट (ethernet)' कहा जाता है।     D. LAN का पूर्ण रूप Local Actual Network (लोकल एक्‍चुअल
नेटवर्क ) है।

Q.44 निम्नलिखित में से कौन सा वेब ब्राउज़र एप्‍पल (Apple) द्वारा विकसित किया गया था?

Ans A. ओपेरा (Opera)     B. सफारी (Safari)     C. इंटरनेट एक्स्प्लोरर (Internet Explorer)     D. मोज‍िला फायरफॉक्‍स (Mozilla Firefox)

Q.45 एमएस एक्‍सेल 2007 (MS-Excel 2007) में सेल रेफरेंस (cell reference) के  संबंध में निम्नलिखित में से कौन सा कथन गलत है?

Ans A. C$5,र‍िलेट‍िव सेल रेफरेंस का एक उदाहरण है।     B. $C$5, ऑब्सोल्‍यूट सेल रेफरेंस का एक उदाहरण है।     C. सेल रेफरेंस, सेल के  स्थिति की
पहचान करता है जिसका उपयोग फार्मूला, फं क्‍शन या अन्य एक्सेल कमांड में किया जा सकता है।     D. C$5 और $C5 म‍िक्‍सड सेल रेफरेंस के  उदाहरण हैं।

Q.46 वेब ब्राउज़र के  बारे  में निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) वे एप्लिके शन सॉफ्टवेयर होते हैं जिनका उपयोग वर्ल्ड वाइड वेब पर उपलब्ध जानकारी को खोजने, पुन: प्राप्‍त करने और प्रदर्शित करने के
लिए किया जाता है।
(ii) वे HTTP का उपयोग करके  पूरे  इंटरनेट पर वेब सर्वरों  को र‍िक्‍वेस्‍ट भेजते हैं।

Ans A. (i) और (ii) दोनों     B. के वल (i)     C. के वल (ii)     D. न तो (i) और न ही (ii)

Q.47 निम्न में से कौन सा सर्च इंजन का एक घटक नहीं  है?

Ans A. वेब क्रॉलर     B. डाटाबेस     C. सर्च इंटरफे स     D. वेब सर्वर

Q.48 एमएस-पावरपॉइंट 2007 (MS-PowerPoint 2007) में एक ब्‍लैंक स्लाइड को इंसर्ट करने के  लिए निम्न में से किस कीबोर्ड शॉर्टकट का उपयोग
किया जाता है?

Ans A. Ctrl + Alt + M     B. Ctrl + M     C. Ctrl + N     D. Alt + M

Q.49 प्रोग्रामिंग लैंग्‍वेज के  बारे  में निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) असेंबली लैंग्‍वेज, मशीन पर न‍िर्भर नहीं  होती है।
(ii) पाइथन, लो-लेवल प्रोग्राम‍िंग लैंग्‍वेज होती है।

Ans A. न तो (i) और न ही (ii)     B. (i) और (ii) दोनों     C. के वल (i)     D. के वल (ii)
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Answers

Q1: C Q2: B Q3: D Q4: C Q5: D Q6: B Q7: C Q8: D Q9: C Q10: C

Q11: C Q12: A Q13: C Q14: C Q15: B Q16: C Q17: C Q18: C Q19: C Q20: D

Q21: D Q22: B Q23: B Q24: A Q25: A Q26: C Q27: A Q28: B Q29: B Q30: C

Q31: A Q32: A Q33: A Q34: D Q35: D Q36: D Q37: A Q38: A Q39: C Q40: A

Q41: D Q42: B Q43: C Q44: B Q45: A Q46: A Q47: D Q48: B Q49: A Q50: B

Q.50 एमएस-वर्ड 2010 (MS-Word 2010) में निम्नलिखित में से कौन-सा कीबोर्ड शॉर्टकट, फाइल टैब (File tab) पर जाने के  लिए उपयोग किया जाता
है?

Ans A. Alt + G     B. Alt + F     C. Alt + H     D. Alt + N
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 िन�िल�खत म� से कौन सा/से कथन स� है/ह�?

(i) उन �ेषको ं(senders) के ईमेल सदैव �ैम (Spam) फो� डर म� जाते ह�, जो आपकी � लैकिल � ट (blacklist) म� होते ह�।
(ii) ड� ा� फो� डर म� आपके सेव िक ए गए ईमेल होते ह�, िज�� आप बाद म� भेज (send)या संपािदत (edit) कर सकते ह�।

Ans A. केवल (ii)     B. केवल (i)     C. (i) और (ii) दोनो ं    D. न तो (i) और न ही (ii)

Q.2 िन � न म� से कौन सा एमएस पावरपॉइंट 2016 (MS-PowerPoint 2016) �ेज���टेशन म� नई �ाइड इंसट� करने का सही तरीका है?

Ans A. िकसी भी मौजूदा �ाइड के अंतग�त नेिवगेशन पेन (Navigation Pane) म� िट�  पल-��क कीिज ए     B. िकसी भी मौजूदा �ाइड के अंतग�त
नेिवगेशन पेन (Navigation Pane) म� राइट-��क कीिज ए और �ू �ाइड िवक� पर ��क कीिज ए     C. िकसी भी मौजूदा �ाइड के अंतग�त नेिवगेशन पेन
(Navigation Pane) म� ले�-��क कीिज ए और �ू �ाइड िवक� पर ��क कीिज ए     D. िकसी भी मौजूदा �ाइड के अंतग�त नेिवगेशन पेन (Navigation Pane)
म� डबल-��क कीिज ए

Q.3 िन�िल�खत म� से कौन सा एमएस वड� (MS-Word) फीचर उन श�ो ंकी पहचान करता है जो िक सी मानक श�कोश म� उपल� ध नही ंहोते ह�?

Ans A. सच� एंड �र � लेस (Search & Replace)     B. िथसॉरस (Thesaurus)     C. वड� रैप (Word wrap)     D. � पेलचैक (Spellcheck)

Q.4 यूएलएसआई (ULSI) का पूण� �प � या है?

Ans A. Unique-Light-Scale Integration (यूिनक-लाइट-�ेल इंटी�ेशन)     B. Ultra-Large-Scale Integration (अ�� ा-लाज�-�ेल इंटी�ेशन)     C.
Ultra-Light-Scale Integration (अ�� ा-लाइट-�ेल इंटी�ेशन)     D. Unique-Large-Scale Integration (यूिनक-लाज�-� केल इंटी�ेशन)

Q.5 िन�िल�खत एमएस ए� सेल (MS-Excel) फं�न का आउटपुट �ा होगा?

=CEILING(34, 10)
Ans A. 35     B. 50     C. 40     D. 30

Q.6 एमएस ए� सेल (MS-Excel) �ेडशीट म� सातवी ंरो (row) और पांचव� कॉलम (column) के �ित� छेदन पर �� थ त सेल का िनरपे� पता
(absolute address) �ा है?

Ans A. $E$7     B. $G$5     C. &G&5     D. &E&7

Q.7 िन�िल�खत म� से कौन सा/से कथन स� है/ह�?

(i) सॉ�वेयर के िबना, सामा� यत: हाड�वेयर का कोई उपयोग नही ंहै।
(ii) कंपाइलर, हाड�वेयर और सॉ�वेयर दोनो ंका एक उदाहरण है।

Ans A. (i) और (ii) दोनो ं    B. केवल (i)     C. केवल (ii)     D. न तो (i) और न ही (ii)

Q.8 िन�िल�खत म� से कौन-सा एक वैध नेटवक�  टोपोलॉजी (network topology) नही ंहै?

Ans A. �र ं ग (Ring)     B. � टार (Star)     C. मेश (Mesh)     D. डोनट (Doughnut)

Q.9 इंटरनेट पर आपके PC से दूसरे कं�ूटर, सामा� यत: एक वेब सव�र पर फाइलो ंको �ानांत�रत करने की �ि� या का वण�न करने के िलए
िन�िल�खत म� से िकस श� का उपयोग िकया जाता है?

Ans A. डाउनलोिडंग (Downloading)     B. �ूिफंग (Spoofing)     C. �ोसेिस ंग (Processing)     D. अपलोिडंग (Uploading)

Q.10 पहचान कीिज ए िक िदए गए कथन स� य ह� या अस� य।

(i) डोनट (Doughnut) चाट�, डाटा सीरीज म� आइटम के आकार को, आइटम के योग के समानुपाती िदखाते ह�।
(ii) डोनट चाट�, पाई चाट� के समान होता है, लेिकन इसम� एक से अिधक डाटा सीरीज हो सकती है।

Ans A. (i) अस�, (ii) अस�     B. (i) स�, (ii) स�     C. (i) अस�, (ii) स�     D. (i) स�, (ii) अस�

Q.11 िन�िल�खत म� से कौन सा सबसे तेज़ वेब �ाउज़र म� से एक है, और इसे िवशेष �प से ए� पल (Apple) िडवाइसो ंपर चलाने के िलए िवकिसत
िकया गया है?

Ans A. एज (Edge)     B. सफारी (Safari)     C. �ोम (Chrome)     D. मोि़ज ला फायरफॉ� स (Mozilla Firefox)

Q.12 एमएस वड� 2016 (MS-Word 2016) म� पैरा�ाफ और फॉ� से संबंिधत सेिटंग, ______ मेनू के अंतग�त िदखाई देती ह�।

Ans A. होम (Home)     B. िड जाइन (Design)     C. लेआउट (Layout)     D. � यू (View)
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Q.13 जीमेल में, यदि आप किसी ईमेल को डिलीट करते हैं तो वह ______ फोल्डर में चला जाएगा।

Ans A. इनबॉक्स (Inbox)     B. आउटबॉक्स (Outbox)     C. स्पैम (Spam)     D. ट्रै श (Trash)

Q.14 कौन सी मेमोरी ट्रै क और सेक्टर की अवधारणा का उपयोग करती है?

Ans A. एसरैम (SRAM)     B. डीरैम (DRAM)     C. हार्ड डिस्क (Hard disk)     D. मैग्‍नेटि‍क टेप (Magnetic tape)

Q.15 जब आप किसी एमएस एक्‍सेल (MS-Excel) वर्क शीट के  सेल में संख्यात्मक डाटा प्रविष्‍ट करते हैं, तो, डिफ़ॉल्ट रूप से, इसका क्षैतिज संरेखण
(horizontal alignment) ______ होता है।

Ans A. सेंटर (center)     B. जस्‍टीफाई (justify)     C. लेफ्ट (left)     D. राइट (right)

Q.16 एमएस पावरपॉइंट 2016 (MS-PowerPoint 2016) के  संबंध में निम्नलिखित में से कौन सा/से कथन असत्‍य है/हैं?

(i) आप नॉर्मल व्‍यू (Normal view) से स्लाइड को डिलीट कर सकते हैं।
(ii) आप स्लाइड सॉर्टर व्‍यू (Slide Sorter view) से स्लाइड को ड‍िलीट नहीं  कर सकते हैं।

Ans A. (i) और (ii) दोनों     B. के वल (ii)     C. न तो (i) और न ही (ii)     D. के वल (i)

Q.17 पहचान कीज‍िए क‍ि दिए गए कथन सत्‍य हैं या असत्‍य।

(i) एमएम वर्ड (MS-Word) टेबल के  किसी कॉलम (column) की दो क्रमागत सेलों  को मर्ज नहीं  किया जा सकता है।
(ii) एमएम वर्ड (MS-Word) टेबल की एक रो (row) की दो क्रमागत सेलों  को मर्ज नहीं  किया जा सकता है।

Ans A. (i) सत्य, (ii) सत्य     B. (i) सत्य, (ii) असत्य     C. (i) असत्य, (ii) सत्य     D. (i) असत्य, (ii) असत्य

Q.18 संयुक्त राज्य अमेरिका में कॉर्पोरेट अनुप्रयोगों  के  लिए डिज़ाइन किया गया पहला सामान्य-उद्देश्य वाला इलेक्ट्रॉ निक डिजिटल कं प्यूटर
(electronic digital computer) निम्नलिखित में से कौन-सा था?

Ans A. UNIVAC I     B. टर्निंग मशीन (Turing machine)     C. Z3 मशीन     D. ENIAC

Q.19 एमएम एक्‍सेल (MS-Excel) स्प्रेडशीट के  पहले सेल का एड्रे स क्या होता है?
Ans A. Z1     B. A1     C. 1A     D. 1Z

Q.20 एमएस वर्ड (MS-Word) डॉक्‍यूमेंट में सेलेक्‍ट किए गए टेक्स्ट को कट करने के  लिए, न‍िम्‍न में से कौन सा कीबोर्ड शॉर्टकट उपयोग क‍िया जाता है?
Ans A. Ctrl + X     B. Ctrl + Z     C. Ctrl + C     D. Alt + T

Q.21 एमएस एक्‍सेल (MS-Excel) में सेल का निरपेक्ष पता (absolute address) बनाने के  लिए, निम्नलिखित में से किस चिन्ह का उपयोग किया जाता
है?

Ans A. $     B. &     C. #     D. *

Q.22 ______ वर्ड प्रोसेसर, (word processor) का एक उदाहरण नहीं  है।

Ans A. ओपन ऑफिस कै ल्क (Open Office Calc)     B. एमएस-वर्ड (MS-Word)     C. नोटपैड (Notepad)     D. गूगल डॉक (Google Doc)

Q.23 शब्द 'टावर मॉडल (tower model)', कं प्यूटर की निम्नलिखित में से किस श्रेणी से संबंधित है?

Ans A. PDAs     B. पामटॉप     C. लैपटॉप     D. डेस्कटॉप कं प्यूटर

Q.24 निम्नलिखित में से कौन-सा विकल्‍प ऑपरे टिंग सिस्टम का एक उदाहरण नहीं  है?

Ans A. यूनिक्स (Unix)     B. सफारी (Safari)     C. एमएस-डॉस (MS-DOS)     D. लिनक्स (Linux)

Q.25 निम्नलिखित में से कौन सा/से कथन असत्य है/हैं?

(i) डॉस (DOS) और लिनक्स (Linux) दोनों  सिस्टम सॉफ्टवेयर के  उदाहरण हैं।
(ii) रेलवे आरक्षण प्रणाली विशेष उद्देश्‍य के  एप्लिके शन सॉफ्टवेयर का एक उदाहरण है।

Ans A. के वल (i)     B. के वल (ii)     C. दोनों (i) और (ii)     D. न तो (i) और न ही (ii)

Q.26 एमएस पावरपॉइंट 2016 (MS-PowerPoint 2016) में स्लाइड सेटअप, स्लाइड ओरिएं टेशन, प्रेजेंटेशन थीम्‍स और बैकग्राउंड (Slide setup,
slide orientation, presentation themes and background) निम्न में से किस मेनू के  अंतर्गत दिखाई देते हैं?

Ans A. इंसर्ट (Insert)     B. र‍िव्‍यू (Review)     C. होम (Home)     D. डिजाइन (Design)
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Q.27 निम्नलिखित में से किस हार्डवेयर घटक को भंडारण इकाई (storage unit) के  रूप में भी माना जाता है, हालांकि इसकी भंडारण क्षमता
(storage capacity) बहुत कम होती है?

Ans A. रजिस्टर     B. कं ट्रो ल यून‍िट (CU)     C. एएलयू (ALU)     D. डाटा बस

Q.28 वर्ड प्रोसेसर (word processor) का निम्नलिखित में से कौन सा फीचर आपको स्वचालित रूप से अगली लाइन में जाने के  लिए सक्षम बनाता है,
जब आप एक लाइन को टेक्‍सट से पूरी तरह भर देते हैं?

Ans A. स्ट्रा इकथ्रू (Strikethrough)     B. वर्ड रैप (Word wrap)     C. कॉपी और पेस्‍ट     D. कट और पेस्‍ट

Q.29 विंडोज़ कं प्यूटर पर फाइल और फोल्डर को ______ संरचना में व्यवस्थित किया जाता है।

Ans A. लिनीअर (linear)     B. ग्राफ (graph)     C. ट्री  (tree)     D. स्‍टैक (stack)

Q.30 कं टेंट की प्रूफिं ग करना, भाषा चयन करना, कमेंट डालना और प्रेजेंटेशन की तुलना करना (Proofing content, language selection,
adding comments and comparing presentations) एमएस पावरपॉइंट 2016 (MS-PowerPoint 2016) में निम्नलिखित में से किस मेनू के
अंतर्गत आता है?

Ans A. होम (Home)     B. र‍िव्‍यू (Review)     C. व्‍यू (View)     D. ड‍िजाइन (Design)

Q.31 न‍िम्‍न में से कौन सा कीबोर्ड शॉर्टकट एमएस-वर्ड (MS-Word) में 'फॉन्‍ट (Font)' डायलॉग बॉक्स खोलने के  लिए उपयोग क‍िया जाता है?
Ans A. Ctrl + D     B. Ctrl + F     C. Ctrl + T     D. Alt + T

Q.32 भौगोलिक क्षेत्र कवरेज के  परिप्रेक्ष्य से, निम्न में से किस श्रेणी के  नेटवर्क  का सबसे अधिक कवरेज होता है?

Ans A. पैन (PAN)     B. लैन (LAN)     C. वैन (WAN)     D. मैन (MAN)

Q.33 गूगल क्रोम (Google Chrome) में वर्तमान पृष्ठ को पुनः लोड करने के  लिए निम्न में से कौन सी फं क्‍शन कीज़/कीबोर्ड शॉर्टकट का उपयोग किया
जा सकता है?

(i) F5
(ii) Ctrl + r

Ans A. के वल (i)     B. (i) और (ii) दोनों     C. के वल (ii)     D. न तो (i) और न ही (ii)

Q.34 अल्टाविस्टा (AltaVista) एक ______ है जिसे 2003 में ______ द्वारा खरीदा गया था।

Ans A. वेब ब्राउज़र, याहू!     B. वेब ब्राउज़र, गूगल     C. सर्च इंजन, याहू!     D. सर्च इंजन, गूगल

Q.35 GUI-आधारित सिस्टम में फोल्डर, फाइल या प्रोग्राम को न‍िरूपि‍त‍ करने के  लिए उपयोग की जाने वाली छोटी आकृ त‍ि ______ के  रूप में जानी
जाती है।

Ans A. फोल्डर (folders)     B. आयन (ions)     C. डेस्कटॉप (desktops)     D. आइकन (icons)

Q.36 निम्नलिखित में से कौन सा कीबोर्ड शॉर्टकट वर्तमान सेलेक्‍शन (current selection) के  लिए लाइन स्पेसिंग को डबल करता है?
Ans A. Ctrl + 2     B. Alt + 2     C. Alt + D     D. Ctrl + D

Q.37 एमएस एक्‍सेल 2016 (MS-Excel 2016) के  निम्नलिखित में से किस मेनू में 'मर्ज एं ड सेंटर (Merge & Center)' कमांड शामिल होता है?

Ans A. इंसर्ट (Insert)     B. व्‍यू (View)     C. होम (Home)     D. डाटा (Data)

Q.38 पहली पीढ़ी के  कं प्यूटरों  को ______ के  रूप में चिह्नित किया जा सकता है।

Ans A. मेनफ्रे म     B. सुपर कं प्यूटर     C. डिजिटल कं प्यूटर     D. एनालॉग कं प्यूटर

Q.39 निम्नलिखित में से क्‍या इंटरनेट पर डाटा संचार के  लिए एक जाना-माना प्रोटोकॉल है?
Ans A. SMTP     B. SNMP     C. HTTP     D. TCP/IP

Q.40 ईमेल भेजते समय, हम ईमेल के  मुख्य प्राप्तकर्ता(ओं) {recipient(s)} के  ईमेल एड्रे स को ______ फ़ील्ड में रखते हैं।
Ans A. CC     B. BCC     C. Subject     D. TO

Q.41 निम्नलिखित में से कौन सा एक वैध ईमेल आईडी नहीं  है?
Ans A. abc.def@gmail.com     B. abc_def@gmail.com     C. abc@def@gmail.com     D. abcdef@gmail.com
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Answers

Q1: C Q2: B Q3: D Q4: B Q5: C Q6: A Q7: B Q8: D Q9: D Q10: B

Q11: B Q12: A Q13: D Q14: C Q15: D Q16: B Q17: D Q18: D Q19: B Q20: A

Q21: A Q22: A Q23: D Q24: B Q25: D Q26: D Q27: A Q28: B Q29: C Q30: B

Q31: A Q32: C Q33: B Q34: C Q35: D Q36: A Q37: C Q38: D Q39: D Q40: D

Q.42 निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) IPv4 एड्रे स की लंबाई 64 बिट होती है।
(ii) Pv6 एड्रे स की लंबाई 256 बिट होती है।

Ans A. के वल (i)     B. न तो (i) और न ही (ii)     C. के वल (ii)     D. (i) और (ii) दोनों

Q.43 निम्नलिखित में से कौन सा एक शक्तिशाली, उपयोग में सरल प्रेजेंटेशन ग्राफिक्स सॉफ्टवेयर प्रोग्राम है जो आपको प्रोफे शनल द‍िखाई देने वाले
इलेक्ट्रॉ निक स्लाइड शो बनाने में सक्षम बनाता है?

Ans A. एमएस-पावरपॉइंट (MS-PowerPoint)     B. एमएस वर्ड (MS-Word)     C. एमएस एक्सेस (MS-Access)     D. एमएस-एक्सेल (MS-Excel)

Q.44 एमएस पावरपॉइंट 2016 (MS-PowerPoint 2016) में प्रेजेंटेशन व्यूज़, मास्टर स्लाइड्स, कलर सेटिंग्स और विंडो अरेंजमेंट्स (presentation
views, Master slides, colour settings and window arrangements) से संबंधित कमांड निम्न में से किस मेनू के  अंतर्गत दिखाई देते हैं?

Ans A. इंसर्ट (Insert)     B. व्‍यू (View)     C. होम (Home)     D. ड‍िजाइन (Design)

Q.45 एमएस एक्‍सेल (MS-Excel) वर्क शीट में सेल के  कं टेंट को ड‍िलीट करने के  लिए निम्नलिखित में से किस क्रम का उपयोग किया जा सकता है?
Ans A. Select -> Delete     B. Select -> Esc     C. Select -> Ctrl     D. Select -> Alt

Q.46 गूगल क्रोम (Google Chrome) में किसी पेज को लोड होने से रोकने के  लिए निम्न में से किस कुं जी (key) का उपयोग किया जा सकता है?

Ans A. Delete (डि‍लीट)     B. Backspace (बैकस्‍पेस)     C. Tab (टैब)     D. Esc (एस्के प)

Q.47 एमएस पावरपॉइंट 2016 (MS-PowerPoint 2016) में क्लिपबोर्ड फं क्‍शन्‍स, मैनिपुलेटिंग स्लाइड्स, फॉन्‍ट और पैराग्राफ सेटिंग्स (Clipboard
functions, manipulating slides, fonts and paragraph settings) निम्न में से किस मेनू के  अंतर्गत दिखाई देते हैं?

Ans A. ड‍िजाइन (Design)     B. र‍िव्‍यू (Review)     C. होम (Home)     D. व्‍यू (View)

Q.48 निम्नलिखित में से कौन सा ऑपरे टिंग सिस्टम के स सेंसिटिव (case-sensitive) होता है?

(i) यूनिक्स (Unix)
(ii) लिनक्स (Linux)
(iii) एमएस-विंडोज (MS-Windows)

Ans A. के वल (i) और (ii)     B. के वल (i) और (iii)     C. के वल (ii) और (iii)     D. (i), (ii) और (iii)

Q.49 विंडोज़ टास्कबार (Windows taskbar) का उपयोग करते हुए, निम्नलिखित में से कौन से फीचर को सेट किया/बदला जा सकता है?

(i) दिनांक (Date)
(ii) समय (Time)

Ans A. के वल (ii)     B. (i) और (ii) दोनों     C. के वल (i)     D. न तो (i) और न ही (ii)

Q.50 निम्न में से कौन सा एमएस पावरपॉइंट 2016 (MS-PowerPoint 2016) प्रेजेंटेशन में नई स्लाइड के  स्लाइड लेआउट को बदलने का सही तरीका
है ?

Ans A. नई इंसर्ट की गई स्लाइड पर राइट-क्लिक कीज‍िए और न्‍यू स्लाइड ऑपशन चुन‍िए     B. नेविगेशन पेन (Navigation Pane) में स्लाइड पर ट्रि पल-
क्लिक कीज‍िए     C. नई इंसर्ट की गई स्लाइड पर राइट-क्लिक कीज‍िए और मौजूदा लेआउट स्‍टाइल में से चुनने के  लिए लेआउटऑपशन चुन‍िए     D. नेविगेशन पेन
(Navigation Pane) में स्लाइड पर डबल-क्लिक कीज‍िए
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 नई िवंडो म� िलंक खोलने के िलए गूगल �ोम (Google Chrome) म� िन�िल�खत म� से कौन सा कीबोड� शॉट�कट उपयोग िकया जा सकता है?

Ans A. Alt + िलंक पर ��क कीिज ए (Alt + Click a link)     B. Shift + िलंक पर ��क कीिज ए (Shift + Click a link)     C. िलंक पर डबल ��क
कीिज ए (Double click a link)     D. Ctrl + िलंक पर ��क कीिज ए (Ctrl + Click a link)

Q.2 िन�िल�खत म� से कौन से कथन सही ह�?

(i) OSI की तुलना म� TCP/IP अिधक िव�सनीय है।
(ii) TCP/IP म� लेयरो ंके बीच ब�त स� त सीमाएं (�� ट�  � ट बाउंड� ी) नही ंहोती ह�।

Ans A. दोनो ं(i) और (ii)     B. केवल (i)     C. न तो (i) और न ही (ii)     D. केवल (ii)

Q.3 िन�िल�खत म� से कौन सा/से कथन अस� है/ह�?

(i) ईमेल के 'To' फ़ी� म� आप िजतने चाह� उतने एड� ेस शािमल कर सकते ह� या उतने ही एड� ेस िज तने िक  ईमेिलंग िस�म �ारा अनुमत िक ए गए
ह�।
(ii) एक ही ईमेल एड� ेस को ‘To’ और ‘Cc’दोनो ंफी� डो ंम� नही ंडाला जा सकता है।

Ans A. केवल (i)     B. न तो (i) और न ही (ii)     C. केवल (ii)     D. दोनो ं(i) या (ii)

Q.4 एमएस ए� सेल (MS-Excel) 2016 म� वक� शीट टैब (worksheet tab) पर िन�िल�खत म� से कौन सा ऑपरेशन िकया जा सकता है?

(i) िड लीट (Delete)
(ii) रीनेम (Rename)
(iii) हाइड (Hide)

Ans A. केवल (ii) और (iii)     B. (i), (ii), और (iii)     C. केवल (i) और (iii)     D. केवल (i) और (ii)

Q.5 िन�िल�खत म� से कौन सी �ेणी के कं�ूटर बड़े होते ह� और पोट�बल होने के िलए नही ंहोते ह�?

Ans A. डे�टॉप     B. लैपटॉप     C. पॉमटॉप     D. नोटपैड

Q.6 िन�िल�खत म� से एमएस वड� (MS-Word) का कौन सा फीचर, टे� से होकर गुजरने वाली रेखा खीचंता है?

Ans A. ड� ॉप कैप (Drop Cap)     B. सब��� (Subscript)     C. अंडरलाइन (Underline)     D. �� ाइक�ू (Strikethrough)

Q.7 एमएस वड� (MS-Word) डॉ� यूम�ट म� िकसी िवशेष श� का चयन करने के िलए िन� म� से िकसका उपयोग िकया जा सकता है?

Ans A. श� पर एक बार ले� ��क कीिज ए     B. श� पर एक बार राइट ��क कीिज ए     C. श� पर तीन बार ले� ��क कीिज ए     D. श� पर
दो बार ले� ��क कीिज ए

Q.8 ______ �ाउज़र एक टे�-आधा�रत �ाउज़र था, िजसका आिव�ार ______ म� िकया गया था।

Ans A. सफारी (Safari); 1985     B. सफारी (Safari); 1992     C. िलं� (Lynx); 1992     D. िलं� (Lynx); 1985

Q.9 एमएस पॉवरपॉइंट (MS-PowerPoint) 2016 म�, ______ मेनू पर ______ �ुप म� आपके डॉ�ूम�ट म� टे� को फॉम�ट  करने के िलए कमांड होते
ह�।

Ans A. � यू; फॉ� ट (View; Font)     B. �र � यू; पैरा�ाफ (Review; Paragraph)     C. होम; फॉ� ट (Home; Font)     D. होम; पैरा�ाफ (Home;
Paragraph)

Q.10 एमएस ए� सेल (MS-Excel) वक� शीट के सेल म� फॉमू�ला �िव� ट करने के िलए, िन�िल�खत म� से िकस िसंबल/कैरे�र (symbol/character) का
उपयोग िकया जाता है?

Ans A. ए�रस�ड (&)     B. �ितशत (%)     C. डॉलर ($)     D. बराबर (=)

Q.11 िन�िल�खत एमएस ए� सेल (MS-Excel) फं� शन का आउटपुट �ा होगा?

=ROUNDUP(213.456, 0)
Ans A. 210     B. 214     C. 213.456     D. 220
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Q.12 निम्नलिखित में से कौन-सा एमएस एक्‍सेल (MS-Excel) फं क्शन शून्य से दू र (away from zero) पूर्णांकित संख्या को सिग्निफिके न्स
(significance) के  निकटतम गुणज में र‍िटर्न करता है?

Ans A. ROUND()     B. CELL()     C. CEILING()     D. FLOOR()

Q.13 फाइल सिस्टम के  संबंध में, निम्नलिखित में से कौन सी FAT की वैध श्रेणी नहीं  है?
Ans A. FAT12     B. FAT10     C. FAT16     D. FAT32

Q.14 यदि आप एमएस पॉवरपॉइंट (MS-PowerPoint) 2016 में ______ कुं जी (key) दबाते हैं, तो प्रेजेंटेशन शुरू से ही पूर्ण-स्क्रीन मोड में दिखाई
देगा।

Ans A. F4     B. Shift+F5     C. F7     D. F5

Q.15 एमएस-पावरपॉइंट (MS-PowerPoint) 2016 में, ______ रिबन (Ribbon) के  ठीक ऊपर स्थित होता है और यह आपको सामान्य कमांड्स
(common commands) तक पहुंच प्रदान करता है चाहे कोई भी टैब/मेनू चुना गया हो।

Ans A. क्विक एक्सेस टू लबार (Quick Access Toolbar)     B. स्टेटस बार (Status bar)     C. टाइटल बार (Title bar)     D. स्क्रॉल बार (Scroll bar)

Q.16 निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) सिस्टम सॉफ्टवेयर, एप्लिके शन सॉफ्टवेयर के  कार्य करने की सुविधा प्रदान करता है।
(ii) एमएस वर्ड (MS-Word), सिस्टम और एप्लीके शन सॉफ्टवेयर दोनों  है।

Ans A. (i) और (ii) दोनों     B. के वल (i)     C. के वल (ii)     D. न तो (i) और न ही (ii)

Q.17 एमएस एक्‍सेल (MS-Excel) 2016 वर्क शीट में सेल कं टेंट को संपादित करने के  लिए निम्न में से किसका उपयोग किया जा सकता है?

(i) F2
(ii) डबल क्लिक (Double click)

Ans A. (i) और (ii) दोनों     B. के वल (i)     C. न तो (i) और न ही (ii)     D. के वल (ii)

Q.18 एमएस वर्ड (MS-Word) 2016 में 'इन्सर्ट हाइपरलिंक (Insert Hyperlink)' विंडो को उपयोग करने के  लिए प्रयुक्‍त कीबोर्ड शॉर्टकट बताएं ।
Ans A. Alt+L     B. Ctrl+K     C. Alt+K     D. Ctrl+H

Q.19 ALU के  संबंध में निम्नलिखित में से कौन सा कथन गलत है?

Ans A. ALU अर‍िथमेट‍िक और लॉज‍िक दोनों प्रकार के  प्रचालन करता है।     B. ALU, CPU के  मुख्य घटकों में से एक है।     C. ALU, कं ट्रो ल यूनिट के
फं क्‍शनों को नियंत्रित करता है।     D. ALU प्रचालनों के  लिए CPU रजिस्टरों का उपयोग करता है।

Q.20 वर्ल्डवाइडवेब (WorldWideWeb) पहला वेब ब्राउज़र था, जिसे बाद में वर्ल्ड वाइड वेब (World Wide Web) के  साथ किसी भी भ्रम से बचने के
लिए ______ नाम दिया गया था।

Ans A. इंटरनेट एक्स्प्लोरर (Internet Explorer)     B. फायरफॉक्‍स (Firefox)     C. नेक्‍सस (Nexus)     D. सफारी (Safari)

Q.21 एमएस पॉवरपॉइंट (MS-PowerPoint) 97 से 2003 संस्करणों  में बनाए गए प्रेजेंटेशन (presentations) के  लिए डिफॉल्‍ट फाइल प्रकार
(एक्सटेंशन) क्या है?

Ans A. .ppt     B. .ppxt     C. .ppto     D. .pptx

Q.22 निम्नलिखित में से कौन सा CPU रजिस्टर, ऑपरेंड को स्टोर करने के  लिए ALU द्वारा उपयोग किया जाता है?

Ans A. प्रोग्राम काउंटर और एक्‍युम्‍युलेटर दोनों     B. प्रोग्राम काउंटर (Program counter)     C. एक्‍युम्‍युलेटर (Accumulator)     D. एड्रे स रजिस्टर
(Address register)

Q.23 निम्नलिखित में से कौन सा मेनू आपको एमएस वर्ड (MS-Word) 2016 में स‍िंगल पेज और टू  पेज (Single Page and Two Page) व्यू के  बीच
स्विच करने के  सक्षम बनाता है?

Ans A. होम (Home)     B. डिजाइन (Design)     C. र‍िव्‍यू (Review)     D. व्‍यू (View)

Q.24 एमएस-एक्सेल (MS-Excel) वर्क शीट में उस सेल का एड्रे स क्या है जो दू सरी रो (row) और तीसरे  कॉलम (column) के  इंटरसेक्‍शन पर स्थित है?
Ans A. C2     B. 2C     C. 3B     D. B3

Q.25 जीमेल (Gmail) में, आप एक ऐसा यूजरनेम (username) चुन सकते हैं जो ______ कै रेक्टर लंबा हो।

Ans A. 4 से 30     B. 8 से 64     C. 6 से 30     D. 6 से 64
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Q.26 निम्नलिखित में से कौन से कार्य यूजर इंटरफे स द्वारा क‍िए जाते हैं?

(i) यूजर के  इनपुट को स्वीकार करना
(ii) आउटपुट प्रदर्शित करना

Ans A. न तो (i) और न ही (ii)     B. के वल (ii)     C. (i) और (ii) दोनों     D. के वल (i)

Q.27 एमएस वर्ड (MS-Word) डॉक्‍यूमेंट में टेक्स्ट को एक स्थान से दू सरे  स्थान पर ले जाने के  लिए निम्नलिखित में से किस कीबोर्ड शॉर्टकट का उपयोग
किया जाता है?

Ans A. Ctrl+Y और Ctrl+Z     B. Ctrl+C और Ctrl+Z     C. Ctrl+C और Ctrl+V     D. Ctrl+X और Ctrl+V

Q.28 IPv4 एड्रे स को चार सेगमेंट (खंडों ) में बांटा गया है। प्रत्येक सेगमेंट का आकार क्या है?

Ans A. 32 बिट     B. 8 बाइट     C. 16 बिट     D. 8 बिट

Q.29 CPU थ्रूपुट (throughput) को बढ़ाने के  लिए, निम्नलिखित में से कौन सी मेमोरी CPU तथा मेन मेमोरी के  बीच रखी जाती है?

Ans A. ऑग्ज़ीलरी मेमोरी (Auxiliary memory)     B. सेकें डरी मेमोरी (Secondary memory)     C. कै श मेमोरी (Cache memory)     D. सीक्वें शियल
मेमोरी (Sequential memory)

Q.30 जब आप ईमेल के  ______ फ़ील्ड में ईमेल एड्रे स डालते हैं, तो वे एड्रे स ईमेल प्राप्तकर्ताओं (recipients) के  लिए अदृश्य होते हैं।

Ans A. सब्जेक्ट (Subject)     B. Bcc     C. To     D. Cc

Q.31 एमएस वर्ड (MS-Word) 2016 में, बोल्ड, अंडरलाइन और इटैलिक जैसे विकल्प ______ मेनू/टैब के  अंतर्गत दिखाई देते हैं।

Ans A. डिजाइन (Design)     B. होम (Home)     C. इंसर्ट (Insert)     D. र‍िव्‍यू (Review)

Q.32 एमएस पॉवरपॉइंट (MS-PowerPoint) 2016 में आपकी स्लाइड्स पर कं टेंट को प्रबंधि‍त और व्यवस्थित करने में मदद करने के  लिए कई टू ल
शामिल हैं। निम्नलिखित में से कौन से ऐसे टू ल हैं?

(i) रूलर (Ruler), (ii) ग्रिडलाइन्स (Gridlines)

Ans A. न तो (i) और न ही (ii)     B. दोनों (i) और (ii)     C. के वल (i)     D. के वल (ii)

Q.33 एमएस पॉवरपॉइंट (MS-PowerPoint) 2016 में ______ मेनू के  अंतर्गत पैराग्राफ, ड्रा इंग और एड‍िट‍िंग (paragraphs, drawing and editing)
संबंधित कमांड दिखाई देते हैं।

Ans A. इंसर्ट (Insert)     B. ट्रां ज‍िशन्‍स (Transitions)     C. व्‍यू (View)     D. होम (Home)

Q.34 विंडोज़ सिस्टम के  संबंध में निम्नलिखित में से कौन सा कथन असत्‍य है?

Ans A. एक फोल्डर में कई फोल्डर हो सकते हैं।     B. एक फोल्डर में फाइल और फोल्डर दोनों हो सकते हैं।     C. एक फोल्‍डर में एक ही नाम के  फोल्‍डर
और फाइल हो सकते हैं।     D. एक फोल्‍डर में PDF और ZIP दोनों फाइलें एक साथ नहीं  हो सकतीं ।

Q.35

Ans A. (i) और (ii) दोनों     B. न तो (i) और न ही (ii)     C. के वल (ii)     D. के वल (i)

Q.36 निम्नलिखित में से किस मेमोरी को कु छ समय अंतराल पर निरंतर र‍िफ्रे श करने की आवश्यकता होती है?

Ans A. सेकें डरी मेमोरी     B. SRAM     C. DRAM     D. कै श मेमोरी

Q.37 निम्नलिखित में से कौन सा/से कथन असत्य है/हैं?

(i) कं पाइलर निष्पादन योग्य कोड (executable codes) उत्पन्न करता है।
(ii) असेंबलर का उपयोग हाई लेवल लैंग्‍वेज कोड को मशीन कोड में ट्रां सलेट (अनुवाद) करने के  लिए किया जा सकता है।

Ans A. न तो (i) और न ही (ii)     B. के वल (ii)     C. के वल (i)     D. (i) और (ii) दोनों
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Answers

Q.38 निम्नलिखित में से किस नेटवर्क  टोपोलॉजी में प्रत्येक नोड ठीक दो अन्य नोड्स से जुड़ा होता है?

Ans A. मेश     B. र‍िं ग     C. स्‍टार     D. बस

Q.39 ब्लूटू थ हेडसेट से जुड़ा सेल फोन या पोर्टेबल ब्लूटू थ थर्मल प्रिंटर से जुड़ा मोबाइल कं प्यूटर ______ का एक उदाहरण है।
Ans A. SAN     B. PAN     C. MAN     D. LAN

Q.40 ऑपरे टिंग सिस्टम की निम्नलिखित में से कौन सी प्रकार्यात्मकता, निष्पादन (execution) अधीन विभिन्न प्रोग्रामों  को मेमोरी स्पेस आवंटित करती
है?

Ans A. प्रोसेसर मैनेजमेंट     B. मेमोरी मैनेजमेंट     C. सिक्योरिटी मैनेजमेंट     D. डिवाइस मैनेजमेंट

Q.41 निम्नलिखित में से कौन से कथन सत्य हैं?

(i) एमएस पॉवरपॉइंट (MS-PowerPoint) में व्‍यू के  लिए कई विकल्प हैं जो आपके  प्रेजेंटेशन के  प्रदर्शित होने के  तरीके  को बदलते हैं।
(ii) एमएस पॉवरपॉइंट (MS-PowerPoint) में, स्लाइडर (slider) के  बगल में संख्या, वर्तमान ज़ूम प्रतिशत (zoom percentage) प्रदर्शित करती
है, जिसे ज़ूम लेवल (zoom level) भी कहा जाता है।

Ans A. के वल (ii)     B. के वल (i)     C. (i) और (ii) दोनों     D. न तो (i) और न ही (ii)

Q.42 संक्षिप्त नाम HTTPS में, दू सरे  ‘T’का पूर्ण रूप क्या है?

Ans A. Truncation (ट्रं के शन)     B. Transition (ट्रां ज‍िशन)     C. Termination (टर्म‍िनेशन)     D. Transfer (ट्रां सफर)

Q.43 निम्नलिखित में से कौन सा व‍िकल्‍प यूजर इंटरफे स के  वैध वर्गीकरण को न‍िरूपि‍त करता है?

Ans A. टेक्स्टुअल और वर्चुअल (Textual and Virtual)     B. टेक्स्टुअल और ग्राफिकल (Textual and Graphical)     C. ग्राफिकल और वर्चुअल
(Graphical and Virtual)     D. टेक्स्टुअल, ग्राफिकल और वर्चुअल (Textual, Graphical and Virtual)

Q.44 निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) याहू (Yahoo) एक वेब पोर्टल है, जो वेब सर्च पोर्टल (web search portal) की मुख्‍य विशेषताओं में से एक है।
(ii) गूगल (Google) और बिंग (Bing) दोनों  ही सर्च इंजन हैं।

Ans A. के वल (i)     B. दोनों (i) और (ii)     C. न तो (i) और न ही (ii)     D. के वल (ii)

Q.45 निम्नलिखित में से कौन-सा एमएस वर्ड (MS-Word) 2016 में टेबल प्रॉपर्टीज व‍िंडो (Table Properties window) में एक मान्य टैब नहीं  है?

Ans A. कॉलम (Column)     B. टेबल (Table)     C. शीट (Sheet)     D. रो (Row)

Q.46 डेस्कटॉप कं प्यूटर, लैपटॉप और पॉमटॉप कं प्यूटर जैसे कं प्यूटरों  को ______ के  रूप में वर्गीकृ त किया जा सकता है।

Ans A. पर्सनल कं प्‍यूटर     B. मेनफ्रे म कं प्यूटर     C. मिनी कं प्यूटर     D. सुपर कं प्यूटर

Q.47 जीमेल (Gmail) में ईमेल आईडी के  घटक के  रूप में निम्नलिखित में से किस कै रेक्‍टर (characters) की अनुमति नहीं  है?

Ans A. संख्‍या (0-9)     B. एम्परसैंड (&)     C. डॉट (.)     D. एट द रेट (@)

Q.48 एमएस वर्ड (MS-Word) में कार्य करते समय Ctrl+Y दबाने से क्या होगा ?

Ans A. अंतिम कार्रवाई को फिर से कर (redone) दिया जाएगा।     B. फाइल का अंतिम शब्द म‍िटा दिया जाएगा।     C. अंतिम कार्रवाई को हटा
(undone) दिया जाएगा।     D. पूरी फाइल का कं टेंट म‍िटा द‍िया जाएगा।

Q.49 एमएस पॉवरपॉइंट (MS-PowerPoint) 2007 या नए संस्करणों  में बनाए गए प्रेजेंटेशन (presentations) के  लिए डिफॉल्‍ट फाइल प्रकार
(एक्सटेंशन) क्या है?

Ans A. .ppt     B. .xppt     C. .pptm     D. .pptx

Q.50 एमएस एक्‍सेल (MS-Excel) वर्क शीट के  सेल में डाटा दर्ज करते समय, सेल के  सारे  कं टेंट को रद्द (cancel) करने के  लिए निम्नलिखित में से कौन
सी कुं जी (key) को एक बार दबाया जा सकता है?

Ans A. बैकस्पेस (Backspace)     B. टैब (Tab)     C. इस्‍के प (Esc)     D. ड‍िलीट (Delete)
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 MS-Word (एमएस-वड�) 365 म� होम (Home) टैब के एिडिटंग (Editing) �ुप म� िन�िल�खत म� से कौन-सा िवक� उपल� नही ंहै?

Ans A. �ाट� िड�ेशन (Start Dictation)     B. सेले� (Select)     C. �र�ेस (Replace)     D. फाइंड (Find)

Q.2 िन�िल�खत म� से कौन सा माइ�ो कं�ूटर (microcomputers) की �ेणी से संबंिधत नही ंहै?

Ans A. �े-1 (Cray-1)     B. पामटॉप कं�ूटर (Palmtop computers)     C. वक� �ेशन (Workstations)     D. डे�टॉप कं�ूटर (Desktop
computers)

Q.3

Ans A. का�ै�्स (Contacts)     B. टा� (Tasks)     C. कैल�डर (Calendar)     D. मेल (Mail)

Q.4 Windows (िवंडोज) 10 ऑपरेिटंग िस�म म� िन�िल�खत म� से कौन-सा िवक�, आपके डे�टॉप पर होने की ��ित म� ��रत प�ँच (quick
access) के िलए सीधे टा�बार पर एक ऐप ( app) रखता है?

Ans A. सेव टु टा�बार (Save to taskbar)     B. असाइन टु टा�बार (Assign to taskbar)     C. िपन टु टा�बार (Pin to taskbar)     D. �ोर टु
टा�बार (Store to taskbar)

Q.5 िन�िल�खत म� से कौन-सा, DSL और केबल मॉडेम के साथ तुलना करने पर, डायल-अप इंटरनेट ए�ेस (internet access) िविध का अलाभ
है?

Ans A. सुर�ा जो�खम     B. लो �ीड (Low speed)     C. िलिमटेड पेरीमीटर (Limited perimeter)     D. ए�प��िसव (Expensive)

Q.6 DNS (डोमेन नंबर िस�म) इंटरनेट की िन�िल�खत म� से िकस सेवा के अंतग�त आता है?

Ans A. संचार (Communication)     B. िनद� �िशका (Directory)     C. WWW     D. सूचना की पुन�ा��� (Information retrieval)

Q.7 The semiconductor memory, Dynamic RAM (DRAM) stores each bit of information in a/an______.
Ans A. encoder     B. capacitor     C. diode     D. resistor

Q.8 Which of the following sequences of steps is used to open an existing MS-Word 365 document?
Ans A. File -> Open     B. Home -> Open     C. Home -> New     D. File -> New

Q.9 Which of the following sequence of steps is used to open the MS-Word 365 software?
Ans A. Press the Windows key + ‘R’ to bring up the Run dialog -> Type ‘MS-Word.exe’ without quotation marks in the box     B.

Press the Windows key and ‘R’ to bring up the Run dialog -> Type ‘WinWord.exe’ without quotation marks in the box     C. Press the Windows
key + ‘R’ to bring up the Run dialog -> Type ‘Word.exe’ without quotation marks in the box     D. Press the Windows key + ‘R’ to bring up the
Run dialog -> Type ‘Win.exe’ without quotation marks in the box

Q.10 MS-Word (एमएस-वड�) 365 म� कीबोड� शॉट�कट 'Ctrl + E' का उपयोग, िन�िल�खत म� से िकस उ�े� के िलए िकया जाता है?

Ans A. ले�-अलाइन टे� (Left-align text)     B. ज��फाई टे� (Justify text)     C. स�टर टे� (Center text)     D. राइट-अलाइन टे� (Right-
align text)

Q.11 MS-PowerPoint (एमएस-पावरपॉइंट) 365 म� जूम डायलॉग बॉ� खोलने के िलए िन�िल�खत म� से िकस कीबोड� शॉट�कट का उपयोग िकया
जाता है?

Ans A. Ctrl + M     B. Alt + H, F     C. Alt + W, Q     D. Ctrl + B

In MS-Excel 365, to enter the same data into several cells at the same time, select the cells into which you want to enterQ.12
the data (the cells do not have to be adjacent). In the active cell, type the data and then press______.

Ans A. Ctrl + Enter     B. Shift + Enter     C. Tab + Enter     D. Alt + Enter
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Q.13 MS-Excel (एमएस-एक्सेल) 365 में निम्नलिखित में से कौन सा फं क्शन दो तिथियों  के  बीच दिनों  की संख्या को वापस लाने के  लिए उपयोग किया
जाता है?

Ans A.
DAY     B.
DATE     C. FIND
    D.
DAYS

Q.14 जब कोई डिवाइस दू सरे  डिवाइस पर संदेश भेजने का प्रयास करता है, तो डेटा को इंटरनेट पर प्रबंधनीय______ के  फ़ॉर्म में भेजा जाता है।

Ans A. बिन्स (bins)     B. लेबल्स (labels)     C. पैके ट्स (packets)     D. एन्वेलप्स (envelopes)

Q.15

Ans A. (i)-(c), (ii)-(b), (iii)-(a)     B. (i)-(a), (ii)-(c) (iii)-(b)     C. (i)-(a), (ii)-(b), (iii)-(c)     D. (i)-(c), (ii)-(a), (iii)-(b)

Q.16 निम्नलिखित में से कौन-सा, ऐसा सॉफ्टवेयर इंटरफे स प्रदान करता है जो आपको WWW पर हाइपरलिंक्ड रिसोर्सेस (hyperlinked resources)
पर क्लिक करने की अनुमति देता है?

Ans A. URI     B. ब्राउजर     C. IP एड्रे स     D. URL

Q.17 यह ज्ञात कीजिए कि दिए गए ये कथन सत्य हैं या असत्य।

(i) WWW कं प्यूटर, लैपटॉप, टैबलेट आदि जैसे उपकरणों  का एक विश्वव्यापी नेटवर्क  है।
(ii) इंटरनेट, वेब सर्वरों  पर संग्रहीत और स्थानीय कं प्यूटर से जुड़ी वेबसाइटों  या वेब पेजों  का एक संग्रह है।

Ans A. (i)- सत्य , (ii)- सत्य     B. (i)- असत्य, (ii)- असत्य     C. (i)- असत्य, (i)- सत्य     D. (i)-सत्य, (ii)-असत्य

Q.18 निम्नलिखित में से कौन सा आइकन MS-Word (एमएस-वर्ड) 365 में फॉन्ट कलर (Font Color) आइकन है?

Ans A.      B.      C.      D. 

Q.19 यूज़र नाम और डोमेन नाम को अलग करने के  लिए ईमेल पते (email address) में निम्नलिखित में से किस प्रतीक का उपयोग किया जाना
चाहिए?

Ans A. @     B. %     C. #     D. $

Q.20 यह ज्ञात कीजिए कि CPU के  संदर्भ में दिए गए ये कथन सत्य हैं या असत्य।

(i) यह रजिस्टर मेमोरी (register memory), कं ट्रो ल यूनिट (control unit) और अरिथ्मेटिक लॉजिक यूनिट से बनता है।
(ii) आधुनिक कं प्यूटरों  में, यह एक एकीकृ त सर्कि ट चिप (integrated circuit chip) में समाहित होता है, जिसे मदरबोर्ड कहा जाता है।

Ans A. (i)- सत्य, (ii)- सत्य     B. (i)- सत्य, (ii)- असत्य     C. (i)- असत्य , (i)- सत्य     D. (i)- असत्य, (ii)- असत्य

Q.21 MS-Excel (एमएस-एक्सेल) 365 में, एक ही वर्क बुक में, अन्य वर्क शीटों  पर मौजूद सेलों  को, सेल संदर्भ की शुरुआत के  लिए वर्क शीट के  नाम के
बाद एक______ प्रतीक को जोड़ (prepending) करके  संदर्भित किया जा सकता है।

Ans A. विस्मयादिबोधक बिंदु (!)     B. ऐस्टरिस्क (*)     C. कोलन (:)     D. प्रतिशत (%)
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Q.22 निम्नलिखित में से कौन-सा, लिनक्स ऑपरे टिंग सिस्टम (Linux operating system) का ऐसा सब-सिस्टम है जो मॉनिटर पर ग्राफिक्स को
प्रदर्शित करता है और इसे आमतौर पर X सर्वर या मात्र X के  रूप में संदर्भित किया जाता है?

Ans A. इनिट सिस्टम (Init system)     B. कर्नेल (Kernel)     C. ग्राफिकल सर्वर (Graphical server)     D. डैमन्स (Daemons)

Q.23 MS-Excel (एमएस-एक्सेल) 365 में, ओवरटाइप (Overtype) मोड को चालू करने के  लिए, ताकि आप द्वारा टाइप करते समय मौजूदा अक्षरों  को
नए अक्षरों  से प्रतिस्थापित कर दिया जाए,______ कुं जी (key) को दबाना चाहिए?

Ans A.
शिफ्ट (Shift)     B. एं टर (Enter)
    C.
बैकस्पेस (Backspace)     D.
इन्सर्ट (Insert)

Q.24 MS-PowerPoint (एमएस-पावरपॉइंट) 365 में अपीयर (Appear), फे ड (Fade), फ्लाई इन (Fly in) आदि किस टैब के  विकल्प हैं?

Ans A. ट्रां जिशन्स (Transitions)
    B.
एनिमेशन्स (Animations)     C.
स्लाइड शो (Slide Show)     D.
डिजाइन (Design)

Q.25 ईमेल पते (email address) का पहला भाग______ होता है।

Ans A. सिस्टम नेम (system name)     B. यूज़र नेम (username)     C. डोमेन नेम (domain name)     D. मेल सर्वर (mail server)

Q.26 Which of the following keyboard shortcuts and their functions in MS-PowerPoint 365 is/are correct?

(I) Ctrl + D – Duplicate an object.
(II) Ctrl + X – Cut the selected object or text.

Ans A. Only (II)     B. Neither (I) nor (II)     C. Only (I)     D. Both (I) and (II)

Q.27 In Windows 10, which of the following options of Display in Settings is to be selected to change the size of your text and
apps?

Ans A. Display resolution     B. Scale and layout     C. Calibrate display color     D. Display orientation

Q.28 MS-Word (एमएस-वर्ड) 365 में लेआउट (Layout) टैब के  पेज सेटअप (Page Setup) ग्रुप में निम्नलिखित में से कौन-सा विकल्प उपलब्ध नहीं
है?

Ans A. हाइफे नेशन (Hyphenation)     B. स्पेसिंग (Spacing)     C. लाइन नंबर (Line numbers)     D. ब्रेक (Breaks)

Q.29 निम्नलिखित में से किसका उपयोग, गूगल सर्च इंजन (Google search engine) में एक निश्चित वेबसाइट पर लेख या सामग्री (कं टेंट) सर्च करने
के  लिए किया जाता है?

Ans A. हाइफन (-)     B. कॉलन (:)     C. टैब     D. ऐस्टरिस्क (*)

Q.30 निम्नलिखित में से कौन-सा, सामान्यतः  आपरे टिंग सिस्टम द्वारा समर्थित किसी मल्टीमीडिया फाइल का फाइल एक्सटेंशन (file extension) है?
Ans A. .lib     B. .mpeg     C. .exe     D. .obj

Q.31 UNIVAC I पहला सामान्य-उद्देश्य वाला इलेक्ट्रॉ निक डिजिटल कं प्यूटर था, जिसे संयुक्त राज्य अमेरिका में कॉर्पोरेट अनुप्रयोगों  के  लिए डिजाइन
किया गया था। UNIVAC का पूर्णरूप क्या है?

Ans A. Universal Automatic Computer (यूनिवर्सल ऑटोमेटिक कं प्यूटर)     B. United Automatic Computer (यूनाइटेड ऑटोमेटिक कं प्यूटर)     C.
Universal Asynchronous Computer (यूनिवर्सल असिंक्रोनस कं प्यूटर)     D. Universal Automatic Calculator (यूनिवर्सल ऑटोमेटिक कै लकु लेटर)

Q.32 Which layer of internet architecture includes different protocols for building internet services?
Ans A. Application     B. IP     C. Physical     D. TCP

Q.33 Which of the following types of computing has application in the defense industry?
Ans A. Pharmacy management software     B. GPS tracking     C. Library manager     D. e-banking
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Q.34 किसी बिंदु  पैमाने (point scale) के  आधार पर, MS-Excel (एमएस-एक्सेल) 365 में पंक्ति (row) की ऊँ चाई का अधिकतम आकार क्या होता है?
Ans A.

8.43     B.
255     C.
15     D.
409

Q.35 MS-Word (एमएस-वर्ड) 365 में, पैराग्राफ की पहली पंक्ति को इंडेंट करने के  लिए, पैराग्राफ के  शुरुआत में अपना कर्सर रखना चाहिए और
______ कुं जी (key) को दबाना चाहिए।

Ans A. शिफ्ट (Shift)     B. Alt     C. टैब (Tab)     D. Ctrl

Q.36 कं प्यूटर सिस्टम के  कीबोर्ड पर इन्सर्ट कुं जी (Insert key) का उपयोग डेटा एं ट्री  के  दौरान______ और______ मोड के  बीच टॉगल (toggle)
करने के  लिए किया जाता है।

Ans A. डिलीट (delete), इन्सर्ट (insert)     B. बैकस्पेस (backspace), ओवरराइट (overwrite)     C. इन्सर्ट (insert), ओवरराइट (overwrite)     D.
डिलीट (delete), ओवरराइट (overwrite)

Q.37 MS-Excel (एमएस-एक्सेल) 365 में मौजूद चार्ट के  चार्ट टाइप (chart type) को बदलने के  लिए निम्नलिखित में से किस चरण-क्रम का उपयोग
किया जाता है?

Ans A. Chart Design tab -> Change Chart Type
    B. Page Layout -> Change Chart Type
    C. Draw -> Change Chart Type
    D. Format tab -> Change Chart Type

Q.38 स्लाइड्स को आसानी से पुनर्व्यवस्थित करने के  लिए निम्नलिखित में से किस MS-PowerPoint (एमएस-पावरपॉइंट) 365 व्यू का उपयोग किया
जाता है?

Ans A. हैंडआउट मास्टर (Handout Master)
    B. नोट्स पेज (Notes Page)
    C. स्लाइड शॉर्टर (Slide Sorter)
    D. स्लाइड मास्टर (Slide Master)

Q.39

Ans A. (i)-(c), (ii)-(a), (iii)-(b)     B. (i)-(c), (ii)-(b), (iii)-(a)     C. (i)-(a), (ii)-(b), (iii)-(c)     D. (i)-(b), (ii)-(a), (iii)-(c)

Q.40 Windows (विंडोज) 10 में टाइम और टाइम ज़ोन निर्धारित करने के  लिए निम्नलिखित में से चरणों  के  किस क्रम का उपयोग किया जाता है?
Ans A. Start -> Settings -> System -> Date & time     B. Start -> Settings -> Network & Internet -> Date & time     C. Start -> Settings

-> Time & language -> Date & time     D. Start -> Settings -> Update & Security -> Date & time

Q.41 MS-PowerPoint (एमएस-पावरपॉइंट) 365 में 'प्रेजेंटेशन व्यू' (Presentation Views) समूह, निम्नलिखित में से किस टैब में उपलब्ध है?

Ans A. होम (Home)
    B. ट्रां जिशन (Transition)
    C. व्यू (View)
    D. रिव्यू (Review)

Q.42 MS-Excel (एमएस-एक्सेल) 365 के  निम्नलिखितसूत्र का आउटपुट क्या होगा?

=20/10*7+4-1
Ans A. 17     B. 30     C. 27     D. 20
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Answers

Q1: A Q2: A Q3: A Q4: C Q5: B Q6: B Q7: B Q8: A Q9: B Q10: C

Q11: C Q12: A Q13: D Q14: C Q15: D Q16: B Q17: B Q18: B Q19: A Q20: B

Q21: A Q22: C Q23: D Q24: B Q25: B Q26: D Q27: B Q28: B Q29: B Q30: B

Q.43 MS-PowerPoint (एमएस-पावरपॉइंट) 365 स्लाइड में लाइन की स्टाइल को बदलने के  लिए निम्नलिखित में से किस टैब का उपयोग किया जाता
है?

Ans A.
पिक्चर फॉर्मेट (Picture Format)     B. डिजाइन (Design)
    C. ड्रा  (Draw)
    D.
शेप फॉर्मेट (Shape Format)

Q.44 MS-PowerPoint (एमएस-पावरपॉइंट) 365 में किसी पिक्चर ऑब्जेक्ट को एक विशिष्ट अनुपात में मैन्युअल रूप से सेट करने के  लिए
निम्नलिखित में से किस चरण-क्रम का उपयोग किया जाता है?

1. शॉर्टकट मेन्यू पर, फॉर्मेट पिक्चर (Format Picture)पर क्लिक करना
2. पिक्चर पर राइट-क्लिक करना
3. स्के ल के  अंतर्गत, मूल ऊं चाई या चौड़ाई का प्रतिशत दर्ज करना
4. डायलॉग बॉक्स में, साइज टैब पर क्लिक करना

Ans A. 4,3,2,1     B. 2,4,3,1     C. 2,1,4,3     D. 1,2,3,4

Q.45 HTTP एक एप्लिके शन लेयर प्रोटोकॉल (application layer protocol) है जो WWW को सुचारू रूप से और प्रभावी ढंग से कार्य करने में सक्षम
बनाता है। HTTP का पूर्ण रूप क्या है?

Ans A. Hypertext Transformation Pipeline (हाइपरटेक्स्टट्रा न्सफॉर्मेशन पाइपलाइन)     B. Hypertext Transfer Protocol (हाइपरटेक्स्ट ट्रा न्सफर
प्रोटोकॉल)     C. Hypertext Transfer Pipeline (हाइपरटेक्स्ट ट्रा न्सफर पाइपलाइन)     D. Hypertext Transformation Protocol (हाइपरटेक्स्ट ट्रा न्सफॉर्मेशन
प्रोटोकॉल)

Q.46 एक्सटेंडेड ASCII कोड प्रत्येक अक्षर का निरूपण करने के  लिए______ बिट्स का उपयोग करता है।
Ans A. 16     B. 8     C. 7     D. 4

Q.47 In MS-Excel 2010, the______ feature helps us to add the contents of a cluster of adjacent cells.
Ans A. PivotTable     B. AutoFill     C. AutoSum     D. Charts

Q.48 MS-Word (एमएस-वर्ड) 365 में हेल्प (Help) विकल्प के  संदर्भ में निम्नलिखित में से कौन-सा कथन असत्य है?

Ans A. सहायता प्राप्त करने के  लिए आपको अपनी क्वे री“Tell me what you want to do”बॉक्स में टाइप करनी होगी।     B. फ़ाइल मेन्यू (File menu) से
हेल्प विकल्प (Help option) तक पहुँचा जा सकता है।     C. F5 फं क्शन कुं जी (key) का उपयोग किसी भी समय हेल्प व्यूअर विंडो (Help viewer window) खोलने के
लिए किया जा सकता है।     D. इसे आसानी से प्राप्त करने के  लिए आपको क्विक एक्सेस टू लबार (Quick Access Toolbar) में एक हेल्प शॉर्टकट (Help shortcut)
जोड़ना होगा।

Q.49 Outlook (आउटलुक) 365 के  डेस्कटॉप संस्करणों  में, आप______ पर जाकर किसी भी समय मैन्युअल रूप से अपने ईमेल संदेश में वर्तनी
(spelling) की जाँच कर सकते हैं।

Ans A. Insert -> Spelling & Grammar     B. Review -> Spelling & Grammar     C. Options -> Spelling & Grammar     D. File ->
Spelling & Grammar

Q.50 MS-PowerPoint (एमएस-पावरपॉइंट) 365 में पिक्चर फॉर्मेट (Picture Format) टैब में किस विकल्प का उपयोग पिक्चर की ब्राइटनेस, कं ट्रा स्ट
या शार्पनेस को बेहतर बनाने के  लिए किया जाता है?

Ans A. कलर (Color)
    B. करेक्शन्स (Corrections)
    C. आर्टिस्टिक इफे क्ट्स (Artistic Effects)
    D. ट्रा न्सपरेंसी (Transparency)
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Q31: A Q32: A Q33: B Q34: D Q35: C Q36: C Q37: A Q38: C Q39: A Q40: C

Q41: C Q42: A Q43: D Q44: C Q45: B Q46: B Q47: C Q48: C Q49: B Q50: B
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 िन�िल�खत म� से कौन सा िवक� वड� �ोसेिसंग फाइल का ए�ट�शन नही ंहै?
Ans A. .docx     B. .rtf     C. .bat     D. .doc

Q.2 जब एमएस-ए�ेल 365 (MS-Excel 365) एिडट मोड (Edit mode) म� होता है, तो 'Edit' श� ए�ेल �ो�ाम िवंडो के ______ कोने म� िदखाई
देता है।

Ans A. िनचले बाय�     B. िनचले दाय�     C. ऊपरी बाय�     D. ऊपरी दाय�

Q.3 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) म� शेप फॉम�ट टैब (Shape Format tab) म� िन�िल�खत म� से कौन सा िवक� िबंदुिकत या
डैश (dotted or dashed) लाइन बनाने के िलए उपयोग िकया जाता है?

Ans A. शेप इफे�्स (Shape Effects)
    B. शेप आ�शंस (Shape Options)
    C. शेप आउटलाइन (Shape Outline)
    D. शेप िफल (Shape Fill)

Q.4 एमएस-वड� 365 (MS-Word 365) म� िन�िल�खत म� से कौन सा िवक� मेनू बार का िवक� नही ंहै?

Ans A. रेफर� सेज (References)     B. मेिलं� (Mailings)     C. डेवलपर (Developer)     D. िड�ेट (Dictate)

Q.5 यिद आप सदैव फ��-लाइन इंड���टेशन (first-line indentation) चाहते ह�, तो एमएस-वड� 365 (MS-Word 365) म� पैरा�ाफ टैब का िन�िल�खत
म� से कौन सा इंड���टेशन िवक� चुना जाना होता है?

Ans A. ह��िगंग (Hanging)     B. फ�� लाइन (First line)     C. एलाइनम�ट (Alignment)     D. �ेिसंग (Spacing)

Q.6 िन�िल�खत म� से कौन सा एक सॉ�वेयर �ो�ाम है जो वेब यूजर �ारा एक �ाउजर का उपयोग करके अनुरोिधत वेब पेजो ंको �दान करता है?

Ans A. वेबसाइट (Website)     B. वेब �ाइंट (Web client)     C. यूआरएल (URL)     D. वेब सव�र (Web server)

Q.7 आप ______ सृजन करने के िलए सेले� कर सकते ह� जो आपके �ारा भेजे जाने वाले ��ेक ईमेल (email) के अंत म� िदखाई देगा।

Ans A. िस�ेचर (signature)     B. फॉम��िटंग ऑ�शन (formatting options)     C. स�े� (subject)     D. अटैचम�ट (attachments)

Q.8 िवंडोज़ 10 (Windows 10) म�, �ीन रेजो�ूशन (screen resolution) को बदलने के िलए सेिटं� (Settings) म� िड��े (Display) का
िन�िल�खत म� से कौन सा िवक� चुना जाना होता है?

Ans A. �ेल एंड लेआउट (Scale and layout)     B. िड��े ओ�रएंटेशन (Display orientation)     C. कैिल�ेट िड��े कलर (Calibrate display
color)     D. िड��े रेजो�ूशन (Display resolution)

Q.9 �ेसहो�र को खाली छोड़ने के िलए िन�िल�खत म� से िकस �तीक का उपयोग िकया जाता है जो बाद म� सच� करते समय �चािलत �प से सच�
इंजन �ारा भरा जा सकता है?

Ans A. हायफन (Hyphen) (-)     B. � लस (Plus) (+)     C. कोलन (Colon) (:)     D. ऐ� टे�र� क (Asterisk) (*)

Q.10 एमएस-पावरपॉइंट 365 (MS-PowerPoint 365) म� शॉट�कट मे�ू (shortcut menu) म� फॉम�ट <ऑ�े� टाइप> (Format <object type>)
का कौन सा िवक� ऑ�े� को एक िविश� अनुपात म� मै�ुअल �प से सेट करने के िलए उपयोग िकया जाता है?

Ans A. इफे�्स (Effects)     B. िफल (Fill)     C. �ेल (Scale)     D. लाइन (Line)

Q.11 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) म� इ�ट� टैब के िकस समूह म� वृ�, वग� और तीर जैसी आकृितयाँ होती ह�?
Ans A.

�ाइड्स (Slides)     B.
इल�� ेशंस (Illustrations)     C.
टेब� (Tables)     D. इमेजेज (Images)
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Q.12 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) में कर्सर द्वारा सेलेक्टेड टेक्स्ट पर होवर करने पर दिखाई देने वाले टेक्स्ट फॉर्मेट विकल्पों में
निम्नलिखित में से कौन सा विकल्प नहीं  होता है?

Ans A.
नंबरिंग ऑर बुलेट्स (Numbering or Bullets)     B. इन्सर्ट पिक्चर (Insert Picture)
    C. फॉन्ट कलर (Font Color)
    D.
अलाइन टेक्स्ट (Align Text)

Q.13 एमएस-आउटलुक 365 (MS-Outlook 365) में निम्नलिखित में से कौन सी इनबॉक्स के टेगरी उन ईमेल पर ध्यान कें द्रित करने में सहायता करती
है जो सबसे अधिक महत्वपूर्ण होते हैं और इनबॉक्स को विभिन्न टैबों  में अलग-अलग करती हैं?

Ans A. अदर (Other)     B. इम्पोर्टेन्ट (Important)     C. फोकस्ड (Focused)     D. अनफोकस्ड (Unfocused)

Q.14 रोगी निगरानी प्रणाली, फार्मा सूचना प्रणाली, प्रयोगशाला-निदान प्रणाली आदि निम्नलिखित में से किस क्षेत्र के  कं प्यूटर अनुप्रयोग हैं?

Ans A. बैंकिं ग     B. स्वास्थ्य देखभाल     C. विपणन     D. बीमा

Q.15 एमएस-एक्सेल 365 (MS-Excel 365) में किसी कॉलम को एक विशिष्ट चौड़ाई पर सेट करने के  लिए होम टैब (Home tab) का निम्नलिखित में से
कौन सा विकल्प उपयोग किया जाता है?

Ans A. सेल एलाइनमेंट (Cell Alignment)     B. फॉर्मेट एज टेबल (Format as Table)     C. सेल स्टाइल्स (Cell Styles)     D. फॉर्मेट (Format)

Q.16 विंडोज़ 10 ओएस (Windows 10 OS) में डेट एं ड टाइम सेटिंग (Date & Time setting) में निम्नलिखित में से कौन सा विकल्प नहीं  होता है?

Ans A. कांटिनेंट (Continent)     B. लैंग्वेज (Language)     C. रीजन (Region)     D. स्पीच (Speech)

Q.17 एमएस-एक्सेल 365 (MS-Excel 365) वर्क शीट के  एक या अधिक फार्मूलों  (formulas) में, आप ______ को संदर्भित करने के  लिए सेल रेफरेंस
का उपयोग नहीं  कर सकते हैं।

Ans A. एक ही वर्क बुक में अन्य वर्क शीटों के  डेटा     B. अन्य वर्ड डॉक्यूमेंट की टेबल के  डेटा     C. वर्क शीट पर एक या अधिक सन्निहित सेलों (cells) के
डेटा     D. वर्क शीट के  विभिन्न क्षेत्रों में निहित डेटा

Q.18 एमएस-वर्ड 365 (MS-Word 365) में 'Ctrl + W' कीबोर्ड शॉर्टकट का उपयोग निम्नलिखित में से किस उद्देश्य के  लिए किया जाता है?

Ans A. चयनित कं टेंट को क्लिपबोर्ड पर कॉपी करने के  लिए     B. क्लिपबोर्ड के  कं टेंट को पेस्ट करने के  लिए     C. डॉक्यूमेंट को बंद करने के  लिए     D.
चयनित कं टेंट को क्लिपबोर्ड पर कट करने और क्लिपबोर्ड के  कं टेंट को पेस्ट करने के  लिए

Q.19 मुख्‍य मेमोरी (main memory) को कार्यान्वित करने के  लिए निम्नलिखित में से किसका व्यापक रूप से उपयोग किया जाता है?

Ans A. डायनामिक रैम (Dynamic RAM)     B. मैग्नेटिक ड्र म मेमोरी (Magnetic drum memory)     C. स्टेटिक रैम (Static RAM)     D. मैग्नेटिक कोर
मेमोरी (Magnetic core memory)

Q.20 एमएस-वर्ड 365 (MS-Word 365) में निम्नलिखित में से कौन सा आइकन होम टैब के  क्लिपबोर्ड समूह में उपलब्ध नहीं  होता है?

Ans A.      B.      C.      D. 

Q.21 एमएस-एक्सेल 365 (MS-Excel 365) में डेटा को सेलेक्ट करने के  तुरंत बाद चार्ट बनाने के  लिए निम्नलिखित में से किस कीबोर्ड शॉर्टकट
(keyboard shortcut) का उपयोग किया जाता है?

Ans A. Alt + F3     B. Alt + F4     C. Alt + F1     D. Alt + F2

Q.22 निम्नलिखित में से कौन सा विकल्प लिनक्स सिस्टम का सबसे महत्‍वपूर्ण भाग है, जो सीपीयू (CPU), मेमोरी और पेरीफे रल डिवाइसेज को
व्‍यवस्थित करता है, और ओएस (OS) का निम्नतम स्तर है?

Ans A. बूटलोडर (Bootloader)     B. ‎कर्नेल (Kernel)     C. डेस्कटॉप एनवायरनमेंट (Desktop environment)     D. डैमन (Daemons)

Q.23 जीमेल में स्पेलिंग, ग्रामर और ऑटोकरेक्ट टू ल्स को चालू (on) या बंद (off) करने के  लिए सेटिंग का निम्नलिखित में से कौन सा टैब उपयोग किया
जा सकता है?

Ans A. जनरल (General)     B. एकाउंट्स एं ड इम्पोर्ट (Accounts and Import)     C. लेबल (Labels)     D. ऐड-ऑन (Add-ons)

Q.24 निम्नलिखित में से कौन-सी एक प्रकार की ब्राउजर विंडो है जो इंटरनेट ब्राउज करते समय बिना किसी यूजर रिक्वे स्ट के  खुल जाती है?

Ans A. पुल-अप (Pull-up)     B. ऐड-ऑन (Add-ons)     C. पॉप-अप (Pop-up)     D. प्लगइन (Plugins)
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Q.25 आपने एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) की स्लाइड में एक चित्र को सेलेक्ट किया है। निम्नलिखित में से कौन सा विकल्प फॉर्मेट
पिक्चर (Format Picture) शॉर्टकट मेनू में उपलब्ध नहीं  होता है?

Ans A.
साइज एं ड प्रॉपर्टीज (Size & Properties)     B.
लेआउट (Layout)     C. फिल एं ड लाइन (Fill & Line)
    D.
इफे क्ट्स (Effects)

Q.26 एमएस-वर्ड 365 (MS-Word 365) में निम्नलिखित में से कौन सा पेस्ट विकल्प पेस्ट किए गए टेक्स्ट की मूल फॉर्मेटिंग के  साथ पेस्ट करता है?

Ans A.      B.      C.      D. 

Q.27 एमएस-वर्ड 365 (MS-Word 365) में निम्नलिखित में से कौन सा ब्रेक विकल्प एक नया सेक्शन ब्रेक इन्सर्ट करता है और उसी पेज पर नया
सेक्शन प्रारंभ करता है?

Ans A. नेक्स्ट पेज (Next Page)     B. ओड पेज (Odd Page)     C. इवन पेज (Even Page)     D. कं टीन्यूअस (Continuous)

Q.28 विंडोज़ 10 ओएस (Windows 10 OS) में टास्क बार के  संदर्भ में निम्नलिखित में से कौन सा कथन असत्य है?

Ans A. इसे न तो साइड में ले जाया जा सकता है और न ही डेस्कटॉप के  शीर्ष पर।     B. यह सुनिश्चित करने के  लिए कि यह जिस तरह से सेट है, वैसे ही बनी
रहे, टास्कबार को लॉक करना आसान है ।     C. लॉक और अनलॉक टास्कबार सेक्शन का उपयोग यह पता लगाने के  लिए किया जा सकता है कि यह लॉक है या नहीं ।
    D. डिफ़ॉल्ट रूप से, टास्कबार डेस्कटॉप के  निचले भाग में होता है।

Q.29 निम्नलिखित में से कौन सी विशेषता किसी कार्य को यथासंभव कम मानवीय संपर्क  के  साथ पूरा करने के  लिए प्रौद्योगिकी के  उपयोग को संदर्भित
करती है?

Ans A. स्मरण शक्ति (Remembrance power)     B. स्वचालन (Automation)     C. कोई आईक्यू नहीं  (No IQ)     D. कोई ईक्यू नहीं  (No EQ)

Q.30 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) में पुश, फे ड, वाइप आदि किस टैब के  विकल्प हैं?

Ans A. स्लाइड शो (Slide Show)
    B. एनिमेशंस (Animations)
    C. डिजाइन (Design)
    D. ट्रां जीशंस (Transitions)

Q.31 निम्नलिखित में से किस इंटरनेट एक्सेस पद्धति में अपेक्षाकृ त अधिक सेटअप शुल्क और महंगे उपकरण अग्रिम शामिल होते हैं?

Ans A. के बल मॉडेम (Cable modem)     B. डायल अप (Dial up)     C. डीएसएल (DSL)     D. सैटेलाइट (Satellite)

Q.32 निम्नलिखित में से कौन सा कोड एक तरीका प्रदान करता है जिसके  माध्यम से एक अके ले अक्षर को वेब पेजों , टेक्स्ट फाइलों  और अन्य डॉक्यूमेंटों
के  रूप में दर्शाया जा सकता है, जिसका उपयोग दुनिया भर की सभी भाषाओं के  अक्षरों  को दर्शाने के  लिए किया जा सकता है?

Ans A. बायनरी (Binary)     B. यूनिकोड (Unicode)     C. आस्की (ASCII)     D. एक्सटेंड आस्की (Extend ASCII)

Q.33 एमएस-वर्ड 365 (MS-Word 365) में मौजूदा टेक्स्ट के  लिए बुलेटेड लिस्ट बनाने हेतु निम्नलिखित में से किस क्रम का उपयोग किया जाता है?

Ans A. इन्सर्ट -> बुलेट (Insert -> Bullets)     B. डिजाइन -> बुलेट (Design -> Bullets)     C. लेआउट -> बुलेट (Layout -> Bullets)     D. होम ->
बुलेट (Home -> Bullets)

Q.34 निम्नलिखित में से कौन-सा विकल्प एक डायरेक्‍ट इनपुट डिवाइस है जिसमें किसी मशीन या डिवाइस द्वारा डेटा सीधे कं प्यूटर में इनपुट किया
जाता है?

Ans A. टच स्क्रीन     B. माइक्रोफोन     C. वेबकै म     D. बारकोड स्कै नर

Q.35 निम्नलिखित में से कौन सा विकल्प सर्च इंजन का एक मुख्य भाग नहीं  है?

Ans A. सर्च इंडेक्स (Search index)     B. सर्च एल्गोरिथम (Search algorithm)     C. क्रॉउलर (Crawler)     D. कर्नेल (Kernel)

Q.36 एमएस-एक्सेल 365 (MS-Excel 365) में निम्नलिखित में से कौन सा सेल रेफरेंस स्तंभ Z (Column Z) और पंक्ति 20 (Row 20) की सेल के  लिए
उपयोग किया जाता है?

Ans A. Z:Z     B. 20:20     C. 20Z     D. Z20
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Answers

Q.37 जब एक डिवाइस दू सरे  डिवाइस पर संदेश भेजने का प्रयास करती है, तो इंटरनेट पर डेटा, प्रबंधनीय पैके ट के  रूप में भेजा जाता है और प्रत्येक
पैके ट को एक ______ असाइन किया जाता है जो इसे इसके  एं डपॉइंट से जोड़ देता है।

Ans A. पोर्ट नंबर (port number)     B. राउटर नंबर (router number)     C. नेटवर्क  नंबर (network number)     D. कं प्यूटर नंबर (computer
number)

Q.38 एमएस-एक्सेल 365 (MS-Excel 365) में रैप टेक्स्ट (Wrap Text) विकल्प, होम टैब (Home tab) के  किस समूह में होता है?

Ans A. सेल्स (Cells)     B. एलाइनमेंट (Alignment)     C. स्टाइल्स (Styles)     D. फॉन्ट (Font)

Q.39 क्रोमियम वेब ब्राउज़र को किसने विकसित किया?

Ans A. मोज़िला (Mozilla)     B. माइक्रोसॉफ्ट (Microsoft)     C. गूगल (Google)     D. एप्पल (Apple)

Q.40 एमएस-वर्ड 365 (MS-Word 365) में कीबोर्ड शॉर्टकट 'Ctrl + बायाँ ब्रैके ट ([)' का उद्देश्य क्या है?

Ans A. डॉक्यूमेंट विंडो को स्प्लिट करना     B. किसी कमांड को रद्द करना     C. टेक्स्ट को मध्‍य में करना     D. फॉन्ट साइज को 1 अंक घटाना

Q.41 वेब मेल द्वारा जिन लोगों  से आप प्राय: संपर्क  करते हैं, उनकी संपर्क  जानकारी संग्रहीत करने के  लिए सामान्‍यत: निम्नलिखित में से कौन सा
विकल्प उपयोग किया जाता है?

Ans A. ऑनलाइन एड्रे स बुक (Online address book)     B. ऑनलाइन कै लेंडर (Online calendar)     C. पब्लिक प्रोफाइल (Public profile)     D.
प्राइवेट प्रोफाइल (Private profile)

Q.42 एमएस-पॉवरपॉइंट (MS-PowerPoint) में, नार्मल व्यू (Normal view) स्क्रीन के  ______ स्लाइड थंबनेल प्रदर्शित करता है।

Ans A. बाईं ओर     B. दाईं ओर     C. ऊपर की ओर     D. नीचे की ओर

Q.43 निम्नलिखित में से कौन सा विकल्प प्रक्रिया मूलक भाषा(procedural language) का एक उदाहरण है?
Ans A. C     B. C++     C. Ruby     D. Python

Q.44 एमएस-एक्सेल 365 (MS-Excel 365) में निम्नलिखित में से कौन सा फं क्शन सेल की रेंज में किसी आइटम को सर्च करने के  लिए उपयोग किया
जाता है, और फिर उस आइटम की सापेक्ष स्थिति को रेंज में वापस लाता है?

Ans A. लुकअप (Lookup)     B. वीलुकअप (VLOOKUP)     C. चूज़ (CHOOSE)     D. मैच (MATCH)

Q.45 1822 में पहला मैके निकल कं प्यूटर किसने विकसित करना शुरू किया था?

Ans A. चार्ल्स बैबेज (Charles Babbage)     B. एडा लवलेस (Ada Lovelace)     C. हर्मन होलेरिथ (Herman Hollerith)     D. जोसेफ मैरी जैक्वार्ड
(Joseph Marie Jacquard)

Q.46 इंटरनेट आर्कि टेक्चर के  संदर्भ में आईपी पैके ट (IP packet) के  परिवहन की गुणवत्ता (quality of transport) सुनिश्चित करते हुए कौन सा
प्रोटोकॉल यह निर्धारित करता है कि बाइट की एक स्ट्रीम को आईपी पैके ट में कै से बदलना है?

Ans A. एआरपी (ARP)     B. आईपी (IP)     C. टीसीपी (TCP)     D. डीएचसीपी (DHCP)

Q.47 एमएस-पावरपॉइंट 365 (MS-PowerPoint 365) में उन कई स्लाइडों  को डिलीट करने के  लिए जो क्रम में नहीं  हैं, आप ______ को दबाए रखें
और अपनी इच्छित स्लाइडों  को सेलेक्ट करें  और फिर राइट-क्लिक करें  और डिलीट स्लाइड (Delete Slide) को सेलेक्ट करें।

Ans A. Shift     B. Alt     C. Ctrl     D. Tab

Q.48 निम्नलिखित में से कौन सा विकल्प इंटरनेट द्वारा प्रदान की जाने वाली संचार सेवा है?

Ans A. आर्ची (Archie)     B. टेलनेट (Telnet)     C. गोफर (Gopher)     D. एफटीपी (FTP)

Q.49 निष्पादन के  दौरान, सीपीयू (CPU) ______ से निर्देशों  का चयन करता है और पुनः  प्राप्त करता है।

Ans A. मुख्‍य मेमोरी (main memory)     B. द्वितीयक मेमोरी (secondary memory)     C. रजिस्टरो (registers)     D. सहायक मेमोरी (auxiliary
memory)

Q.50 निम्नलिखित एमएस-एक्सेल 365 (MS-Excel 365) फॉर्मूले का आउटपुट क्या होगा?
=50+20/5-3

Ans A. 61     B. 51     C. 11     D. 60
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 Which of the following privacy and security settings of the Google Chrome browser uses cookies to remember
preferences even if we don’t visit those pages?

Ans A. Sync and Google services     B. Manage certificates     C. Clear browsing data     D. Preload pages for faster browsing and
searching

Q.2 िन�िल�खत म� से एमएस-वड� (MS-Word 365) के कौन से फीचर का उपयोग गलत वत�नी वाले श�ो ंको �चािलत �प से ठीक करने और
श�ो ंके कैिपटलाइज़ेशन को सही करने के िलए िकया जाता है?

Ans A. ऑटोकरे� (Autocorrect)     B. ऑटोटे� (AutoText)     C. ऑटोिफल (AutoFill)     D. ऑटोफॉम�ट (AutoFormat)

Q.3 एमएस-वड� 365 (MS-Word 365) म�, 'ि�ंट �ी�ू’ िवंडो खोलने के िलए िन� म� से कौन सा कीबोड� शॉट�कट है?
Ans A. Ctrl + F3     B. Ctrl + F1     C. Ctrl + F2     D. Ctrl + F4

Q.4 वष� 2021 म� जारी िकया गया िवंडोज़ ऑपरेिटंग िस�म का नवीनतम सं�रण िन� म� से कौन सा है?

Ans A. िवंडोज़ 7 (Windows 7)     B. िवंडोज़ 8 (Windows 8)     C. िवंडोज़ 11 (Windows 11)     D. िवंडोज़ 10 (Windows 10)

Q.5 Which of the following MS-PowerPoint views shows the thumbnail form of slides?
Ans A. Master view     B. Slide sorter view     C. Outline view     D. Notes page view

Q.6 OpenSUSE, Fedora and Debian are versions of which of the following GUI-based operating system?
Ans A. Linux     B. Windows     C. Apple iOS     D. MacOS X

Q.7 Ada, BASIC और C/C++ नामक कं�ूटर की भाषाएँ िन�िल�खत म� से िकस �ेणी से संबंिधत ह�?

Ans A. मशीन ल��ेज (Machine languages)     B. फं�नल ल��ेज (Functional languages)     C. अस��ी ल��ेज (Assembly languages)     D.
�ोसीजरल ल��ेज (Procedural languages)

Q.8 एसएसडी (SSDs)______ मेमोरी तकनीक पर आधा�रत सॉिलड-�ेट �ोरेज िडवाइस ( solid-state storage devices ) ह�।

Ans A. लेज़र ( laser)     B. ऑि�कल ( optical)     C. एनएएनडी �ैश (NAND flash)     D. मै�ेिटक ( magnetic)

Q.9 िन� म� से कौन सा मै�ेिटक टेप का �मुख दोष है?

Ans A. अनु�िमक फॉम�ट (Sequential format)     B. अन�ासी (Non-volatile)     C. लचीले �ा��क का उपयोग (Flexible plastic usage)     D.
िकफ़ायती (Economical)

Identify whether the given statements with reference to MS-Word 365 are true or false.Q.10

(I) The Shading option is used to colour the background behind the selected text or paragraph.
(II) Multi-level list is not supported in an MS-Word document.

Ans A. (I) False, (II) True     B. (I) True, (II) True     C. (I) False, (II) False     D. (I) True, (II) False

Q.11 नेटवक�  काड� और साउंड काड� जैसे बाहरी कंपोन�ट (External components)______ के मा�म से मदरबोड� से जुड़े होते ह�।

Ans A. इंटन�ल बस(internal bus)     B. िचप सेट (chip set)     C. �ंट साइड बस ( front side bus)     D. ए�प�शन �ॉट (expansion slot)

Q.12 In MS-PowerPoint 2019, which of the following is used to display a group of related commands within tabs?
Ans A. Ribbon     B. Work Area     C. View Options     D. Collapse

Q.13 एमएस वड� 365 (MS-Word 365) म� 'सेव एज़' (‘Save As’) िवंडो को खोलने के िलए िकस फं�न कंुजी (key) का उपयोग िकया जाता है?
Ans A. F12     B. F7     C. F4     D. F5

Q.14 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) �ेज���टेशन म� �ाइड शो के दौरान �ीन पर �ाइड के चालू और बंद होने पर िदया जाने वाला
िवज़ुअल इफे� िन� म� से कौन-सा है?

Ans A. �ाइड ट� ांिज़शन (Slide Transition)     B. �ाइड लेआउट (Slide Layout)     C. ��पआट� (ClipArt)     D. �ाइड सॉिट�ग (Slide Sorting)
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Q.15 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) के  संदर्भ में निम्न में से कौन सा कथन असत्‍य है?

Ans A. किसी एमएस-पॉवर पॉइंट (MS-PowerPoint) प्रेजेंटेशन को समाप्त करने के  लिए, हमें 'Esc' कुं जी का उपयोग करना चाहिए।     B. एक स्लाइड
बनाने के  बाद, हम इसके  लेआउट को आसानी से संशोधित कर सकते हैं।     C. स्लाइड के  सबसेट का उपयोग करके  एक कस्टम स्लाइड शो तैयार किया जा सकता है।
    D. हम मैन्युअल रूप से स्लाइड टाइमिंग असाइन नहीं  कर सकते हैं।

Q.16 A footnote in an MS-Word 365 document appears at the______.
Ans A. bottom of the document     B. top of the page     C. bottom of the page     D. top of the document

Q.17 Which of the following is NOT an MS-PowerPoint 365 view?
Ans A. Outline     B. Slide show     C. Inline     D. Slide

Q.18 पहचानें कि एमएस-एक्सेल 365 (MS-Excel 365) के  संदर्भ में दिए गए कथन सत्‍य हैं अथवा असत्‍य।

I. एक वर्क बुक में तीन से कम वर्क शीट नहीं  हो सकती हैं।
II. एमएस-एक्सेल (MS-Excel) वर्क बुक की पहली वर्क शीट का नाम बदला नहीं  जा सकता है।

Ans A. I – असत्‍य, II – सत्‍य     B. I – सत्‍य, II – असत्‍य     C. I – असत्‍य, II – असत्‍य     D. I – सत्‍य, II – सत्‍य

Q.19 Which of the following MS-Excel 365 features scans all the entries for a column in which data is entered with a match
and finishes the entry with the unique match that is in the column?

Ans A. AutoFill     B. AutoFormat     C. AutoComplete     D. AutoCorrect

Q.20 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) में प्रेजेंटेशन के  समय को रिकॉर्ड करने के  लिए निम्न में से कौन सा विकल्प उपयोग किया जाता
है और जो यह जांचने में सहायता करता है कि प्रेजेंटेशन एक निश्चित समय सीमा के  भीतर फिट बैठता है या नहीं ?

Ans A. स्लाइड ओरिएं टेशन (Slide orientation)     B. कस्टम एनिमेशन (Custom animation)     C. स्लाइड ट्रां ज़िशन (Slide transition)     D.
रिहर्सल (Rehearsal)

Q.21 Which of the following protocols of internet architecture is NOT a dominant component in data transmission?
Ans A. TCP     B. UDP     C. IP     D. DNS

Q.22 WinZip और WinRAR किस प्रकार के  यूटिलिटी सॉफ्टवेयर हैं?

Ans A. फ्री अप डिस्क मैनेजमेंट टू ल्स ( Free up disk management tools)     B. डिस्क डिफ्रे ग्मेंटर (Disk defragmenter)     C. फाइल कं प्रेशन टू ल्स
( File compression tools)     D. डिस्क क्लीनअप टू ल्स (Disk cleanup tools)

Q.23 The Drop Cap feature of MS-Word 365 can be used to create a letter of much bigger size at/in the______ of a paragraph.
Ans A. last line     B. second line     C. beginning     D. end

Q.24 Identify whether the given statements are true or false.

I. CRT uses electron gun for visual representation of data.
II. VDU is also called an input device.
III. A computer may have more than one input device.

Ans A. I - True, II - True, III - False     B. I - False, II - True, III - True     C. I - True, II - False, III - True     D. I - True, II - False, III -
False

Q.25 Identify whether the given statements are true or false.

(i) A web browser is an application used to access and view websites.
(ii) A website helps you find other web pages, such as Google.

Ans A. (i) True (ii) True     B. (i) False (ii) False     C. (i) False (ii) True     D. (i) True (ii) False

Q.26 Which of the following options in Control Panel should be used to choose the program you want Windows to use for
activities like web browsing, editing photos, sending e-mail and playing music in the Windows 10 OS?

Ans A. Default Programs     B. File Explorer Options     C. Device Manager     D. Devices and Printers

Q.27 एमएस-एक्सेल 365 (MS-Excel 365) में, किसी फॉर्मूले में सेल रेफरेंस (cell reference) को तुरंत एब्सोल्यूट (absolute) में बदलने के  लिए किस
फं क्शन कुं जी (key) का उपयोग किया जाता है?

Ans A. F12     B. F2     C. F10     D. F4
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Q.28 Carrying out which of the following actions will show a shortcut menu during a slide show in MS-PowerPoint 365?
Ans A. Clicking an icon on the current slide     B. Clicking the shortcut button on the formatting toolbar     C. Right clicking the

current slide     D. Pressing the keyboard shortcut ‘Shift + Enter’

Q.29 इंटरनेट एक्सप्लोरर (Internet Explorer) में, विंडो के  ऊपरी दाएं  कोने पर स्थित निम्न में से कौन सा आइकन फे वरेट फ़ोल्डर (Favourite’s
folder) को एक्सेस करने के  लिए क्लिक किया जा सकता है?

Ans A. सेटिंग आइकन (Setting icon)     B. स्माइली आइकन (Smiley icon)     C. होम आइकन (Home icon)     D. स्टार्ट आइकन (Star icon)

Q.30 निम्न में से कौन-सा एक सर्च इंजन नहीं  है?

Ans A. यूट्यूब (YouTube)     B. ब्रेव (Brave)     C. बिंग (Bing)     D. गूगल (Google)

Q.31 निम्नलिखित में से कौन-सा ऑपरे टिंग सिस्टम (operating systems) ग्राफिकल यूजर इंटरफे स (Graphical User Interface) का उपयोग
करता है?

Ans A. विंडो सर्वर कोर (Windows Server Core)     B. लिनक्स मिंट (Linux Mint)     C. MS-DOS     D. माइक्रोसॉफ्ट विंडोज एक्सपी (Microsoft
Windows XP)

Q.32 वाइड एरिया नेटवर्क  (WAN) के  संदर्भ में निम्न में से कौन सा कथन सत्य है?

Ans A. वैन (WAN) की डेटा रेट लैन (LAN) की गति से अधिक होती है।     B. वैन (WAN) का के वल एक प्रकार होता है जिसे 'स्विच्ड वैन' (Switched
WAN) के  नाम से जाना जाता है।     C. लंबी दू री के  पारेषण के  कारण, वैन (WAN) में शोर एवं त्रुटियां होने की संभावना अधिक होती है।     D. वैन (WAN) का भ्रंस
सह्यता (fault tolerance) बहुत अधिक होता है।

Q.33 निम्न में से कौन सा सी-डैक ( C-DAC ) द्वारा निर्मित भारत का पहला गीगा-स्के ल सुपरकं प्यूटर माना जाता है?

Ans A. परम 10000 ( PARAM 10000)     B. परम पद्म ( PARAM Padma)     C. परम 8000 ( PARAM 8000)     D. परम युवा ( PARAM Yuva)

Q.34 इंस्टेंट मैसेजिंग (instant messaging) के  संदर्भ में निम्नलिखित में से किसे स्माइली के  रूप में भी जाना जाता है?

Ans A. स्पॉन्टेनियस (Spontaneous)     B. कमोशंस (Commotion)     C. एमोटिकन्स (Emoticons)     D. इमोशंस (Emotions)

Q.35 एमएस-पॉवरपॉइंट 365 (MS-PowerPoint 365) में, एक स्लाइड शो के  दौरान 'होम' कुं जी दबाने पर आप प्रेजेंटेशन की______ स्लाइड पर
पहुंच जाएं गे।

Ans A. दू सरी     B. पहली     C. अंतिम     D. मध्य

Q.36 यदि एमएस-एक्सेल 365 (MS-Excel 365) वर्क शीट में A1 से A6 तक के  सेलों  को 'A,12,B,20,C,15' से भर दिया जाए, तो ‘=MAX(A1:A6)’ का
आउटपुट क्या होगा?

Ans A. #NUMBER     B. A     C. 20     D. !ERROR

Q.37 निम्न में से कौन सा उचित इंटरनेट तरीका (proper internet etiquette) नहीं  है?

Ans A. आपको संके ताक्षरों (abbreviations) का उपयोग बुद्धिमानी से करना चाहिए।     B. आप अनचाहे मैसेज फॉरवर्ड कर सकते हैं।     C. आपको मेल
के  नीचे अपना नाम शामिल करना चाहिए।     D. अटैचमेंट छोटे होने चाहिए।

Q.38 एमएस-एक्सेल 365 (MS-Excel 365) में चार्ट के  संदर्भ में निम्न में से कौन सा कथन असत्‍य है?

Ans A. बार चार्ट अलग-अलग आइटमों के  बीच तुलना को दर्शाते हैं।     B. लाइन चार्ट समय के  साथ सतत डेटा दिखा सकते हैं।     C. वर्क शीट पर स्‍तंभों
(columns) या पंक्तियों (rows) में व्यवस्थित डेटा को कॉलम चार्ट में प्लॉट किया जा सकता है।     D. पाई चार्ट बहु डेटा श्रृंखला वाले आइटम का आकार दर्शाते हैं।

Q.39 एमएस-एक्सेल 365 (MS-Excel 365) में, सेल रेफरेंस '$C4' को किस रूप में जाना जाता है?

Ans A. निरपेक्ष स्तंभ और सापेक्ष पंक्ति (absolute column and relative row)     B. सापेक्ष स्तंभ और पंक्ति (relative column and row)     C. सापेक्ष
स्तंभ और निरपेक्ष पंक्ति (relative column and absolute row)     D. निरपेक्ष स्तंभ और पंक्ति (absolute column and row)

Q.40 In which of the following formats must a downloaded webpage be saved if we want to download all the assets like
images, videos etc., along with the web page?

Ans A. webpage     B. Webpage (pdf)     C. Webpage (complete)     D. Webpage (HTML only)

Q.41 एमएस-वर्ड 2010 (MS-Word 2010) में निम्नलिखित में से कौन-सा कीबोर्ड शॉर्टकट, पैराग्राफ स्पेसिंग (paragraph spacing) को 1.5-लाइन
स्पेसिंग में बदलने के  लिए उपयोग किया जाता है?

Ans A. Ctrl + 5     B. Ctrl + 7     C. Ctrl + 3     D. Ctrl + 1
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Answers

Q1: D Q2: A Q3: C Q4: C Q5: B Q6: A Q7: D Q8: C Q9: A Q10: D

Q11: D Q12: A Q13: A Q14: A Q15: D Q16: C Q17: C Q18: C Q19: C Q20: D

Q21: D Q22: C Q23: C Q24: C Q25: D Q26: A Q27: D Q28: C Q29: D Q30: B

Q31: D Q32: C Q33: C Q34: C Q35: B Q36: C Q37: B Q38: D Q39: A Q40: C

Q41: A Q42: A Q43: C Q44: C Q45: B Q46: B Q47: C Q48: B Q49: D Q50: C

Q.42 पहचानें कि दिए गए कथन सत्‍य हैं अथवा असत्‍य।

(i) विंडोज़ ओएस (Windows OS) यूजर को ग्राफिकल यूजर इंटरफे स (GUI) और मल्टीटास्किं ग की योग्‍यता प्रदान करता है।
(ii) विंडोज़ ऑपरे टिंग सिस्टम (Windows operating system) गूगल द्वारा विकसित किया गया है।

Ans A. (i)-सत्‍य, (ii)-असत्‍य     B. (i)-सत्‍य , (ii)-सत्‍य     C. (i)-असत्‍य, (ii)-असत्‍य     D. (i)-असत्‍य, (ii)-सत्‍य

Q.43 निम्न में से कौन सूचना इलेक्ट्रॉ निक्स और संचार प्रौद्योगिकी (IECT) के  अनुप्रयोग हैं?

Ans A. ई-कॉमर्स और ई-गवर्नेंस     B. ई-बैंकिं ग एवं मल्टीमीडिया और एं टरटेनमेंट     C. ई- गवर्नेंस एवं मल्टीमीडिया और एं टरटेनमेंट     D. ई-बैंकिं ग और
ई-कॉमर्स

Q.44 एमएस-एक्सेल 365 (MS-Excel 365) में सेल कं टेंट (cell content) को सेल के  बायें बॉर्डर से दू र ले जाने के  लिए अलाइनमेंट ग्रुप (Alignment
group) के  निम्न में से किस विकल्प का उपयोग किया जाता है?

Ans A. ऑरिएं टेशन (Orientation)     B. डिक्रीज़ इंडेन्ट (Decrease Indent)     C. इंक्रीज़ इंडेन्ट (Increase Indent)     D. टेक्स्ट कं ट्रो ल (Text
Control)

Q.45 इंसट्रू सिव स्पैम (intrusive spam) को प्रतिबंधित करने के  लिए आउटलुक 365 (Outlook 365) की निम्नलिखित में से कौन सी विशेषता का
उपयोग किया जा सकता है?

Ans A. सेफ सेंडर (Safe senders)     B. ब्लॉक सेंडर्स (Block senders)     C. सेफ रेसेपिएं ट्स (Safe recipients)     D. ब्लॉक रेसेपिएं ट्स (Block
recipients)

Q.46 Which of the following statements is FALSE with reference to email forwarding?
Ans A. When forwarding an email, it is possible to forward to multiple recipients.     B. When forwarding an email, it is not possible to

remove an existing attachment.     C. When forwarding an email, it is possible to add a message and/or modify the existing message.     D.
When forwarding an email, it is possible to remove an existing attachment.

Q.47 एमएस-वर्ड 365 (MS-Word 365) टेबल में पंक्तियों  (rows) और स्‍तंभों  (columns) को इंसर्ट करने के  संदर्भ में निम्न में से कौन-सी संक्रिया
संभव नहीं  है?

Ans A. इंसर्ट लेफ्ट (Insert Left)     B. इंसर्ट बेलो (Insert Below)     C. इंसर्ट एक्रॉस (Insert Across)     D. इंसर्ट राइट (Insert Right)

Q.48 Which of the following is used to give a name to the IP address so that the user can locate a computer by a name, with
reference to the internet?

Ans A. TCP/IP     B. DNS     C. UDP     D. HTTPS

Q.49 एमएस-एक्सेल 365 (MS-Excel 365) फॉर्मूला ऑपरेटर में निम्नलिखित में से कौन सा ऑपरेटर किसी संख्या को एक घात में उठाता है?
Ans A. % (percent sign)     B. / (forward slash)     C. * (asterisk)     D. ^ (caret)

Q.50 In the URL “https://www.computerorganisation.com/jargon/w/example.htm”, which part refers to the website?
Ans A. example.htm     B. https     C. computerorganisation.com     D. wwwKD Jo
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UPPCL EXAM COMPUTER MCQ Conducted By TCS

Q.1 ई-मेल फॉरवड� करने के संबंध म� िन�िल�खत म� से कौन सा कथन ग़लत है?

Ans A. एक ई-मेल अनेक ���यो ंको फॉरवड� िकया जा सकता है।     B. फॉरवड� िकए गए ई-मेल संदेश म� नया संदेश नही ंजोड़ा जा सकता है।     C. एक
ई-मेल या तो मानवीय �प से या �त: फॉरवड� िकया जा सकता है।     D. ओ�रिजनल अटैच की गई फ़ाइलो ंके अित�र�, फॉरवड� िकए गए ई-मेल के साथ कुछ नई
फ़ाइल� भी अटैच की जा सकती ह�।

Q.2 CPU कं�ूटर का मु� घटक होता है। िन�िल�खत म� से CPU का पूण� �प �ा है?

Ans A. Control Processing Unit (कंट� ोल �ोसेिसंग यूिनट)     B. Central Programming Unit (स�ट� ल �ो�ािमंग यूिनट)     C. Central Processing
Unit (स�ट� ल �ोसेिसंग यूिनट)     D. Computer Processing Unit (क��ूटर �ोसेिसंग यूिनट)

Q.3 िन�िल�खत म� से �ा एक िस�म सॉ�टवेयर है?

Ans A. Web browser (वेब �ाउज़र)     B. Printer driver (ि�ंटर ड� ाइवर)     C. MS-Office (एमएस-ऑिफ़स)     D. Adobe Reader (एडोब रीडर)

Q.4 Which of the following statements is correct about sending a new e-mail?
Ans A. Bcc stands for ‘Blind carbon copy’ that is used to send the same message to more than one person and all of them can see

the list of recipients of this message.     B. The subject of the message is entered in the ‘Heading’ field.     C. The recipient’s e-mail address is
entered in the ‘To’ field.     D. The sender’s e-mail address is automatically stored in the ‘To’ field.

Q.5 िन�िल�खत म� से कौन सा कथन एमएस-वड� (MS-Word) 2007 म� एक पैरा�ाफ़ के टे� के अलाइनम�ट के बारे म� ग़लत है?

Ans A. टे� को दाईं ओर अलाइन करने के िलए Ctrl + R शॉट�कट कंुिजयो ं(keys) का उपयोग िकया जा सकता है।     B. टे� को बाईं ओर अलाइन
करने के िलए Ctrl + L शॉट�कट कंुिजयो ं(keys) का उपयोग िकया जा सकता है।     C. टे� को बाईं ओर अलाइन करने के िलए Alt + L शॉट�कट कंुिजयो ं(keys) का
उपयोग िकया जा सकता है।     D. टे� को क� � म� अलाइन करने के िलए Ctrl + E शॉट�कट कंुिजयो ं(keys) का उपयोग िकया जा सकता है।

Q.6 TCP/IP मॉडल के संबंध म�, UDP का पूण� �प �ा है?

Ans A. Uni-Directional Processing (यूनी-डायरे�नल �ोसेिसंग)     B. User Data Processing (यूज़र डेटा �ोसेिसंग)     C. Unique Datagram
Protocol (यूिनक डेटा�ाम �ोटोकॉल)     D. User Datagram Protocol (यूज़र डेटा�ाम �ोटोकॉल)

Q.7 Which of the following statements is/are true about headers and footers in MS-PowerPoint 2007?

(i) By default, the slide number is displayed in the lower right corner of the slide.
(ii) The ‘date and time’ cannot be inserted using a header and footer.

Ans A. (ii) only     B. Both (i) and (ii)     C. (i) only     D. Neither (i) nor (ii)

Q.8 िन�िल�खत म� से कौन-सा एमएस-ए� सेल (MS-Excel) फं�न बाइनरी नंबर को डेिसमल नंबर के समतु� य लौटाता है?
Ans A. DECTOBIN()     B. DECIMAL2BINARY()     C. DEC2BIN()     D. TOBIN()

Q.9 Which of the following statements is correct about output devices of a computer?
Ans A. Mouse is an output device.     B. It is used to send data to a computer.     C. It converts digital data into human

understandable form.     D. It converts data into digital form.

Q.10 वेब �ाउज़र के बारे म� िन�िल�खत म� से कौन सा/से कथन स� है/ह�?

(i) यह एक िस�म सॉ�टवेयर है जो वेब सव�र के साथ इंटरै� करता है।
(ii) सफ़ारी एक वेब �ाउज़र है।

Ans A. केवल (ii)     B. (i) और (ii) दोनो ं    C. न तो (i) और न ही (ii)     D. केवल (i)

Q.11 एमएस-पॉवरपॉइंट (MS-PowerPoint) 2007 म� सेले� की गई �ाइड की डु�ीकेट �ाइड को इ� सट� करने के िलए िन�िल�खत म� से िकस
की-बोड� शॉट�कट का उपयोग िकया जाता है?

Ans A. Alt + D     B. Ctrl + M     C. Ctrl + Alt + M     D. Ctrl + D

Q.12 कं�ूटर के CPU �ारा िकस मेमोरी को सीधे ए�ेस िकया जा सकता है?

Ans A. मै�ेिटक टेप(Magnetic tape)     B. हाड� िड� (Hard disc)     C. मेमोरी काड� (Memory card)     D. कैश मेमोरी (Cache memory)
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Q.13 निम्नलिखित में से कौन-सा कमांड एमएस-वर्ड (MS-Word) 2007 में 'पेज सेटअप' मेनू का भाग होता है?

Ans A. Page Color (पेज कलर)     B. Page Border (पेज बॉर्डर)     C. Watermark (वॉटरमार्क )     D. Orientations (ओरिएं टेशन्स)

Q.14 एमएस-एक्‍सेल (MS-Excel) 2007 में प्रिंटिंग के  बारे  में निम्नलिखित में से कौन सा कथन सही है?

Ans A. प्रिंटिंग के  लिए सेल (cells) की रेंज को मैन्युअली नहीं  चुना जा सकता है।     B. सेल (cells) की नॉन-कॉन्टीगुअस रेंज को प्रिंट करना संभव नहीं  है।
    C. डिफ़ॉल्ट रूप से, एक्सेल वर्तमान वर्क शीट के  सभी डेटा को प्रिंट करता है।     D. डिफ़ॉल्ट रूप से, एक्सेल वर्तमान वर्क बुक की सभी वर्क शीटों (worksheets) के
सभी डेटा को प्रिंट करता है।

Q.15 Which of the following statements is/are true about instant messages using smileys?

(i) In instant messaging, only text messages can be sent.
(ii) A smiley is a graphical representation of emotion.

Ans A. (ii) only     B. Both (i) and (ii)     C. Neither (i) nor (ii)     D. (i) only

Q.16 एमएस-वर्ड (MS-Word) 2007 में सेलेक्टेड टेक्स्ट के  के सिंग को बदलने के  लिए निम्नलिखित में से किस की-बोर्ड शॉर्टकट का उपयोग किया जाता
है?

Ans A. Ctrl + A     B. Shift + C     C. Shift + F5     D. Shift + F3

Q.17 सभी भेजे गए मेल डिफ़ॉल्ट रूप से ______ फ़ोल्डर में स्टोर होते हैं।

Ans A. Inbox (इनबॉक्स)     B. Draft (ड्रा फ़्ट)     C. Sent (सेंट)     D. Trash (ट्रै श)

Q.18 विंडोज़ (Windows)10 में समय को 24 घंटे के  प्रारूप से 12 घंटे के  प्रारूप में बदलने के  लिए निम्नलिखित में से किस विकल्प का उपयोग किया
जाता है?

Ans A. Start → Settings → Time & language → Date & time → Change data formats     B. Start → Settings → Date & language →
Date & time → Change data formats     C. Start → Settings → Date → Date & time → Change data formats     D. Start → Settings → Time &
language → Region → Change data formats

Q.19 एमएस.वर्ड (MS-Word) 2007 के  निम्नलिखित में से किस मुख्य मेनू आइटम में 'फु टनोट और एं डनोट' कमांड होते हैं?

Ans A. Home (होम)     B. Page Layout (पेज लेआउट)     C. Insert (इन्‍सर्ट)     D. References (रेफ़रेंसेज़)

Q.20 एमएस-पॉवरपॉइंट (MS-PowerPoint) 2007 में स्लाइड में पिक्चर (इमेज) इन्‍सर्ट के  लिए निम्नलिखित में से किस मेन मेनू का उपयोग किया जा
सकता है?

Ans A. Animation (एनीमेशन)     B. Insert (इन्‍सर्ट)     C. Design (डिज़ाइन)     D. View (व्यू)

Q.21 सेल B1 में

"=IF(A1>=80,"AB",IF(A1<=60,"BC",IF(A1>=70,"CD","DE")))फ़ॉर्मूला है, जहां सेल A1, 55 को स्टोर करता है। सेल B1 में निम्नलिखित में
से कौन सा आउटपुट होना चाहिए?

Ans A. AB     B. BC     C. DE     D. CD

Q.22 When MS-PowerPoint 2007 software is opened, it displays the title slide. Which of the following statements is correct
about this slide?

Ans A. By default, it contains 3 place holders.     B. By default, it contains only the title and subtitle place holders.     C. It is not
possible to change the font size and font face of its place holders.     D. It is necessary to type something in each place holder.

Q.23 ‘वर्ड (Word) 97-2003 डॉक्युमेंट' फॉर्मेट में रक्षित (save) होने पर फ़ाइल (एमएस-वर्ड 2007 में) का एक्सटेंशन निम्नलिखित में से क्या होता है?
Ans A. .dox     B. .docx     C. .doc     D. .doxc

Q.24 निम्नलिखित में से कौन सा कथन सर्च इंजनों  के  बारे  में सही है?

Ans A. आस्क (Ask) को 2005 में लॉन्च किया गया था।     B. बिंग (Bing) एप्पल (Apple) द्वारा विकसित किया गया था।     C. गूगल सर्च इंजन (Google
search engine) को मूल रूप से BackRub के  नाम से जाना जाता था।     D. अल्ताविस्ता (AltaVista) को Microsoft द्वारा लॉन्च किया गया था।

Q.25 A1 सेल दिनांक "21-09-2022" को स्टोर करता है जो कि बुधवार है। B1 सेल का निम्नलिखित में से कौन सा फ़ॉर्मूला “21-Sep-2022” प्रदर्शित
करता है?

Ans A.      B.      C.

     D. 

KD Jo
b 

Upd
at

es



Q.26 एमएस-एक्‍सेल (MS-Excel) वर्क शीट में, A1 से A20 तक के  सेल 20 व्यक्तियों के  नाम स्टोर करते हैं। निम्नलिखित में से कौन सा MS-Excel
फ़ॉर्मूला उन व्यक्तियों की संख्या की गणना करता है जिनके  नाम "A" अक्षर से शुरू होते हैं और "f" के  साथ समाप्त होते हैं?

Ans A.      B.      C.      D.

Q.27 एमएस-वर्ड (MS-Word) 2007 में पेज सेटअप के  बारे  में निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) 'Normal' में, मार्जिन्स का मान प्रत्येक दिशा में 2.0 cm होता है।

(ii) A3 पेपर का साइज़ 21 cm × 20.7 cm होता है।

Ans A. के वल (i)     B. (i) और (ii) दोनों     C. के वल (ii)     D. न तो (i) और न ही (ii)

Q.28 एमएस-एक्‍सेल (MS-Excel) 2007 में सेल का कं टेंट नीचे-बाएँ  से ऊपरी-दाईं दिशा में दर्शाने के  लिए 'Format Cells → Alignment' मेनू के
निम्नलिखित में से किस विकल्प का उपयोग किया जाता है?

Ans A. Direction (डायरेक्शन)     B. Vertical Direction (वर्टिकल डायरेक्शन)     C. Horizontal Direction (हॉरिज़ॉन्टल डायरेक्शन)     D.
Orientation (ओरिएं टेशन)

Q.29 निम्नलिखित में से कौन सा कथन लिनक्स (Linux) ऑपरे टिंग सिस्टम के  बारे  में सही है?

Ans A. यह ओरेकल इन्कॉर्पोरेशन (Oracle Incorporation) का उत्पाद है।     B. यह सिंगल यूज़र ऑपरे टिंग सिस्टम है।     C. यह एक मल्टी टास्किं ग
ऑपरे टिंग सिस्टम है।     D. इसे डेनिस रिची (Dennis Ritchie) द्वारा विकसित किया गया था।

Q.30 Which of the following statements is correct about the Windows operating system?
Ans A. Windows NT supports preemptive multitasking.     B. Windows NT was released in 1987.     C. Windows NT was developed

by Oracle and marketed by Microsoft.     D. Windows 10 was released in 2010.

Q.31 Which of the following statements is INCORRECT about LAN?
Ans A. LAN stands for Local Area Network.     B. LAN is more secure in comparison to the Internet.     C. Two computers placed in

two different continents may connect through LAN.     D. A LAN with 10 Mbps speed called Ethernet.

Q.32 Which of the following should be the address of the range of the first five cells of the 1st column in MS-Excel 2007?
Ans A. A1:E1     B. A1:5     C. 1A:5A     D. A1:A5

Q.33 विंडोज़ (Windows) 10 में माउस प्रॉपर्टीज़ को बदलने के  बारे  में निम्नलिखित में से कौन सा/से कथन सही है/हैं?

(i) माउस की कर्सर-गति को बदला नहीं  जा सकता है।
(ii) कॉन्टेक्स्ट मेनू ( Context menu) को खोलने के  लिए माउस के  बाएं  बटन के  कार्य को बदलना संभव है।

Ans A. (i) और (ii) दोनों     B. के वल (i)     C. के वल (ii)     D. न तो (i) और न ही (ii)

Q.34 एमएस-पॉवरपॉइंट (MS-PowerPoint) 2007 में प्रेज़ेंटेशन देखने के  बारे  में निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) डिफ़ॉल्ट रूप से, स्टेटस बार में‘Normal’, ‘Print Layout’, और ‘Web Layout’ views कमांड होते हैं।
(ii) स्लाइड शो कमांड को 'F2' कुं जी (key) दबाकर एग्ज़ीक्यूट किया जा सकता है।

Ans A. न तो (i) और न ही (ii)     B. के वल (ii)     C. के वल (i)     D. (i) और (ii) दोनों

Q.35 Which of the following is an example of absolute cell reference in MS-Excel 2007?
Ans A. $A$5     B. A$5     C. $A5     D. A5

Q.36 Which of the following statements is/are true about data communication?

(i) It is an act of sending or receiving data.
(ii) In data communication, a protocol is a hardware that transfers messages from the sender to receiver.

Ans A. Both (i) and (ii)     B. (ii) only     C. Neither (i) nor (ii)     D. (i) only

Q.37 इलेक्ट्रॉ निक न्यूमेरिकल इंटीग्रेटर एं ड कं प्यूटर (ENIAC) ______ पर आधारित पहला बाइनरी प्रोग्रामेबल कं प्यूटर था।

Ans A. ब्लेज़ पास्कल्‍’स कॉन्सेप्ट (Blaise Pascal’s concept)     B. ट्यूरिंग्’स मशीनकॉन्सेप्ट (Turing’s machine concept)     C. चार्ल्स बैबेज्’स
आर्कि टेक्चर (Charles Babbage’s architecture)     D. वॉन न्यूमैन्’सआर्कि टेक्चर (Von Neumann’s architecture)
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Answers

Q.38 मूर्स के  नियम (Moore’s Law) के  बारे  में निम्नलिखित में से कौन सा/से कथन सही है/हैं?

(i) एक चिप पर ट्रां जिस्टरों  की संख्या प्रति वर्ष दोगुनी हो जाएगी।
(ii) एक चिप की लागत प्रत्येक दो वर्ष में आधी हो जाएगी।

Ans A. के वल (ii)     B. के वल (i)     C. न तो (i) और न ही (ii)     D. (i) और (ii) दोनों

Q.39 पहली स्लाइड से स्लाइड शो शुरू करने के  लिए निम्नलिखित में से किस की-बोर्ड शॉर्टकट का उपयोग किया जाता है?
Ans A. Alt + F5     B. Ctrl + F5     C. F5     D. Shift + F5

Q.40 वर्ल्ड वाइड वेब (www) के  बारे  में निम्नलिखित में से कौन सा कथन सही है?

Ans A. HTTP प्रोटोकॉल किसी वेब पेज का एक्सेस करने के  लिए होता है।     B. यह OSI रेफ़रेंस मॉडल पर आधारित है।     C. इसका आविष्कार जॉन
बॉब ने किया था।     D. यह एक इंट्रा नेट है जिसे एक संगठन में निजी नेटवर्क  के  रूप में स्थापित किया जाता है।

Q.41 पायथन प्रोग्रामिंग लैंग्वेज के  बारे  में निम्नलिखित में से कौन सा/से कथन सही है/हैं?

(i) यह OOP कॉन्सेप्ट को सपोर्ट करता है।
(ii) यह एक लो लेवल (low level) प्रोग्रामिंग भाषा है।

Ans A. (i) और (ii) दोनों     B. न तो (i) और न ही (ii)     C. के वल (ii)     D. के वल (i)

Q.42 एमएस.वर्ड (MS-Word) 2007 में डॉक्युमेंट खोलने के  लिए निम्नलिखित में से किस की-बोर्ड शॉर्टकट का उपयोग किया जाता है?
Ans A. Shift + O     B. Ctrl + Alt + O     C. Ctrl + O     D. Alt + O

Q.43 Which of the following is a component of a web search engine?
Ans A. Web crawler     B. Web browser     C. Internet Protocol     D. Web server

Q.44 Which of the following statements is correct about the quick access toolbar of MS-PowerPoint 2007?
Ans A. By default, it contains the Open, Save, New, and Slide-show commands.     B. The number of commands in it is fixed and

cannot be changed.     C. By default, it contains only 3 commands.     D. By default, it is located at the bottom left corner of the window.

Q.45 Which of the following is a cross-platform web browser that was first bundled with Windows 10 in 2015?
Ans A. Mozilla Firefox     B. Edge     C. Safari     D. Opera

Q.46 इंटरनेट के  बारे  में निम्नलिखित में से कौन सा कथन सही है?

Ans A. इंटरनेट और वर्ल्ड वाइड वेब एक ही हैं।     B. यह एक निजी नेटवर्क  है जो किसी संगठन के  कं प्यूटरों को जोड़ता है।     C. यह TCP/IP प्रोटोकॉल
का उपयोग करता है।     D. यह वेब पेजों का संकलन है जिसे ब्राउज़र के  ज़रिए एक्सेस किया जाता है।

Q.47 Which of the following texts in MS-Word is an example of superscript?

Ans A. X = Y – 10     B. H2O     C. X2 + Y2 = 20     D. X = 25

Q.48 विंडोज़ (Windows)10 ऑपरे टिंग सिस्टम के  'स्टार्ट मेनू' के  बारे  में निम्नलिखित में से कौन सा कथन सही है?

Ans A. यह टास्कबार के  बाएं  कोने में स्थित होता है।     B. यह टास्कबार के  दाहिने कोने में स्थित होता है।     C. यह विंडो के  मेनू बार के  बीच में स्थित होता
है।     D. यह विंडो के  मेनू बार में स्थित होता है।

Q.49 कं प्यूटर मेमोरी की यूनिट के  बारे  में निम्नलिखित में से कौन सा कथन ग़लत है?

Ans A. 1 बाइट = 8 बिट     B. 1 KB (किलोबाइट) = 1024 बाइट     C. कं प्यूटर मेमोरी की बेसिक यूनिट बिट होती है     D. 1 निबल = 6 बिट

Q.50 Which of the following methods is used to create a presentation using a template in MS-PowerPoint 2007?
Ans A. Office Button → New → Create Button     B. Office Button → New → Installed Templates → Select a Template → Create

Button     C. Office Button → Installed Templates → Select a Template → Create Button     D. Office Button → New → Blank → Select a
Template → Create Button
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Q1: B Q2: C Q3: B Q4: C Q5: C Q6: D Q7: C Q8: C Q9: C Q10: A

Q11: D Q12: D Q13: D Q14: C Q15: A Q16: D Q17: C Q18: D Q19: D Q20: B

Q21: B Q22: B Q23: C Q24: C Q25: A Q26: C Q27: D Q28: D Q29: C Q30: A

Q31: C Q32: D Q33: C Q34: A Q35: A Q36: D Q37: D Q38: A Q39: C Q40: A

Q41: D Q42: C Q43: A Q44: C Q45: B Q46: C Q47: C Q48: A Q49: D Q50: B
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